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About this User Manual

password security, network security, firewalls, virus protection, etc., represent
possible steps that a user of an 800xA System may want to consider based on a
risk assessment for a particular application and installation. This risk assessment,
as well as the proper implementation, configuration, installation, operation,
administration, and maintenance of all relevant security related equipment,
software, and procedures, are the responsibility of the user of the 800xA System.

@ Any security measures described in this document, for example, for user access,

This User Manual includes information as it pertains to installing and setting up
prerequisite third party software, and manually installing 800xA System and
Functional Area software.

Unless otherwise noted, the version of all 800xA Base System and Functional Area
software described in this User Manual is the latest release of 800xA 5.1. The
procedures described require Windows Administrator privileges.

This does not include information on site planning, engineering planning, software
configuration, network design, security measures, tools, maintenance, etc. that can
be found in other 800xA User Manuals.

Version Described in this Document

All information and procedures described in this document are specific to the latest
release of 800xA 5.1 that includes latest revisions and Feature Packs.

3BSE034678-511 G 15



User Manual Conventions About this User Manual

User Manual Conventions

Microsoft Windows conventions are normally used for the standard presentation of
material when entering text, key sequences, prompts, messages, menu items, screen
elements, etc.

Feature Packs

Feature Packs are intended to release new features and functions in between system
version releases. Feature Packs are intended as "add-ons" to an already available
system version. Feature Packs allow a more agile response to market requirements
without revising or releasing a system version.

Feature Packs are available to holders of a Sentinel agreement. The expiry date of
the sentinel agreement is checked at installation time, and the license system will

continue to remind the user until a license file with a valid Sentinel expiry date is

installed.

Users are not forced to adopt the Feature Pack. A new installation can choose to
install the main version only, or to also add the Feature Pack. An existing
installation can choose to stay on the main version, or to install the Feature Pack at
any time.

A Feature Pack is compatible with one particular system version, including revision
level. Feature Packs follow the life cycle of its main system version (transitions to
Classic and Limited will follow the system version the Feature Pack is compatible
with).

Feature Packs are accumulative. If additional features become available after the
initial Feature Pack release, the Feature Pack is updated (a new version of it). This
means there is only one Feature Pack available per system version.

A Feature Pack is one package. Users cannot "pick and choose" among features.
Separate features can however be released. Those will be purchased through a price
list, and will be possible to install independent from other features and Feature
Packs.

Revisions contain error corrections only. A user can choose to update to the current
revision and keep the installation at that level. This means users will get the recently
found problems corrected, and the functionality of the system will remain like it was
at the point in time when the original installation was made. This improves the

16
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About this User Manual Warning, Caution, Information, and Tip Icons

stability of the actual installation, and the user does not have to adopt any new
functions, updated user interfaces or anything else that differs from before the
revision was installed.

The Feature Pack installation kits will in many cases contain also the revision (this
is the case for Feature Pack 1 on 800xA 5.1), which means that when checking the
installation after it is done there is usually only one entry in addition to the base
installation. For some functional areas in 800xA, where the whole installation of it
is replaced when an update is made, there is only one entry visible for the whole
functional area. An installation that has the Feature Pack installed at some point in
time needs to follow that track (the Feature Pack cannot be uninstalled).

Revisions to features released in Feature Packs will be part of upcoming Feature
Packs, or possibly pure Feature Pack revisions when there are no longer new
features added to the system version (this is when the system version is in classic
life cycle). In practice this means that users have to install consecutive Feature
Packs in order to have revisions to previously released feature.

The Feature Pack content (including text, tables, and figures) included in this
User Manual is distinguished from the existing content using the following
two separators:

Feature Pack Functionality

<Feature Pack Content>

Feature Pack functionality included in an existing table is indicated using a

table footnote (*) :
*Feature Pack Functionality

Unless noted, all other information in this User Manual applies to 800xA Systems
with or without a Feature Pack installed.

Warning, Caution, Information, and Tip Icons

This publication includes Warning, Caution, and Information where appropriate
to point out safety related or other important information. It also includes Tip to
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Terminology About this User Manual

point out useful hints to the reader. The corresponding symbols should be
interpreted as follows:

Electrical warning icon indicates the presence of a hazard which could result in
electrical shock.

Warning icon indicates the presence of a hazard which could result in personal
injury.
Caution icon indicates important information or warning related to the concept

discussed in the text. It might indicate the presence of a hazard which could
result in corruption of software or damage to equipment/property.

Information icon alerts the reader to pertinent facts and conditions.

Tip icon indicates advice on, for example, how to design your project or how to
use a certain function

<O P

Although Warning hazards are related to personal injury, and Caution hazards are
associated with equipment or property damage, it should be understood that
operation of damaged equipment could, under certain operational conditions, result
in degraded process performance leading to personal injury or death. Therefore,
fully comply with all Warning and Caution notices.

Terminology

A complete and comprehensive list of Terms is included in System 800xA System
Guide Functional Description (3BSE038018%*). The listing includes terms and
definitions that apply to the 800xA System where the usage is different from
commonly accepted industry standard definitions and definitions given in standard
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dictionaries such as Webster’s Dictionary of Computer Terms. Terms that uniquely
apply to this instruction are listed in the following table.

Term/Acronym

Description

Backup

800xA Backup: Backup using the 800xA Backup Definition aspect.
Functional Area Backup: Backup via defined tools or copy of Functional Area
configuration and/or data to a safe media for items not covered by 800xA
Backup.

The specific operations called out for the Functional Area within the
Backup/Restore procedure in System 800xA Maintenance (3BSE046784%) for
same version to same version backup and restore.

Restore

800xA Restore: Restore via Configuration Wizard.

Functional Area Restore: Restore via defined tools or copy of Functional Area
configuration and/or data from a safe media for items not covered by 800xA
Backup.

The specific operations called out for the Functional Area within the
Backup/Restore procedure in System 800xA Maintenance (3BSE046784*) for
same version to same version backup and restore.

Upgrade

Moving from one 800xA release to a later 800xA release, whether it be a major
or minor release.

Update

Adding service packs, patches, hot fixes, or rollups to an existing 800xA System.

Related Documentation

A complete list of all documents applicable to the 800xA System is provided in
System 800xA Released User Documents (3BUA000263*). This document lists
applicable Release Notes and User Instructions. It is provided in PDF format and is
included on the Release Notes/Documentation media provided with your system.
Released User Documents are updated with each release and a new file is provided
that contains all user documents applicable for that release with their applicable
document number. Whenever a reference to a specific instruction is made, the
instruction number is included in the reference.
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Section 1 Installation Overview

ﬂ It is recommended to use Automated Installation to install 800xA System. Refer
System 800xA 5.1 Automated Installation (3BSE034679%) for the installation
procedures.

ﬂ This document reflects 800xA System and Functional Area software at the time
of release. All 800xA System and Functional Area Release Notes must be read
and understood before performing any automated or manual installation, post
installation, or upgrade procedures. The Release Notes contain any last minute
changes that be performed when installing or upgrading the 800xA System. All
Release Notes can be found on the CD labeled System Version 5.1 Released
Documents.

This instruction includes information as it pertains to installing and setting up
prerequisite third party software, and manually installing 800xA Base System and
Functional Area software.

Unless otherwise indicated in this instruction, do not install any 800xA Base
System or Functional Area software on a separate Domain Server node. A
separate Domain Server node is one that is not combined with an Aspect Server.

System Security

It is very important to have a corporate security policy that is revised on a regular
@ basis. This is the responsibility of the user of the 800xA System.

This document does not contain recommendations on system security, users, user
groups, or user roles and permissions. Refer to System 800xA Administration and
Security (3BSE037410%), System 800xA Network Configuration (3BSE034463%),
and System 800xA System Planning (3BSE041389%*) for more information.
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New Installations Section 1 Installation Overview

New Installations

®
i

Do not attempt to make a disk image of one 800xA System node and clone it to
other 800xA System nodes. This is not supported and the system installation will
fail.

800xA for DCI was not included with the initial release of 800xA 5.1 and thus
800xA for DCI installation instructions are not documented in this user manual.
Refer to 800xA for DCI 5.1 Installation (3BUA001686%*) user manual for
installation of 800xA for DCI 5.1.

If not starting with an 800xA System pre-installed by ABB, a new system
installation can be executed either semi-automatically using the System Installer as
described in System 800xA Automated Installation (3BSE034679%), or manually as
described in this instruction.

If performing a manual installation, read the rest of this section in its entirety for
guidelines on how to proceed before beginning to install 800xA Base System and
Functional Area software.

Read the Release Notes on the System Version 5.1 Released Documents CD
delivered with the installation media.

Upgrades

Upgrades can be executed either semi-automatically using the System Installer as
described in System 800xA Automated Installation (3BSE034679%), or manually as
described in System 800xA Upgrade (3BSE036342%).

System Installer can not be used to upgrade 800xA Systems with 800xA for DCI
or Freelance installed.

If an installed system exists and is being manually upgraded from System Version
4.1 to System Version 5.1 or from System Version 5.0 Service Pack 2 to System
Version 5.1, refer to System 800xA Upgrade (3BSE036342%).

Upgrades directly from System Baseline 2.1/2 and System Version 3.1 Service
Pack 3 to System Version 5.1 are not supported. Refer to System 800xA Upgrade
(3BSE036342%) for the supported upgrade paths.

The upgrade instruction contains upgrade preparation and post upgrade procedures.
Upgrading most Base System and Functional Area software requires referring back
to this installation instruction to install that software. Unless otherwise noted, the

procedures for installing the software for a new installation and installing it as part

22
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Section 1 Installation Overview Graphics

of an upgrade are identical. If required, differences in the two installation
procedures will be clearly identified.

Graphics

800xA 5.1 supports Process Graphics 2 as a default with optional VB Graphics
extensions that can be installed and loaded when upgrading. 800xA 5.0 SP2
supported VB Graphics as the default with Process Graphics 2 extensions that could
be installed and loaded. 800xA SV 5.0 SP1 and earlier supported VB Graphics as
the default with no option for Process Graphics.

Customers upgrading from previous 800xA versions can still view and modify their
VB Graphics, but they must install their previously licensed version of Visual
BASIC 6.0 with SP6 in order to do so. They must also install and load the VB
Graphics extensions.

New 800xA 5.1 customers should not install the VB Graphics extensions as they
will only have the VB runtime and will not be able to create and/or modify VB
graphics.

ﬂ If required, install Asset Optimization VB Graphics Extension manually.

Installation Tools Provided with System Installer

The System Installer provides standalone tools to help in the installation and
verification process.

System Planner Tool: Used to:

e  Plan a New System: Used to specify the desired system configuration. The
System Planner Tool consists of a series of dialog boxes where relevant
information is specified, such as:

—  Location of the license file.

—  Whether or not Windows is already installed on the client or server.

—  The number of Operator Workplace and Engineering Workplace Clients.
—  The number of remote client servers.

—  Connectivity Server options.

—  Device Management options.
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Installation Tools Provided with System Installer Section 1 Installation Overview

—  Functional Area software that will run in the system and options for each.
—  Aspect Server redundancy options.

—  AC 800M options.

—  Other Connectivity Server options.

—  Whether the system will be part of a domain or Windows Workgroup.

—  Multisystem Integration options.

—  Network and node parameters.

—  User and User Group settings.

—  Network redundancy and control network areas.

—  Client or server IP addresses.

When the planning phase is complete, node specific Setup Packages are
generated. Refer to the System Planner Tool section in System S800xA
Automated Installation (3BSE034679%) for more information.

Windows Firewall Configuration Tool: Windows Firewall restricts
communications between a server or client and a network or the Internet. It
might be necessary to adjust settings for some other applications that prefer an
open connection. Either exceptions can be made or a port can be opened so
these applications can communicate through Windows Firewall.

The Windows Firewall Configuration Tool makes the necessary exceptions and
opens the necessary ports. Use this tool to configure Windows Firewall even if
manually installing the 800xA Base System and Functional Area software.

In order to allow proper communications between a client or server and a
network or the Internet, Windows Firewall must be turned off during 800xA
installation and post installation procedures, and then turned on using the
Windows Firewall Configuration Tool after all procedures are complete. The
Windows Firewall Configuration Tool turns on the firewall for the Server
Operating System nodes and all Windows Workgroup nodes, and turns on the
Domain Profile for the Workstation Operating System nodes that belong to a
domain.

Windows Configuration Tool: Sets up Windows Operating System services
and settings for the 800xA System (Windows hardening). The operation of the
standalone tool is described in System 800xA Post Installation (3BUA000156%).

800xA Common Third Party Install Tool: Installs unlicensed third party
software that is common to every node in the 800xA System.

24
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Section 1 Installation Overview System Configuration Console

System Verifier Tool (this is not a standalone tool): After Windows is
installed and configured on a node, the System Verifier Tool will check to see if
the node fulfills the necessary software requirements. If any third party
software is required, the System Verifier Tool will help install it or it will
provide the necessary information to fulfill the requirement.

The System Verifier Tool can also be used to upgrade an installed system from
800xA 5.0 SP2 to 800xA 5.1 or 800xA 4.1 to 800xA 5.1. An upgrade
information file, generated by the System Verifier Tool, is needed to use this
option. The System Upgrade Guide must be run on the 800xA System version
to be upgraded, while the 800xA System is running. Refer to the Upgrading an
Installed System section in System 800xA Automated Installation
(3BSE034679%*) for more information.

For more information on these installation tools, refer to System 800xA Automated
Installation (3BSE034679%).

System Configuration Console

Some procedures described in this instruction use the 800xA System Configuration
Wizard. A new feature, the System Configuration Console, can also be used to
perform many of these procedures. Refer to System 800xA Tools (2PAA101088%) for
information and instructions on using the System Configuration Console.

Pre-Installation Considerations

Consider the following before performing the procedures described in this
instruction.

1.

This instruction does not include information on site planning, engineering
planning, software configuration, network design, security measures, users,
user groups, user roles and permissions, tools, maintenance, etc. that can be
found in other 800X A instructions.

Do not install any software until the system has been properly designed and
configured for the software being installed. Please refer to the following
instructions before installing the software described in this instruction:

Accessible from the System Version 5.1 Released Documents CD provided
with the 800xA System:

3BSE034678-511 G
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Pre-Installation Considerations Section 1 Installation Overview

—  System 800xA Administration and Security (3BSE037410%).

—  System 800xA Maintenance (3BSE046784%).

—  System 800xA Tools (2PAA101888%).

—  System 800xA Network Configuration (3BSE034463*).

—  System 800xA System Planning (3BSE041389%).

—  System 800xA Site Planning (3BUA000285*).

—  System 800xA System Guide Functional Description (3BSE038018%).

—  System 800xA System Guide Technical Data and Configuration
Information (3BSE041434%).

Accessible from ABB SolutionsBank
—  Third Party Software System 800xA (3BUA000500).
—  System 800xA Verified Third Party Products (3BSE046579%).

Preconfigured workstations or servers that come from the hardware
manufacturer must be pre-configured by the hardware manufacturer to meet
800xA System specifications. If they are not, they must be reconfigured by the
user to meet 800xA System specifications.

Unless otherwise specified, this instruction assumes there are no previous
versions of 800xA Base System or Functional Area software installed before
the described installation procedures are started.

If virus checking software is installed, disable it until after the 800xA System is
installed and configured (post installation).

Read the Release Notes on the System Version 5.1 Released Documents CD
delivered with the installation media.

The 800xA System software is supplied on DVDs as described in Appendix A,
Installation Media.

The 800xA for AC 800M software must be installed and the AC 800M Connect
system extension must be loaded prior to installing 800xA for TRIO software
and loading its system extension. This instruction does not contain installation
procedures for 800xA for TRIO. Refer to System 800xA Post Installation
(3BUA000156%) for all procedures related to 800xA for TRIO.

26
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Section 1 Installation Overview Installation Sequence

8. Redundant Batch Servers can not be combined with other servers on the same
node if Batch redundancy is required. Refer to the System 800xA System Guide
Technical Data and Configuration Information (3BSE041434%*) for more
information.

Installation Sequence
Figure 1 shows the high level installation sequence flowchart.
The installation process is broken down into three processes:
*  Planning and preparation (Figure 2).
*  Operating System and third party software installation (Figure 3).

Feature Pack Functionality

. 800xA Base System, Functional Area, and Feature Pack software installation
and post installation (Figure 4).

Follow the sequence when installing the 800xA System. If a block in the flow does
not refer to another instruction, the procedures for performing the tasks in that block
are contained in this instruction.

INSTALL AND CONFIGURE
START { P A avart e OPERATING SYSTEM AND
x THIRD PARTY SOFTWARE

INSTALL AND SET UP

(POST INSTALLATION)
800xA BASE SYSTEM AND DONE
FUNCTIONAL AREA

SOFTWARE

v

Figure 1. Installation Sequence Flowchart (High Level)
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PLAN 800xA SYSTEM
ACCORDING TO
CONFIGURATION RULES
AND NODE TYPES AS

A Tm——se SPECIFIED IN SYSTEM

B00%A SYSTEM GUIDE
TECHNICAL DATA AND
CONFIGURATION
{3BSED41434%)

VERIFY HARDWARE MEETS

PLAN AND SET UP
NETWORK AND DOMAIN REQUIREMENTS FOR EACH
TOPOLOGY AS SPECIFIED NODE TYPE AS SPECIFIED IN
IM SYSTEM 800xA THIRD PARTY HW PRODUCTS
NETWORK VERIFIED FOR INDUSTRIAL IT
CONFIGURATION SYSTEM &800wA (IBSEQ347189) AT
(FBSEQI4463") ABEB SolutionsBank

ACQUIRE INSTALLATION
AND CONFIGURATION
PARAMETERS

PLAN THE 800xA SYSTEM.
TO USE THE SYSTEM
FLANMER TOOL, REFER
TO SYSTEM 800xA
AUTOMATED
INSTALLATION
(IBSEDI4ETIY)

Figure 2. Installation Sequence Flow Chart A (Planning and Preparation)
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INSTALL AND
oPE e PERFORM INSTALL AND CONFIGURE
MISCELLANEOUS MISCELLANEOUS
AND OPERATING e *
OPERATING SYSTEM OPERATING S5YSTEM
SYSTEM SERVICE e e T
PACKS ON ALL 800xA
SYSTEM NODES
I
INSTALL AND CONFIGURE SET UP DOMAIN
NETWORK ADAPTERS ON s Sl L LT CONTROLLER AND DNS
ALL B00xA SYSTEM ADMINISTRA TION AND ¥ SERVEROMDOMAIN | |
SECURITY (3BSE034710)
NODES SERVER NODE
CREATE 800xA SYSTEM ADD 800xA DOMAIN INSTALL AND CONFIGURE
» USERS AND GROUPS OM Négéa%xﬁHsEYDSf;EﬂhilN | USERS TO LOCAL » OTHER THIRD PARTY
DOMAIN SERVER NODE ADMINISTRATORS GROUP SOFTWARE
MAKE A DISK IMAGE OF
EACH NODE AFTER
INSTALL OPERATING INSTALLING AND
ADD PRIVILEGES TO | SYSTEM UPDATES AND |  CONFIGURING THE
MANAGE GROLF POLICY }_' 800xA SERVICE USER *| HOT FIXES ON ALL B00XA *| OPERATING SYSTEM AND
SYSTEM NODES OTHER THIRD PARTY
SOFTWARE

{RECOMMENDED)

Figure 3. Installation Sequence Flow Chart B (Operating System and Third Party
Software Installation)
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Feature Pack Functionality

'”STS‘?(LS'—T::')":N%ASE PERFORM ALL POST
INSTALL B00XA 5.1 INSTALLATION TASKS AS

;%mg;éh??&é LICEMSE BDOxA SYSTEM FEATURE PACK USING |l SPECIFIED IN SYSTEM
S SOFTWARE SYSTEM FEATURE PACK 800%A POST
UPDATE TOOL (FUT). INSTALLATION

THIS INSTRUCTION ON A "
NODE-BY-NODE BASIS (3BUAOD01567)

MAKE ANOTHER,
SEPARATE DISK IMAGE
OF EACH NODE AFTER
INSTALLING ALL S00xA
BASE SYSTEM AND
FUNGTIONAL AREA » 2kt =
SOFTWARE AND
PERFORMING ALL POST
INSTALLATION TASKS
(RECOMMENDED)

Figure 4. Install 800xA 5.1 Feature Pack using System Feature Pack Update Tool
(FUT)

Acquiring Installation and Configuration Parameters

This section provides guidelines for acquiring the information needed for
installation with regard to network parameters, software keys, etc. Gather the
required installation media needed to complete the installation, and confirm that all
required hardware is in place and meets the system requirements.

ﬂ An organization should be in place to manage the domain with assigned
responsibilities and methods handling users and security.

Before installing and configuring (post installation) the 800xA System, there are
several parameters and system settings whose values must be determined and
available. Table 1 provides a worksheet for recording this information. It lists node
types and their applicable parameters, and provides a Value column for recording
the information.
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For guidelines on parameters related to network and domain setup, refer to System
800xA Network Configuration (3BSE034463%).

Table 1. Installation and Configuration Parameter Worksheet

Node Type Parameter Value
All Nodes Primary IP address
Secondary IP address
Subnet mask
Node name
Time sync protocols
Time sync role and configuration (per protocol)
RNRP network area, node number, and local flag
PC Nodes DNS Server addresses
AC 800M Primary CPU primary and secondary IP address
Controllers | Backup CPU primary and secondary IP address
Tool port IP address
Communication modules

10 modules
Domain Domain name
Server User Groups
Users

Concept of 800xA roles and permissions on system,
structures, and aspect object level

Network adapter type

DNS Server |Backup needs IP address of primary

Aspect Affinity - Aspect Server Base Service

Server Affinity - Aspect Server node name of clients
Affinity - node name of redundant Aspect Servers
Network adapter type

Affinity - Connectivity Server Base Service

Affinity - Connectivity Server node name of clients
Affinity - node name of parallel Connectivity Server
AC 400 MB 300 netw number1

Controller MB 300 netw number2

MB 300 node number
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Table 1. Installation and Configuration Parameter Worksheet (Continued)

Node Type

Parameter

Value

800xA for
Advant
Master

MB 300 netw number1

MB 300 netw number2

MB 300 node number

Network interface IP address in PC used for PU410.

Since the RTA unit default IP addresses are
172.16.168.50 and 172.17.168.50, do not
configure network area 10 in the RNRP
client/server topology. If the client server
topology is configured as network area 10, the
default IP address of the RTA unit must be
changed as described in 800xA for Advant
Master Configuration (3BSE0303407).

Connectivity
Server

Network adapter type

(Managed)
Switches

IP address

Disk Image

Server IP address

Session names

Backup identities and filenames

800xA for
MOD 300
RTA Unit

Since the RTA unit default IP addresses are
172.16.168.50 and 172.17.168.50, do not
configure network area 10 in the RNRP
client/server topology. If the client server
topology is configured as network area 10, the
default IP address of the RTA unit must be
changed as described in Industrial IT, System
800xA for MOD 300 - RTA Unit PU410 and
PU412 User’s Guide, Technical Data and
Installation Information (3BUA001442%).

Installation AUTORUN

When the 800xA System Installation DVD 1 as listed in the Appendix A,
Installation Media is inserted into the drive, the Installation AUTORUN screen will
appear. If it does not, navigate to the root directory of the DVD and manually launch
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AUTORUN:.exe. Figure 5 shows the Installation AUTORUN screen.

[J Industrial [T 800xA System = | B [

Instalt Adobes
Reader X ,}\‘-

System 800xA

Figure 5. Installation AUTORUN Screen

Clicking Manual Installation (Figure 6) allows direct access to the various 800xA
Base System and Functional Area software installation programs, that in most cases
start the 800xA Installation Wizard for that program. It also allows direct access to
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800xA Common Third Party Install Tool.

[J Industrial IT B00xA System

System 800xA

Manual Installation

instat-Adobes
Reader X ,L

AL Eb ID
MpD

Figure 6. Manual Installation from DVD 1

Insert the DVD 5 as listed in the Appendix A, Installation Media into the drive, the
Installation AUTORUN screen will appear. This allows access to the Oracle

34
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Installation Files and VB Graphics Extension of the 800xA Base System and
Functional Area software.

Clicking Manual Installation (Figure 7) allows to access 800xA Common Third
Party Install Tool that in most cases start the 800xA Installation Wizard for that
program.

[ p—
|--3 Industrial IT B00xA System I=NECN X |

Manual Installation

|

instait Adobes
Reader X ,L

System 800xA

Figure 7. Manual Installation from DVD 5
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800xA Installation Wizard Section 1 Installation Overview

800xA Installation Wizard

Most 800xA installations begin with the 800xA Installation Wizard. The Welcome
dialog box of the Wizard (Figure 8 shows a typical example) provides common
options that will not be repeated throughout this instruction. They are:

Generate log file: To specify that a log file be generated for this installation
(recommended), enable the check box.

Copy To Server: This function is not supported in the manual installation
described in this instruction.

Browse: Allows browsing the contents of the installation media.
Home: Returns to the original installation screen.
Exit: Closes the setup program.

Suppress Reboot check box: Select this check box to suppress a reboot of the
node until all 800xA software is installed. Some software may override this
check box. It is recommended to suppress the reboot during all software
installations, unless the information in the specific software procedure in this
user guide states otherwise.

Most procedures indicate to follow the Installation Wizard to complete the
installation. The procedure will include guidelines on what to select or fill in when
specific dialog boxes appear. Common dialog boxes such as License Agreement

36
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Section 1 Installation Overview 800xA Installation Wizard

B Process Portal A

Welcome to the Process Portal A Installation Wizard

[ A2 a6B 80018 Base 5.1
Welcome To ABB Products Installation

By clicking select one or more
of the products in the left

1 s To install the selected products,
“%J choose Install. To quit the
Lome” |
o

installation choose Exit.

Choose Browse 10 explore the content of the installation media,

With Copy distribution to server you can copy the whols product
installation package to & server.
Check the Generate logfill box 10 log all sctions dring the installation
Copyright @1981-2010 by ABB

¥ Generate log file in %Temp2a14B8 Industrial IT B00xAlProcessPortali_App_100407_103114.log

I" Suppress Reboot Copy To Server Browse Home Exit

Figure 8. 800xA Installation Wizard Welcome Dialog Box (Typical)

dialog boxes, Start Copying Files dialog boxes, Destination Location dialog boxes,
etc. will not be mentioned.

Unless otherwise specified, choose the default installation location in the
Destination Location dialog boxes.

Unless otherwise specified, enter your name and company name in the
Registration dialog boxes.

Unless otherwise specified, when a dialog box asks if you are installing the
product for yourself or anyone who uses the computer, enable Anyone who uses
this computer.

Read the Release Notes on the System Version 5.1 Released Documents CD
delivered with the installation media.

3BSE034678-511 G 37



800xA Installation Wizard Section 1 Installation Overview

38 3BSE034678-511 G



Section 2 Prerequisites

ﬂ The installer performing the procedures in this section must be proficient in the
use of Windows Operating Systems. This section may not include detailed
procedures on how to perform the described settings.

ﬂ There may be differences in accessing the Microsoft Operating System settings
described in this section depending on the selected operating system. It is the
responsibility of the user to consult Microsoft documentation and online help to
accurately make the settings.

This section provides instructions for installing the Windows Operating System and
other prerequisite software for the 800xA System. Additional application specific
prerequisites may be required when installing software for the various Functional
Areas such as Engineering Studio, Batch Management, and Information
Management.

ﬂ Hot fixes, service packs, and updates for third party prerequisites that the 800xA
System software has been found to be compatible with are listed in Third Party
Software System 800xA (3BUA000500). This document can be found in ABB
SolutionsBank.

It is recommended to make a full backup of all disks. With such a backup all work

ﬂ will be saved in the event of a disk crash or other serious malfunction. Make sure
to place proper identification on the backup media or backup files.

ﬂ Install optional hardware drivers if not supplied by the Windows Operating
System (video card, network adapter, sound card, etc.).
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Feature Pack Functionality

ﬂ Engineering Studio requires Visual Studio Tools. It is recommended to install
Visual Studio Tools for the Office System 3.0 Runtime and Service Pack 1.

Windows Operating System

This section describes:

*  Selecting the Windows Operating System on page 40.
*  Considerations for Disks and File System on page 42.
*  Windows Installation Guidelines on page 44.

*  Windows Operating System Service Packs on page 46.

Selecting the Windows Operating System

System 800xA 5.1 version runs on 64-bit (x64) and 32-bit (x86) operating systems.
The initial System 800xA 5.1 version was 32-bit and Revision A had separate media
boxes for 64- and 32-bit operating systems. The later revisions and feature packs are
in a single media supporting both options. New installations should be installed on
64-bit operating systems. However, if desired older hardware and available
operating system licenses can be used, it is possible to install the 800xA software on
a 32-bit operating system.

It is possible to install mixed 64- and 32-bit systems. The most common use case is
when a client is added or exchanged. Here it is possible to use a 64-bit node with 64-
bit operating system, even if the rest of the system is running on 32-bit. Exchanging
a Connectivity Server or even an Aspect Server to a node running on a 64-bit
operating system is possible under certain circumstances. It is recommended to
discuss this with Product Management. Swapping nodes to a 32-bit operating
system on a system generally running on a 64-bit operating system is not considered
as a relevant use case and should not be done.
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Selecting the Windows Operating System

The supported operating systems, service packs, and hot fixes are listed in System
800xA 5.1, 5.0, 4.x, 3.1 Third Party Software (3BUA000500). This document can be
found in ABB SolutionsBank.

ﬂ Server Operating System and Workstation Operating System will be used
throughout the remainder of this document.

The same capabilities and performance as the previously released 32-bit version
apply also to the 64-bit version.

The US English version of the operating system is required even if a translation
NLS package for System 800xA is used.

The following conditions affect the decision on which operating system to use:

e Certain 800xA Server types can run on the Workstation Operating System as
well as on the Server Operating System. The Server Operating System must be
used for the following applications:

Domain Server.

Aspect Server when it runs the Domain Controller and Domain Name
System (DNS).

Batch Server (except in a Single Node Engineering System).

Servers that run Asset Optimization (except in a Single Node Engineering
System).

800xA for Harmony Connectivity Server, Configuration Server, and
Configuration Server with Connectivity Server.

800xA for AC 870P/Melody Connectivity Server and Configuration
Server.

800xA for MOD 300 Connectivity Server.

*  Systems using the Workstation Operating System for the Aspect Server nodes
are limited to nine PC nodes, not counting Domain Server nodes. Systems
using the Workstation Operating System for any other server nodes, other than
the Aspect Server nodes, are limited to 11 PC nodes, not counting the Domain
Server nodes. These limitations depend on Microsoft licensing rules for the
Workstation Operating System and Internet Information Services (I1S).
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*  The Workstation Operating System may be used in most other instances,
although some performance benefits may be gained by using the Server
Operating System. If the Server Operating System is not required, then the
Workstation Operating System is generally recommended.

*  The Windows Operating System may be purchased from any Microsoft
reseller.

*  Pre-configured servers/clients that come from the server/client manufacturer
must be pre-configured by the server/client manufacturer to meet 800xA
System specifications. If they are not, they must be reconfigured by the user to
meet 800XA System specifications.

»  Existing nodes that are not running the Workstation Operating System or the
Server Operating System must be reformatted and the compatible operating
system must be installed.

Considerations for Disks and File System

There are several factors that may have an impact on 800xA System performance,
for example: where the software is installed, the tendency toward fragmentation,
and the file system. The following are some recommendations regarding these
factors.

Installation Directory

It is generally recommended to use the Windows default location, the program files
directory on the boot disk, for installation.

@ A faster disk subsystem will improve performance.
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Defragmenting Disks

The default installation of the Workstation Operating System is set to defragment

@ the disk automatically. If desired, it can be turned off. The default installation of
the Server Operating System is set to not defragment the disk automatically. If
desired, it can be turned on.

The file system must be in a consistent state at all times. Defragment disks on a
regular basis using the defragmentation software provided with the operating
system.

*  Size disks so they will be 25 percent empty for defragmentation purposes.

e Check the system for fragmented files on all nodes where trend and history
logs reside, and defragment the applicable disks as required.

*  History configuration impacts not only the History Server disks, but also
Connectivity Server disks where trend logs are configured. Therefore, check
the disks on Connectivity Servers where trend or history logs reside, and
defragment them as required.

*  Extensive use of the Bulk Configuration tool may cause disks to become
fragmented. Check the system for fragmented files after any such procedure,
and defragment disks as required.

*  Configuration procedures that involve creating, deleting, and then recreating of
a large quantity of objects may cause the associated disks to become
fragmented. Check the system for fragmented files after any such procedure,
and defragment disks as required.

*  Deleting and then creating the Aspect System may cause associated disks to
become fragmented. Check the system for fragmented files after any such
procedure, and defragment disks as required.

Enabling Write Caching on the Server Operating System Hard Disks

To ensure Aspect Directory integrity, the write cache buffer flushing must be left
enabled in the Server Operating System. Depending on the configuration, choice of
driver, type of hard disks, etc. Windows may allow disabling the write cache buffer
flushing on the hard disks to improve performance.

For data integrity this otherwise performance increasing option must not be used.

3BSE034678-511 G 43



Windows Installation Guidelines Section 2 Prerequisites

Refer to Enable Write Caching on Hard Disks on page 50 for more information and
specific procedures.

File System

The 800xA System requires the NTFS file system. In addition to the partition where
the Windows Operating System and 800xA System software is installed, a dedicated
NTES partition (or partitions) is also needed for:

*  Historical data storage - if Information Management is installed.

A FAT32 partition may be required if using certain disk imaging utilities; however,
most disk imaging software now supports FAT32 or NTFS.

Windows Installation Guidelines

Make a fresh installation of the Windows Operating System.

Before adding applicable service packs, it is important that all the correct device
drivers are installed to match the hardware. This is especially important for elite
server hardware with special RAID hard drives and server specific hardware that
requires the latest drivers or drivers not included in the operating system media.
Verify that the latest BIOS exists for all hardware (mother board, RAID cards,
and anything else that uses BIOS).

Install applicable service packs before installing other third party software. Install
Windows hot fixes, and updates approved by ABB (refer to Third Party Software
System 800xA (3BUA000500) after installing other third party software. This
document is accessible from ABB SolutionsBank.

Follow the installation procedure as described in the documentation provided by
Microsoft.

Table 2 indicates the settings specifically required for the 800xA System
installation.

The U.S. English version of the operating system is required.
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Windows Installation Guidelines

Table 2. Windows Installation Requirements

Step

Description

Choosing a partition for
installing the operating
system.

It is recommended to delete any previous partitions and create a new
partition on which to install the Windows Operating System. This partition
MUST use the NTFS file system.

Verify that the latest BIOS exists for all hardware (mother board, RAID
cards, and anything else that uses BIOS)

It is recommended that all server nodes (Aspect Directory, Connectivity
Servers, Applications Servers, etc.) use at least one additional partition for
the operatelTData and operatelTTemp folders. For best performance, the
additional partition should be on a separate disk or disk array from the
operating system.

There may be additional disk requirements for Applications Servers. If
installing the Information Management Server function on this node, at
least one additional NTFS partition is needed for storing historical data.
This partition can be the same as the operatelTData and operatelTTemp
partition or be a separate partition. The amount of disks, disk space, and
disk 1/0 needed for the Information Management node are dependent on
the final configuration for the node.

To maximize the performance for any server, any additional partitions
should be a separate disk or disk array from the root partition.

If planning on creating disk images on this server or workstation, a FAT32
partition may be required if using certain disk imaging utilities; however,
most disk imaging software now supports FAT32 or NTFS.

Selecting Regional
Settings

Refer to Regional and Language Options on page 48.

Time Zone

Make sure the Automatically adjust clock for daylight saving changes
check box is enabled (if daylight saving time is used).

It is recommended to reboot from the Windows installation CD to begin the
Windows Operating System installation.

1. Insert the applicable CD in the CD drive.

2. Restart the server or workstation.
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3. When the prompt to open the reboot menu is displayed, press the applicable
function key to display the menu (function key varies per server or workstation
model).

4. From the reboot menu, enable the option for rebooting from the Windows
installation CD.

5. When the Windows Setup screen is displayed, enable the option for starting
Windows Setup now (complete installation, DO NOT enable the option for
repairing an existing installation).

6. Follow the Installation Wizard, and use Table 2 to choose the correct options
for the 800xA System when applicable.

7. If reloading an operating system, select Advanced Settings, delete the
partition, and recreate it. Otherwise the old operating system files will be saved
on the disk.

Windows Operating System Service Packs

The Windows Operating System service packs must be installed immediately
after installing the operating system, and before performing any other procedures
in this instruction.

Follow the procedures provided by Microsoft to install the Windows Operating
System service packs.

Miscellaneous Operating System Setup

The following settings are required for use with the 800xA System:

*  Disable User Account Control (UAC) on page 47.

*  Windows Search Index on page 48.

*  Regional and Language Options on page 48.

*  Disable Displaying Server Manager Console at Logon on page 50.

*  Enable Write Caching on Hard Disks on page 50.

*  Virtual Memory Configuration on page 52.

*  Disable Show Window Contents While Dragging on page 52.

*  Disable Energy Saver and Screen Saver on page 53.

*  Disable Windows Firewall During Installation and Post Installation on page 53.
*  Disable Web Browser Popup Blocker on page 54.

46

3BSE034678-511 G



Section 2 Prerequisites Disable User Account Control (UAC)

Disable Virus Checking Software During Installation and Post Installation on
page 54.

Disable Automatic Updates on page 54.

Change Local Security Policy on the Workstation Operating System on page
55.

Disable User Account Control (UAC)
Perform the following procedure to disable UAC.

The procedure differs depending on the operating system. The procedures described
are as follows:

32-bit Server Operating System
All Other Supported Operating Systems

32-bit Server Operating System

1.

2
3.
4

Open Windows Control Panel.
Change Windows Control Panel to Classic View.
Double-click User Accounts.

Select:

Turn User Account Control on or off.

Clear the Use User Account Control (UAC) to help protect your computer
check box and click OK.

All Other Supported Operating Systems

1.

2
3.
4

Open Windows Control Panel.
Change Windows Control Panel to Large Icons view.
Click User Accounts.
Select:
User Accounts > Change User Account Control Settings

Slide the bar to Never notify and click OK.
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Section 2 Prerequisites

Windows Search Index

®

Do not index the following folders under any circumstances, or the entire volume
that contains them. These folders can exist on one or more disks and should not
be indexed on any of them.

OperatelTData: Runtime data from services is stored here.
OperatelTTemp: Runtime data for client processes is stored here.
ProgramData: Various other runtime data is stored here.

HsData, Oracle: Applies only for Information Management Servers.
ABBIndustriallT Data: User data is stored here.

Refer to Microsoft Windows help for more information on the Windows Search
Indexing feature and recommendations on types of folders to index and not to
index.

Regional and Language Options

Perform the following procedure to set the regional and language options. These
procedures must be performed for all users on all nodes in the 800xA System.

The procedure differs depending on the operating system. The procedures described
are as follows:

32-bit Server Operating System
All Other Supported Operating Systems

32-bit Server Operating System

1.
2.

Open Windows Control Panel.

Double-click Regional and Language Options to launch the Regional and
Language Options dialog box.

Verify that English (United States) is the selection in the Current
format drop-down list. If it is not, change it to English (United States)
and click Apply.

Click Customize this format to launch the Customize Regional Options dialog
box.

Verify that the value in the Decimal symbol field drop-down list is a dot (.). If
it is not, change it to a dot (.) and click Apply and then OK.
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6.
7.

10.

11.
12.

Click the Administrative tab.

Click Change system locale to launch the Regional and Language Settings
dialog box.

If a message box appears asking: Would you like to apply your
regional and language changes?, Click Apply.

Verify that the value in the Current system locale drop-down list is English
(United States).Ifitis not, change it to English (United States)
and click OK to return to the Administrative tab of the Regional and
Language Options dialog box.

Click Copy to reserved accounts to launch another Regional and Language
Settings dialog box.

Enable the Default user account (new users) and System accounts (local
system, local service, and network service) check boxes and click OK.

Click OK to exit the Regional and Language Options dialog box.

Close Windows Control Panel.

All Other Supported Operating Systems

1.
2.
3.

Open Windows Control Panel.
Click Region and Language to launch the Region and Language dialog box.

Verify that English (United States) is the selection in the Format drop-
down list. If it is not, change it to English (United States).

Click Additional settings to launch the Customize Format dialog box.

Verify that the value in the Decimal symbol field drop-down list is a dot (.). If
it is not, change it to a dot (.) and click Apply and then OK.

Click the Administrative tab.

Click Change system locale to launch the Regional and Language Settings
dialog box.

Verify that the value in the Current system locale drop-down list is English
(United States).Ifitis not, change it to English (United States)
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and click OK to return to the Administrative tab of the Regional and
Language Options dialog box.

9. Click Copy settings to launch the Welcome Screen and New User Accounts
Settings dialog box.

10. Enable the Welcome screen and system accounts and New User Accounts
check boxes and click OK.

11. Click OK to exit the Regional and Language Options dialog box.
12. Close Windows Control Panel.

Disable Displaying Server Manager Console at Logon

ﬂ This procedure only applies to the Server Operating System installations.

Perform the following procedure to disable displaying of the Server Manager
Console at logon:

Open Windows Control Panel.

Double-click Administrative Tools.

Double-click Server Manager to launch the Server Manager.
Enable the Do not show me this console at logon check box.

Close the Server Manager.

A

Close Windows Control Panel.

Enable Write Caching on Hard Disks

To ensure Aspect Directory integrity, the write cache buffer flushing must be left
enabled in the Microsoft Windows Operating System. Depending on the
configuration, choice of driver, type of hard disks, etc, Windows may allow
disabling the write cache buffer flushing on the hard disks to improve performance.

For data integrity this otherwise performance increasing option must not be used.

System 800xA configuration and application data is stored in the Aspect Directory.
The Aspect Directory is transaction driven and enforces a two-phase-commit
scheme. As part of that scheme it ensures that data is written to disk prior to
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considering the transaction complete. This behavior is used by several other third-
party databases.

A flush command is used to ensure that data is written to the disk.It is possible to
configure the disk driver to neglect the flush command. This is normally configured
in the Windows disk drives setting.

A consequence of, for example, a power or hardware failure can be that a flushing is
not performed. Potentially the Aspect Directory can then become inconsistent and
the system will no longer start. Furthermore the data and applications become
impossible to recover.

Refer to Microsoft Knowledge Base article 234656 for more information.
Perform the following procedure on all the Server Operating System hard disks:
1. Launch the Computer Management Console.

2.  Select Device Manager in the left pane.

3. Right-click the hard drive in the right pane and select Properties from the
context menu to launch the hard drive properties dialog box.

4. Select the Optimize for Performance option.

5. Select the Enable write caching on the disk check box (Enable write
caching on the device for the Workstation Operating System).

6. Click OK.

7. Close the Computer Management Console.

ﬂ It may be necessary to verify the Enable write caching on the disk check box is
still enabled after rebooting.

The Internet Explorer Enhanced Security component must be disabled on all the
Server Operating System nodes.

1. Select:
Start > Control Panel

2. Double-click Add/Remove Programs to launch the Add or Remove Programs
utility.
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3. Click Add/Remove Windows Components to open the Windows
Components Wizard.

4. In the Components list, disable the Internet Explorer Enhanced Security
Configuration check box.

5. Click Next and then Finish.

Virtual Memory Configuration

Windows manages the virtual memory configuration by default. Although it can be
customized, ABB recommends letting Windows manage the virtual memory.

Use standard Windows procedures to set the virtual memory to at least 1.5 GB for
client nodes. For server nodes, a correct configuration of virtual memory can
enhance performance considerably. As a rule of thumb the size of pagefile.sys
should be physical RAM x 2.5 or at least 1.5 GB. As another rule of thumb, if one
more disk or partition exists, put the pagefile.sys there. After installation and
starting up the nodes, use standard Windows procedures, via Windows Task
Manager, to verify that the virtual memory being used is less than the configured
value of the virtual memory.

Disable Show Window Contents While Dragging

To prevent CPU intensive redrawing of the window, disable the Windows Show
Window Contents while dragging feature.

1. Access My Computer.

2. Right-click and select Properties from the context menu to launch the System
Properties dialog box.

3. Select the Advanced tab.

4. Click Settings in the Performance frame to launch the Performance Options
dialog box.

5. Select the Visual Effects tab (this should be selected when the dialog box is
launched).

6. Select the Custom option.
7.  Clear the Show Window Content while Dragging check box.

8.  Click Apply, wait, and then click OK to close the Performance Options dialog
box.
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9. Click OK to close the System Properties dialog box.

Disable Energy Saver and Screen Saver

It is recommended to NOT have any Energy Saving and screen saver functionality
activated on 800xA System nodes (especially operator Workplace Clients), as this
might lead to longer reaction times in case of an emergency. If the server or
workstation BIOS has an Energy Saver configuration, configure it on a node-by-
node basis. The Windows energy saving data is user dependent.

The energy saving setting may be accessed in two ways. The BIOS setup is
available whenever the server or workstation is powered up. It may also be accessed
via Power Options in Windows Control Panel. The screen saver may be turned off in
the Display Properties option in Windows Control Panel.

Disable Windows Firewall During Installation and Post Installation

In order to allow proper communications between the nodes during installation,

@ Windows Firewall must be disabled during 800xA installation and post
installation procedures, and then enabled using the Windows Firewall
Configuration Tool after all procedures are complete.

The installer should make sure that the installation procedure completes without
exposing the computers to malware or malicious network traffic of any sort. This
can only be done by limiting the communication to the system and by performing
separate virus scanning of any portable media or disks before connecting them to
the system nodes during the installation.

After completing the system installation it is recommended to perform a full virus
scan of all computers in the system.

Windows Firewall restricts communications between a workstation or server and a
network or the Internet. It might be necessary to adjust settings for some other
applications that prefer an open connection. Either exceptions can be made or a port
can be opened so these applications can communicate through Windows Firewall.

The 800xA System Installer has a standalone Windows Firewall Configuration Tool
that will make the necessary exceptions and open the necessary ports. Use this tool
to configure Windows Firewall even if manually installing the 800xA Base System
and Functional Area software.
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Use standard Windows procedures to turn off Windows Firewall on every node
in the 800xA System when performing all installation procedures described in
this instruction, and all post installation procedures described in System S800xA
Post Installation (3BUAO00156%*). Nodes that are joined to a domain have three
profile options with the Workstation Operating System (Domain, Private, and
Public). Turn off all three profiles during installation and post installation. the
Server Operating System nodes and any node that is joined to a Windows
Workgroup only require that the firewall be turned off (there are no profiles).

Refer to the Windows Firewall Configuration appendix in System 800xA Post
Installation (3BUA0O00156%*) to turn on and configure Windows Firewall on
every node in the 800xA System. The Windows Firewall Configuration Tool
turns on the firewall for the Server Operating System nodes and all Windows
Workgroup nodes, and turns on the Domain Profile for the Workstation
Operating System nodes that belong to a domain.

Disable Web Browser Popup Blocker

Some third party software may offer a web browser popup blocker. Do not use them
with the thin client portions of the integrated applications (specifically Asset
Optimization), since these applications open child window browsers to display
application data for the user. If a popup blocker is being used on a web browser,
disable it during use of these web based applications.

Disable Virus Checking Software During Installation and Post Installation

®

The installer should make sure that the installation procedure completes without
exposing the computers to malware or malicious network traffic of any sort.

This can only be done by limiting the communication to the system and by
performing separate virus scanning of any portable media or disks before
connecting them to the system nodes during the installation. After completing the
system installation it is recommended to perform a full virus scan of all
computers in the system.

If virus checking software is installed, disable it during 800xA installation and post
installation procedures.

Disable Automatic Updates

The Windows Automatic Updates feature must be disabled.

54

3BSE034678-511 G



Section 2 Prerequisites Change Local Security Policy on the Workstation Operating System

1.

2.
3.

Select:
Start > Control Panel > Windows Update
Select Change Settings from the left pane.
Under the Important Updates section, select Never Check for Updates.

Change Local Security Policy on the Workstation Operating System

In order to add a client to the 800xA System, the local security policy on
Workstation Operating System should be verified. The settings described here are
the default setting in the Workstation Operating System installation.

1.

Select:
Start > Control Panel
Double-click Administrative Tools.
Double-click Local Security Policy to open the Local Security Policy console.

Navigate to Local Policies > Security Options in the Local Security Settings
console tree in the left pane.

Double-click Network Access: Sharing and security model for local
account in the right pane to open the Local Security Setting dialog box.

Select Classic- local users authenticate as themselves in the drop-down list
box.

Click Apply and then OK.

Miscellaneous Windows Components Installation and
Configuration
The following Windows components must be installed and configured for use with

the 800xA System. Some of them are dependant on the 800xA Software that will be
used in the 800xA System and will be indicated as such:

Internet Information Services on page 56.

Enable SNMP Service on page 61.

Remote (Thin) Client for the Server Operating System on page 62.
Desktop Experience on the Server Operating System on page 63.
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PCI Express SCSI Adapter Driver on page 64.

Internet Information Services

Microsoft Internet Information Services (IIS) components must be enabled on
800xA System nodes except client nodes and separate Domain Server nodes. There
are different procedures for the Workstation Operating System and the Server
Operating System.

Workstation Operating System

Perform the following procedure to enable the required IIS components on the
Workstation Operating System.

1.

2
3.
4

Open Windows Control Panel.
Change Windows Control Panel to Large Icons view.
Click Programs and Features.

Click Turn Windows features on or off in the left pane to launch the
Windows Features dialog box.

Navigate to and expand the following:
Internet Information Services > Web Management Tools

Make the settings as shown in Figure 9. For detailed instructions for making
the settings continue with Step 7.
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Internet Information Services
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Figure 9. IIS Configuring IIS Components on the Workstation Operating System.
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10.

11.

12.
13.

14.
15.

16.
17.
18.
19.

20.

Enable the following check boxes:

—  IIS Management Console.

— IIS Management Scripts and Tools.
— IIS Management Service.

Click the plus sign (+) nextto IIS 6 Management Compatibilityto
expand it.

Enable the IIS Metabase and IIS 6 configuration compatibility check boxes.

Navigate to and expand the following:

Internet Information Services > World Wide Web Services
> Application Development Features

Enable the.NET Extensibility, ASP, ASP.NET, ISAPI Extensions, ISAPI
Filters, and Server-Side Includes check boxes.

Click the plus sign (+) next to Common HTTP Features to expand it.

Enable the Default Document, Directory Browsing, HI'TP Errors, HTTP
Redirection, Static Content, and WebDav Publishing check boxes.

Click the plus sign (+) next to Health and Diagnostics to expand it.

Enable the HTTP Logging, Logging Tools, Request Monitor, and Tracing
check boxes.

Click the plus sign (+) next to Performance Features to expand it.
Enable Static Content Compression check box.
Click the plus sign (+) next to Security to expand it.

Enable the Basic Authetication, Request Filtering and Windows
Authentication check boxes.

Click OK to make the changes and close the Windows Features dialog box.

Server Operating System

Perform the following procedure to enable the required yes components on the
Server Operating System.

1.
2.

Open Windows Control Panel.

Change Windows Control Panel to Classic View.
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Double-click Programs and Features.

4. Click Turn Windows features on or off in the left pane to launch the Server
Manager.

5. Select Roles in the left pane.

a. If this is the node that will serve as the AO Main Server or 800xA for
Harmony Connectivity Server node, check to see if Application Server
and Web Server (IIS) are in the Installed Roles pane of the Roles
Summary.

b.  If this is not a node that will serve as the AO Main Server or 800xA for
Harmony Connectivity Server node, check to see if Web Server (IIS) is in
the Installed Roles pane of the Roles Summary.

6. Click Add Roles to launch the Add Roles Wizard.
7. Click Next to advance to Select Server Roles.

8. Select the Web Server (IIS) and/or Application Server check boxes
(depending on the current configuration) and click Next.

ﬂ It is only necessary to perform Step 9 through Step 11 on the AO Main Server or
800xA for Harmony Connectivity Server node.

9. Click Next to advance to Application Server.
10. Click Next to advance to Select Role Services.

11. Select the Application Server Foundation, COM+ Network Access, TCP
Port Sharing, and all selections under the Windows Process Activation
Service Support check boxes.

12. Click Next to advance to Web Server (IIS).
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13. Make the settings as shown in Figure 10. For detailed instructions for making
the settings continue with Step 14.
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Figure 10. Configuring I1S Components on Windows 2008 Server.

14. Select the following:
—  Every check box under Common HTTP Features.
—  Every check box except CGI under Application Development.

—  Every check box except Custom Logging and ODBC Logging under
Health and Diagnostics.
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—  The Basic Authentication, Windows Authentication, and Request
Filtering check boxes under Security.

—  The Static Content Compression check box under Performance.

—  The IIS Management Console and everything except IIS 6 WMI
Compatibility and IIS 6 Scripting Tools under the IIS 6 Management
Compatibility check boxes under Management Tools.

—  Every check box under FTP Publishing Service.

15. Click Next to advance to Confirm Installation Selections. If they are correct,
click Install. If they are not, click Previous to make the proper selections.

Enable Detailed Error in IIS

This procedure is only required on Asset Optimization Server to send Custom error
response to remote node. Perform the following:

1. Open IIS Manager, select Node name, locate Error Pages in the IIS.
2. Right-click on Error Pages and select Open Feature.

3. Right-click on 500 and select Edit Feature settings.
4

Select Detailed errors option in Edit Error Pages settings dialog.

Enable SNMP Service

This procedure is required on the nodes where PC, Network and Software
Monitoring Server is installed.

Simple Network Management Protocol (SNMP) services are required by the PC,
Network and Software Monitoring software to enable PC, Network and Software
Monitoring Server nodes to communicate with remote devices that support SNMP.

There are different procedures for the Workstation Operating System and the Server
Operating System.

Workstation Operating System

To enable SNMP services in the node in which the PC, Network and Software
Monitoring Server software will be installed:
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Open Windows Control Panel.
Change Windows Control Panel to Large Icons view.

Click Programs and Features.

v b=

Click Turn Windows features on or off in the left pane to launch the
Windows Features dialog box.

5. Navigate to and expand the following:
Simple Network Management Protocol (SNMP)
6. Enable the WMI SNMP Provider check box.

7. Click OK to make the changes and close the Windows Features dialog box.

Server Operating System

To enable SNMP services in the node in which the PC, Network and Software
Monitoring Server software will be installed:

1. Open Windows Control Panel.

2. Change Windows Control Panel to Classic View.
3. Double-click Programs and Features.
4

Click Turn Windows features on or off in the left pane to launch the Server
Manager.

5. Scroll down to the Features Summary and click Add Features to launch the
Add Features Wizard.

6. Scroll down and select the SNMP Services check box. This will automatically
select the SNMP Service and SNMP WMI Provider check boxes.

7. Click Next and then Install.
8. Click Close to exit the Add Features Wizard.

Remote (Thin) Client for the Server Operating System

Perform the following procedure to install the Terminal Server role service and
configure the Terminal Server to host programs:

1. Select:

Start > Administrative Tools > Server Manager
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to launch the Server Manager.

2. Right-click Roles in the left pane and select Add Roles from the context menu
to launch the Add Roles Wizard.

3. Click Next in the Before You Begin dialog box.

4. Select the Terminal Services check box under Roles on the Select Server
Roles dialog box, and click Next.

ﬂ If Terminal Services is already installed on the server, the Terminal Services
check box will be selected and dimmed.

5. Click Next in the Terminal Services dialog box.

6. Select the Terminal Server check box in the Select Role Services dialog box,
and click Next.

ﬂ If installing the Terminal Server role service on a Domain Controller, a warning
message indicating that Installing the Terminal Server role service on a Domain
Controller is not recommended will appear.

7. Click Next in the Uninstall and Reinstall Applications for Compatibility dialog
box.

8. Select the appropriate authentication method for the Terminal Server in the
Specify Authentication Method for Terminal Server dialog box, and click Next.

9. Select the appropriate licensing mode for the Terminal Server in the Specify
Licensing Mode dialog box, and click Next.

10. Add the users or user groups who can remotely connect to this Terminal Server
in the Select User Groups Allowed Access To This Terminal Server dialog box,
and click Next.

11. Verify that the Terminal Server role service will be installed in the Confirm
Installation Selections dialog box, and click Install.

12. Restart the node when the installation is complete.

Desktop Experience on the Server Operating System

This procedure is required on 800xA for Harmony Connectivity Servers running on
the Server Operating System. 800xA for Harmony requires hardware drivers
included in Desktop Experience.

Perform the following procedure to install Desktop Experience components.
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1.

A

Select:
Start > Administrative Tools > Server Manager
to launch the Server Manager.
On the Features Summary, click Add Features.
Select the Desktop Experience check box, and click Next.
Click Install to complete the wizard.

Restart the node once the installation is complete.

PCI Express SCSI Adapter Driver

This procedure is required on 800xA for Harmony Connectivity Servers using SCSI
INICIO3 interface, model 29160N or 39160 PCI adapter.

Perform the following procedure to install the latest Adaptec 29320LPE PCle SCSI
card driver of version 7.0 (7.0.0.10).

®

ook »n

Adaptec 23320LPE PCle SCSI card driver version 7.1 and above is not supported
with 800xA for Harmony.

Download the latest Adaptec 29320LPE PCIe SCST card driver of version
7.0 from the Adaptec web site. Save the driver file to the node.

Restart the node in Safe Mode.

Uninstall the Adaptec 29320LPE PCIe SCSI card driver version 7.2.0.0.
Install the Adaptec SCSI driver downloaded in the Step 1.

Restart the node.

Network Adapters

If the Network Adapter supports Receive Side Scaling this feature must be
disabled. Refer to the Network Adapter documentation for information on how to
disable the feature.

Network adapters must be installed and configured to support communication on
the client/server network. This is required on the Domain Server node, and all
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800xA System nodes. Typically one network adapter will be provided with the
server or workstation hardware. It may be necessary to install a second network
adapter for redundancy.

All network adapters may be installed and configured at the same time during
system installation; however, the network will not run with redundancy until
Redundant Network Routing Protocol (RNRP) is installed (refer to Section 5,
RNRP for a separate Domain Server node and Section 4, 800xA Base System for all
other 800xA System nodes).

If the network adapters are not plug-and-play devices, the installation must be done
manually. If the Windows installation does not include the drivers for the network
adapters the driver software must be installed before the network adapters can be
configured.

ﬂ The 800xA System relies on TCP/IP as its transport protocol. It is strongly
recommended that TCP/IP is the only protocol in use. If other protocols need to
be installed, make sure that TCP/IP is configured as the primary protocol.

Refer to Windows Help > Networking for more information on how to install and
@ configure TCP/IP network adapters.

Refer to System 800xA Network Configuration (3BSE034463*) for configuration
of DNS.

ﬂ The following procedure applies to the Workstation Operating System nodes. The
procedure for the Server Operating System nodes may vary from the one shown
here.

To configure the network adapters:
1. Open Windows Control Panel.

2.  Double-click Network and Sharing Center to open the Network and Sharing
Center.

3. Click Change Adapter Settings.

4. Right-click on the network adapter and select Properties from the context
menu to open the Connection Properties dialog box.

5. Select Internet Protocol Version 4 (TCP/IPv4) and click
Properties to open the Internet Protocol (TCP/IP) Properties dialog box.

6. Select Use the following IP address.
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10.

11.

12.
Use the same DNS settings for all network adapters.

13.

14.

15.

Enter the IP address in the IP address field according to the planning done in
Table 1 on page 31.

Enter the subnet mask in the Subnet mask field according to the planning done
in Table 1 on page 31.

Enter the IP address of the default gateway in the Default gateway field (if
required by topology).

Enter the IP address of the Primary Domain Server in the Preferred DNS
server field.

Enter the IP address of the Secondary Domain Server in the Alternate DNS
server field.

Always specify the Domain Servers with their primary client/server network
addresses. This is true for all network adapters, including the ones for secondary
client/server networks.

Repeat for all network adapters in the servers and workstations.

Click OK as necessary to save the newly configured values, and then click
Close to close the Connection Properties dialog box.

Connect the Ethernet cables. Match each of the icons with its corresponding
Ethernet connector on the server or workstation.

Use ping and nslookup from a Windows command prompt to verify the server
or workstation has contact with the Domain Controller:

C:\>ping 172.16.4.1

Pinging 172.16.4.1 with 32 bytes of data:

Reply from 172.16.4.1: bytes=32 time<lOms TTL=64...
C:\>nslookup clientl (the name of this computer)
Server: dcl.mydomain.com

Address: 172.16.4.1

Name: clientl.mydomain.com

Address: 172.16.4.91

The connection may not work via more than one network adapter before RNRP is
installed.
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Verify the port speed and duplex configuration on both ends (Network Adapter
and network switch). Refer to System 800xA Network Configuration
(3BSE034463%).

Verify the primary network is bound first for RNRP configurations. From the
Change Adapter Settings:

e Use the Alt key to expose the Advanced Settings menu.

e  Select Advanced Settings.

e Verify the Primary RNRP is bound first and the second NIC is second.

*  Make corrections as needed.

Domain Controller and DNS Server

®

If the Domain Controller uses any network interface in addition to the ones for
the client/serer network, the DNS Server need to be configured to only listen to
DNS requests on the client/server network. Perform the following for all Domain
Controllers.

e Open the Interfaces tab under Properties for the DNS Server.
e  Select Only the following IP addresses.

e  Make sure that only the IP addresses for the client/server network are
selected.

The only 800xA software installed on a separate Domain Controller node is:
*  Diagnostics Collection Tool.

U RNRP.

e 800xA Common Third Party Install Tool.

This procedure is performed at the Domain Server, and is required for all 800xA
Systems that use domains.

For an 800xA System installation to be used as a production system, set up a new
Domain Server with a domain specifically for the 800xA System, that will exist
independent of any other corporate domains that may already exist. Follow the
procedure in this section, starting at Active Directory Domain Services on First
Forest Root Domain Controller on page 68.

The following are general recommendations:

One 800xA System may share the same domain with other 800xA Systems.
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*  Generally, it is better to create a new, dedicated domain for an 800xA System
as opposed to reusing an old domain.

* Do not create subdomains and avoid complex solutions.

*  Generally, it is not recommended to split two redundant Domain Controllers to
host engineering and production systems on two different locations (i.e.
network islands). Splitting two Domain Controllers will make one of the parts
incomplete since the Flexible Single Master Operations (FSMO) roles and
Global Catalog services are not redundant within Microsoft Windows.

Additional guidelines for setting up the 800xA System domain are provided in
System 800xA Network Configuration (3BSE034463%).

Before setting up a new domain, verify that the server hardware being used as the
Domain Server has the Server Operating System installed. the Workstation
Operating System can not be used for a Domain Controller or DNS server.

Ensure TCP/IP protocol is correctly installed on the node.

«o@m

Create a new domain by setting up a new Domain Controller and DNS server using
the Server Manager.

To set up a new domain, configure the IP addresses of the Domain Server node if
this is not already done. This procedure is described in Network Adapters on page
64.

—  Set the IP addresses according to Installation Sequence on page 27.

—  Set the IP address of this computer as the Preferred DNS Server on the
primary network adapter.

—  If using, or planning on using two Domain Servers, set the IP address of
the other Domain Server as the Alternate DNS Server on the primary
network adapter.

—  If using a redundant network, use the same DNS settings on the secondary
network adapter.

Active Directory Domain Services on First Forest Root Domain Controller

The following procedure was prepared using Install AD DS on the First Forest Root
Domain Controller as provided by Microsoft at:
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http://technet.microsoft.com/en-us/library/cc753100(WS.10).aspx

ﬂ The instructions included here are for the preferred method of installing Active
Directory Domain Services (AD DS). Refer to the Microsoft article if planning
on using alternate methods.

The interface in the Server Operating System provides two wizards for installing the
AD DS:

Add Roles Wizard - accessible from Server Manager.

Active Directory Domain Services Installation Wizard (Dcpromo.exe) -
accessible by:

—  Clicking the link to launch the Active Directory Domain Services
Installation Wizard when the Add Roles Wizard completes
(recommended).

—  Selecting Start > Run, typing depromo . exe, and clicking OK.

ﬂ Membership in the local Administrator account is the minimum required to
complete this procedure. Details about using the appropriate accounts and group
memberships can be found at http://go.microsoft.com/fwlink/?LinkId=83477.

To install AD DS:
1. Select:
Start > Server Manager

2. Click Add Roles in the Roles Summary dialog box.

3. Review the information in the Before You Begin dialog box (if necessary) and
click Next.

4. Select the Active Directory Domain Services check box in the Select Server
Roles dialog box and click Next.

5. Review the information in the Active Directory Domain Services dialog box
and click Next.

6. Click Install in the Confirm Installation Selections dialog box.

7. Click Close this wizard and launch the Active Directory Domain Services

Installation Wizard (dcpromo.exe) in the Installation Results dialog box.
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10.

Click Next in the Welcome to the Active Directory Domain Services
Installation Wizard dialog box.

Click Create a new domain in a new forest in the Choose a Deployment
Configuration dialog box and click Next.

Type the full Domain Name System (DNS) name for the forest root domain in
the Name the Forest Root Domain dialog box and click Next.

@ Do not use public domain names such as .com.

®

11.

12.

13.

14.

16.

17.
18.
19.

Enter the Domain Name as per Microsoft guidelines. Failure to follow the
guidelines will not allow nodes that are trying to be joined to the domain to join.

Select the Server Operating System in the Set Forest Functional Level dialog
box and click Next. This is the preferred method unless special needs exist for
compatibility with older Domain Controllers.

DNS Server is selected by default in the Additional Domain Controller
Options dialog box so that AD DS can create the forest DNS infrastructure
when AD DS is installed. Click Next if it is planned to use Active Directory-
integrated DNS (this is the preferred method).

Use the default locations in the Location for Database, Log Files, and SYSVOL
dialog box and click Next.

Type and confirm the restore mode password in the Directory Services Restore
Mode Administrator Password dialog box and click Next.

This password must be used to start AD DS in Directory Service Restore Mode
for tasks that must be performed offline.

15.

Review the selections in the Summary dialog box. Click Back if it is necessary
to change any selections.

Click Export settings to save the selected settings to an answer file that can be
used to automate subsequent AD DS operations.

Type the name for the answer file and click Save.
Click Next to install AD DS when the selections are accurate.

Click Finish in the Completing the Active Directory Domain Services
Installation Wizard dialog box.
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20.

A prompt appears asking to restart the server. Select either the Reboot on
Completion check box to restart the server automatically or clear the check
box to restart the server manually to complete the AD DS installation.

ﬂ System 800xA Network Configuration (3BSE034463%*) includes examples of a
correctly configured DNS Server.

21.

22.
23.
24.
25.

26.

27.

28.

29.

30.

More information about installing a new the Server Operating System forest
can be found at:

http://technet.microsoft.com/en-us/library/cc732156(WS.10).aspx

Select Administrative Tools in Windows Control Panel.
Double-click Configure Your Server Wizard.
Click Next at the Welcome dialog and the Preliminary Steps dialog.

If any of the network connections on the server do not work, the following
warning may appear:

At least one of the network connections on this server
is currently disconnected. If a server connection is
not working, this wizard might not be able to configure
the server properly. Before continuing, ensure that all
of your network connections are working properly.

Disregard this message and click Continue when configuring the first Domain
Controller. However, when configuring a backup Domain Controller it is
important that it has a network connection to the primary Domain Controller.

Select Custom Configuration in the Configuration Options dialog and click
Next.

Select Domain Controller (Active Directory) in the Server Role list in the
Server Role dialog and click Next.

At the Summary dialog, click Next and wait while the wizard is installing and
configuring the Active Directory.

Click Next in the Active Directory Installation dialog that appears and in the
Operating System Compatibility dialog.

Select Domain controller for a new domain in the Domain Controller Type
dialog and click Next.
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31.

32.

Select Domain in a new forest in the Create New Domain dialog and click
Next.

Choose a proper name for the (still nonexistent) domain in the New Domain
Name dialog and click Next.

@ Do not use public domain names such as .com.

33.
34.

35.

36.

37.

38.

39.

40.

41.
42.

43.
44.

Choose a proper name in the NetBIOS Domain Name dialog and click Next.

Click Next in the Database and Log Folders and Shared System Volume
dialogs.

Select Install and configure the DNS server on this computer, and set this
computer to use this DNS server as its preferred DNS server in the DNS
Registration Diagnostics window and click Next.

Select Permissions compatible only with Windows 2000 or Windows
Server 2008 in the Permissions dialog (this is to maximize security) and click
Next.

Specify a password in the Directory Services Restore Mode Administrator
Password dialog and click Next.

Remember this password. Set this password carefully and record it for future use
in case there are problems with the Active Directory.

Click Next in the Summary dialog and wait for the configuration process to
finish.

When the configuration is complete, click Finish and choose to Restart
Windows.

As windows starts, the following message should appear:
This Server is Now a Domain Controller

Click Finish.

Open Administrative Tools in Windows Control Panel.

Double-click DNS and verify that only the Forward lookup zone has been
created.

Right-click Reverse lookup zone and choose New Zone.

Click Next in the Welcome dialog.
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45. Select Primary in the Zone Type dialog.

46. Make sure that Store the zone in Active Directory is enabled in the Zone Type
dialog and click Next.

47. Select To all domain controllers in Active directory domain <Your
Domain> in the Active Directory Zone Replication Scope dialog and click
Next.

48. Enter the Network ID for the primary network for this computer; for
example: 172.16.4.1, in the Reverse Lookup Zone Name dialog and click Next.

49. Select Allow only secure dynamic updates in the Dynamic Update dialog and
click Next.

50. Click Finish in the Completing the New Zone Wizard dialog.

51. If there is a redundant network, repeat Step 43 through Step 48 to add a
Reverse Lookup Zone for the secondary network. Enter the network ID for
secondary network; for example: 172.17.4.1.

If configuring just one Domain Controller, the configuration is complete. To
configure a second Domain Controller, continue to Active Directory Domain
Services on Second Forest Root Domain Controller.

Active Directory Domain Services on Second Forest Root Domain Controller

The following procedure was prepared using Install AD DS on the Second Domain
Controller as provided by Microsoft at:

http://technet.microsoft.com/en-us/library/cc771411(WS.10).aspx

ﬂ The instructions included here are for the preferred method of installing Active
Directory Domain Services (AD DS). Refer to the Microsoft article if planning
on using alternate methods.

The interface in the Server Operating System provides two wizards for installing the
AD DS:

* Add Roles Wizard - accessible from Server Manager.

¢ Active Directory Domain Services Installation Wizard (Dcpromo.exe) -
accessible by:
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To
1.

10.

—  Clicking the link to launch the Active Directory Domain Services
Installation Wizard when the Add Roles Wizard completes
(recommended).

—  Selecting Start > Run, typing depromo . exe, and clicking OK.

Membership in the Domain Admins group for the domain in which the second
Domain Controller is being installed is the minimum required to complete this
procedure. Details about using the appropriate accounts and group memberships

can be found at http://go.microsoft.com/fwlink/?LinkId=83477.

install AD DS on a Domain Controller in an existing domain:
Select:
Start > Server Manager
Click Add Roles in the Roles Summary dialog box.

Review the information in the Before You Begin dialog box (if necessary) and
click Next.

Select the Active Directory Domain Services check box in the Select Server
Roles dialog box and click Next.

Review the information in the Active Directory Domain Services dialog box
and click Next.

Click Install in the Confirm Installation Selections dialog box.

Click Close this wizard and launch the Active Directory Domain Services
Installation Wizard (dcpromo.exe) in the Installation Results dialog box.

Click Next in the Welcome to the Active Directory Domain Services
Installation Wizard dialog box.

Select Existing Forest and Add a domain controller to an existing domain
in the Choose a Deployment Configuration dialog box and click Next.

Type the name of the existing domain in the forest and then take the following
actions:

a. Select My current logged on credentials or Alternate credentials under
Specify the account credentials to use to perform the installation and
click Set.
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b. Provide the user name and password for an account that can install the
additional Domain Controller (it must be a member of the Enterprise
Admins group or the Domain Admins group) in the Windows Security
dialog box and click Next.

11. Select the domain of the new Domain Controller in the Select a Domain dialog
box and click Next.

12. Select a site from the list, or select the option to install the Domain Controller
in the site that corresponds to its IP address in the Select a Site dialog box and
click Next.

13. Make the following selections in the Additional Domain Controller Options
dialog box and click Next.

—  DNS Server: This option is selected by default when AD DS integrates
the DNS server service in to the domain so that the Domain Controller can
function as a DNS server (this is the preferred method).

ﬂ It is recommended that DNS be installed when the Active Directory Domain
Services Installation Wizard is run (keep the default selected), so that the wizard
creates the DNS zone delegation automatically.

—  Global Catalog: This option is selected by default. It adds the global
catalog, read-only directory partitions to the Domain Controller, and it
enables global catalog search functionality.

— Read-only domain controller: This option is not selected by default. It
makes the additional Domain Controller read-only. For more information
about read-only domain controllers, refer to:

http://go.microsoft.com/fwlink/?linkID=92728

14. Use the default locations in the Location for Database, Log Files, and SYSVOL
dialog box and click Next.

15. Type and confirm the restore mode password in the Directory Services Restore
Mode Administrator Password dialog box and click Next.
ﬂ This password must be used to start AD DS in Directory Service Restore Mode
for tasks that must be performed offline.

16. Review the selections in the Summary dialog box. Click Back if it is necessary
to change any selections.
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17.

18.
19.
20.

21.

Click Export settings to save the selected settings to an answer file that can be
used to automate subsequent AD DS operations.

Type the name for the answer file and click Save.
Click Next to install AD DS when the selections are accurate.

Click Finish in the Completing the Active Directory Domain Services
Installation Wizard dialog box.

A prompt appears asking to restart the server. Select either the Reboot on
Completion check box to restart the server automatically or clear the check
box to restart the server manually to complete the AD DS installation.

System 800xA Network Configuration (3BSE034463%*) includes examples of a

correctly configured DNS Server.

22. More information about installing a new the Server Operating System forest

can be found at:

http://technet.microsoft.com/en-us/library/cc732156(WS.10).aspx

Users and Groups

Refer to System 800xA Administration and Security (3BSE037410%) for detailed
descriptions of users, user groups, and user roles and permissions.

Refer to Users, Groups, and Rights Assignments on page 80 for listings of 800xA
System default User Groups and Users.

This section describes how to create the Windows domain users and groups in the
Active Directory on the Domain Server node.

Since the 800xA System user credential concept is built on Windows domains,
local user accounts must never be created and used on the client nodes. Clients
will always connect to the 800xA System using domain accounts. The only
exception is for single node systems, Windows Workgroups where domains are
not used, and the ABB Controller User Group used for Base Software for
SoftControl functionality in 800xA for AC 800M. In these cases all users and
groups are local.
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= ©

Before setting up Industrial IT users and user groups, verify that a domain has
been created by setting up a Domain Controller and DNS server as described in
Domain Controller and DNS Server on page 67.

This procedure requires being logged in as domain administrator. A default
domain administrator is created when the Domain Controller and domain is set
up as described in Domain Controller and DNS Server on page 67.

During the following procedure two (or more) domain accounts with administrator
privileges will be created. One account will be reserved for use by 800xA System
services. This account will NOT be used for installation, administration,
configuration, or any other system related procedures. A second administrator
account must be created and used to complete the 800xA System software
installation and post installation procedures. Create other user accounts for other
800xA System activities such as Application Engineer, System Engineer, and
Operator.

Define separate accounts and different passwords for the 800xA Service User and
the 800xA installing User.

Domain Administrator users are powerful for administrative purposes but could
by this also be dangerous from a security perspective. For security reasons the
number of users in the Domain Administrator group should be kept to a
minimum.

The 800xA Service User and 800xA Installing User do not need to be members
of the Domain Administrators group. They both need to be members of the
Builtin Administrators group on the 800xA System nodes but not on the Domain
Controller, unless it is combined with an 800xA Server.

The 800xA Installing User could be a Domain Administrator but should be set to
passive after the installation of the System. The 800xA Service User should not
be a Domain Administrator and also not a local administrator on the Domain
Controller.

The various users and groups required by the 800xA System are described in
Table 3. All groups/users must reside on the 800xA System domain.

This setup may be performed yourself, or the domain administrator may perform the
setup. In either case, use the guidelines in Table 3, and follow the step-by-step
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procedures following Table 3.

Table 3. Domain Groups/Accounts Required by 800xA System

Groups/Users

Description

Industriall TAdmin Group

Create the Industriall TAdmin Group. All 800xA System
administrators (including the 800xA Service User) must be
a member of the IndustriallTAdmin group.

IndustriallTUser Group

Create the IndustriallTUser Group. All 800xA System
users must be a member of the IndustriallTUser group.

800xA Service User

Create a new user for 800xA System services. Make this
user a member of the IndustriallTAdmin Group, the
IndustriallTUser Group, and the local administrator group
on every system node.

All 800xA System services will run under this account.
Make the name easy to recognize (for example:
800xAServicel).

NOTE 1: Creating this user requires being logged in as
domain administrator. Adding this user to the local
administrator group on every system node requires being
logged in as local administrator.

NOTE 2: The 800xA Service User must not be a member
of the Domain Administrator group. These users should be
members of the Built-in Administrators group on the
Domain Controller node.

NOTE 3: Define separate accounts and different passwords
for the 800xA Service User and the 800xA installing User.
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Table 3. Domain Groups/Accounts Required by 800xA System (Continued)

Groups/Users Description

Installing User Create a user for installing software, and performing
system administration procedures. Make this user a
member of the IndustriallTAdmin Group, the
IndustriallTUser Group, and the local administrator group
on every system node.

NOTE 1: Creating this user requires being logged in as
domain administrator. Adding this user to the local
administrator group on every system node requires being
logged in as local administrator.

NOTE 2: Define separate accounts and different passwords
for the 800xA Service User and the 800xA installing User.

Other 800xA System users Create additional users for system configuration and
operation. These users are added to the IndustriallTUser
Group.

New Organizational Unit

This organizational unit is not mandatory; however, it may be helpful to put all
800xA System groups and users into one container. To create a new unit:

1. Select:

Start > Programs > Administrative Tools > Active Directory Users
and Computers

2. In the left pane, right-click on the newly created domain server name, and
select:

New > Organizational Unit
from the context menu that appears.

3. Assign this organization unit the name Industrial IT.
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Groups
ﬂ This procedure assumes the Industrial I'T organization unit has been created.

To create the required groups:
1. Right-click on the Industrial IT folder in the left pane and select:
New > Group
from the context menu that appears.

2. Use the New Object - group dialog box to assign the group a name (for
example, IndustrialI TAdmin).

3. Set the Group scope to Global, and the Group type to Security.
4. Perform Step 1 through Step 3 for each of the two required groups:

—  IndustrialITAdmin.
—  IndustriallTUser.

ﬂ It is recommended to keep the default names of these groups.

Users, Groups, and Rights Assignments
This topic defines the default User Groups and Users for the 800xA System.

Windows Workgroups set up the same groups and users as a domain. The user rights
are also the same as in a domain, except all domain policies must be defined on each
local node. No additional policies are required for Windows Workgroups.
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User Groups and Users

All users must be members of the IndustrialITUser group if they require the
ability to start a workplace in Process Portal.

Table 4 lists the default User Groups and Users.

Table 4. Default User Groups and Users

Organizational
Unit

User Group

User Account

Description

Industrial IT

Industriall TAdmin

800xAService

800xA System service account

800xAlnstaller

800xA System installer account

Administrator

System installer default account

Customer Admin

Additional customer administrators

Industriall TUser

800xAService

800xA System service account

800xAlnstaller

800xA System installer account

ApplicationEngineer

Default application engineer

SystemEngineer

Default system engineer

MaintenanceSupervisor

Default maintenance supervisor

MaintenanceEngineer

Default maintenance engineer

MaintenanceTechnician

Default maintenance technician

Operator

Default operator 1

Operator2

Default operator 2

Administrator

System installer default account

Customer Users

Additional customer users
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Local Groups and Members on Each Node

Table 5 lists the local and domain User Groups and Users for each system node.

Table 5. Local Groups and Members on Each Node in System

Local Group/User Domain Group/User

Administrators (standard default) 800xAService

800xAlnstaller

HistoryAdmin (Information Management |800xAService
Server node only)

800xAlnstaller

ORA_DBA (Information Management 800xAService
Server node only)

800xAlnstaller

User Assignment Rights

Table 6 lists the user assignment rights.

Table 6. User Rights Assignments

Policy Security Setting

Domain Security Policy

None defined

Domain Controller Security Policy

None defined

Local Security Policy (each node)

Access this node from the network Industriall TAdmin
IndustriallTUser

Allow log on locally (Server Operating System) Industriall TAdmin

Change system time Industriall TAdmin
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Users, Groups, and Rights Assignments

Table 6. User Rights Assignments (Continued)

Policy Security Setting
Local Security Policy (each node) (continued)
Log on as batch job 800xAService
800xAlnstaller
Log on as service 800xAService

800xAlnstaller

Log on locally (Workstation Operating System)

Industriall TAdmin

Impersonate a client after authentication

SERVICE (Default)
Administrators (Default)
Users that require logover (Process Portal)

Additional Local Security

Policies on Batch Server

Act as part of operating system

Adjust memory quotas for a process

Bypass traverse checking

Replace a process level token

800xAService

Additional Local Security Policies for Harmony/Melody Servers

Act as part of operating system

Generate security audits

Impersonate a Client after Authentication

Log on as Service

800xAService
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800xA Service User

Define separate accounts and different passwords for the 800xA Service User and
the 800xA installing User.

This procedure assumes the Industrial IT organization unit has been created.

Creating this user requires being logged in as domain administrator. Adding this
user to the local administrator group on every system node requires being logged
in as local administrator.

Create the 800xA Service User. This is the user account that all 800xA System
services will run under. Make this new user a member of the following groups:

*  IndustrialITAdmin Group

e IndustriallTUser Group

*  Local Administrator group on every system node

*  Builtin Administrators group on the Domain Controller node.

To create this user:
1. Right-click on the Industrial IT organizational unit in the left pane and select:
New > User
from the context menu that appears.

2. Inthe New Object - User dialog box specify the user name and login name.
Make the name meaningful and easy to recognize (for example:
800xAServicel).

Click Next when finished.

4. Specify the user password. Enable the Password never expires check box, and
make sure the password for this user is NEVER CHANGED.

5. Click Next when finished with the password specification.
6. Click Finish in the next dialog box to complete the user specification.
7. Make this user a member of the IndustriallTAdmin Group.

Select the Industrial IT organizational unit in the left pane.

b. Right-click on the IndustrialI TAdmin group in the right pane and choose
Properties from the context menu that appears (or double-click the group
name).
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Select the Members tab in the Properties dialog box.

d. Click Add. This displays the Select Users, Contacts, or Computers dialog
box.

Select the new user (for example, 800xAServicel) and click Add.
Repeat Step e to add other users to the IndustriallTAdmin group.
Click OK when finished.

Click OK on the Members tab of the Properties dialog box.

5o oo

8. Add this user to the Builtin Administrators group on the Domain Controller
node.

9. Add this user to the local administrator group on every system node.

In order to limit the abilities of the 800xA Service User, the 800xA Service User

@ may be included in the Deny Logon Locally policy on every System node. This
policy should be enabled once the System has been Installed and configured. In
case of System Update as well, the 800xA Service user should not be part of this
policy. This policy will also prevent logging in as the 800xA Service user on
Report Scheduling Server nodes (Scheduling Server nodes that need to run Excel
reports). On these nodes, the 800xA Service User must be logged in to add the
DataDirect add-ins to Excel for this user. In this case, the 800xA Service User
may be included in the Deny Logon Locally Policy after adding the add-ins, but
not before.

User Account for Installation

Define separate accounts and different passwords for the 800xA Service User and
@ the 800xA installing User.

Create an administrator account for installing all 800xA System software and
performing all post installation procedures. Follow the procedure for 800xA Service
User on page 84. The only difference is that this account should be configured so
that the password will expire, and will need to be changed periodically.

User Account Privileges for Building VB Graphic Displays

Building Graphic Displays using VB on a node in a domain requires that the user
belong to the Administrators local user group. Refer to System S800xA
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Section 2 Prerequisites

Other Users

Administration and Security (3BSE037410%*) for information on how to add users to
this group.

Building Graphic Displays using Process Graphics 2 (PG2) does not require the user
to belong to the Administrators local user group. The additional rights are not
required when PG2 is used.

Add other IndustrialIT users and make them members of the IndustriallT User
Group. Set passwords according to company policy, and change them frequently.

Adding Nodes to a Domain

This is required for all member nodes in the 800xA System (not applicable for
single node installations, for example Information Management consolidation node,
or Windows Workgroups). Perform this procedure at each node that needs to be
added to the domain.

This procedure requires an administrator user name and password defined for the
domain. Have this information available before proceeding.

1. Log on to the node as a local administrator.

2. Configure the IP address of this node as described in Network Adapters on
page 64. Make sure the DNS server address points to the IP address of the DNS
server.

3. From the desktop, right-click on My Computer and choose Properties from
the context menu that appears.

4. For the Server Operating System, perform Step a through Step e. For the
Workstation Operating System, perform Step f and Step g.

a. Select the Computer Name tab and click Change.

b.  In the Computer Name Changes dialog box, select Domain Controller.
c. Type the name of the domain in the Domain field.

d. Click OK until all dialog boxes are closed.

e. Click Yes when asked to reboot.

f.  Select the Computer Name tab and click Network ID.
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g. This launches the Network Identification Wizard. Follow the Wizard to
add the node to the domain. A domain administrator user name and
password is required during this procedure.

5. Repeat this procedure to add additional nodes to the domain.

Adding 800xA Domain Users to the Local Administrator
Group

The 800xA Service User and 800xA Installing User accounts defined in the domain
must be added to the local Administrator Group on every node in the domain,
including the Domain Controller node. There are three different procedures
depending on the node type:

*  Workstation Operating System.
e Server Operating System.
*  Domain Controller Node.

Workstation Operating System
1. Log on as a local administrator.

2. Right-click My Computer on the Windows desktop and select Manage from
the context menu that appears.

3. The Computer Management dialog box appears. In the left pane, navigate to:

Computer Management (Local) > System Tools > Local
Users and Groups > Groups

4. Double-click on Administrators to open the Administrators Properties dialog
box.

5. Click Add. This opens the Select Users, Computers or Groups dialog box.
6. Click Locations, select the domain in the Locations dialog box and click OK.

7.  Enter the names of the 800xA Service User and Installing User in the text box
and click Check Names.

8. When the dialog box indicates the names have been found, click OK.

9. To finish, click OK in the Administrators Properties dialog box.
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Server Operating System

1.
2.

0.

10.

Log on as a local administrator.

Right-click My Computer on the Windows desktop and select Manage from
the context menu that appears.

The Server Manager appears. In the left pane, navigate to:

Server Manager (node name) > Configuration > Local
Users and Groups > Groups

Select Configuration in the left pane.

Double-click on Administrators to open the Administrators Properties dialog
box.

Click Add. This opens the Select Users, Computers or Groups dialog box.
Click Locations, select the domain in the Locations dialog box and click OK.

Enter the names of the 800xA Service User and Installing User in the text box
and click Check Names.

When the dialog box indicates the names have been found, click OK.

To finish, click OK in the Administrators Properties dialog box.

Domain Controller Node

1.

Select:
Start > Control Panel
Double-click Administrative Tools.

Double-click Active Directory Users and Computers to launch the
Active Directory Users and Computers dialog box.

In the left pane, navigate to:

Active Directory Users and Computers > Domain Name >
Builtin

Double-click Administrators in the right pane to launch the Administrators
Properties dialog box.

Select the Members tab.
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7. Click Add. This opens the Select Users, Computers or Groups dialog box.
8.  Click Locations, select the domain in the Locations dialog box and click OK.

9. Enter the names of the 800xA Service User and Installing User in the text box
and click Check Names.

10. When the dialog box indicates the names have been found, click OK.
11. To finish, click OK in the Administrators Properties dialog box.

Other Third Party Software

The remainder of this section details the installation of other third party software.

The software that requires additional licenses is not included in the 800xA Common
Third Party Install Tool. This section contains information about those software
programs. Software programs installed by the 800xA Common Third Party Install
Tool are not described here.

800xA Common Third Party Install Tool

The 800xA Common Third Party Install Tool is a standalone tool that installs almost
all required third party software automatically. It installs third party software that is
common to every node in the 800xA System (including the Domain Controller
nodes). To run the tool:

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > 3rd Party Software & Tools >
800xA Common Install

2. Follow the Installation Wizard to complete the installation.
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Microsoft Office Professional

Feature Pack Functionality

The 800xA System supports the U.S. English, 32-bit version of the Microsoft
Office Professional 2007 or 2010 or 2013.

Do not upgrade Office 2007 to Office 2010 or 2013 until updating the 800xA
System to 800xA 5.1 Feature Pack. Add the datadirect add-ins manually once the
upgrade of Office is complete.

Microsoft Word

When installing Microsoft Word it is required to select Office Shared Features
from the Installation Options dialog box and to accept the default subfeatures
under the Office Shared Features selection.

Microsoft Word, which is part of the Microsoft Office Professional suite, must be
installed on all nodes where the following functions will be used:

*  Process Graphics (for Reference Documentation Tool).
*  Engineering Studio (for Document Manager Functions).
e Control Builder M (for Project Documentation Functions).

This software is available from any Microsoft reseller. Follow the installation
procedure described in the documentation provided by Microsoft.

Macro Security for Microsoft Word. Perform the following procedure for every
Industrial IT User on every node, after installation of Microsoft Word and before
continuing installing or working on the Engineering Platform:

1. Start Microsoft Word.
2. Microsoft Office 2007:
Click the Office button in the upper left corner.
Microsoft Office 2010 or 2013:

Click the File menu in the left corner.
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Click Word Options to open the Word Options dialog box.
Select Trust Center in the left pane of the Word Options dialog box.
Click Trust Center Settings to open the Trust Center.

Select Macro Settings in the left pane of the Trust Center.

N kW

Select Disable all Macros Except Digitally Signed Macros in the right pane
of the Trust Center.

*®

Click OK to close the Trust Center.
9. Click OK to close the Word Options dialog box.

10. Repeat this procedure for every Industrial IT User on every node.

Microsoft Excel

When installing Microsoft Excel 2007 or 2010 or 2013 it is required to select
@ Office Shared Features from the Installation Options dialog box and to accept the
default subfeatures under the Office Shared Features selection.

When installing Microsoft Excel, select the Custom installation. When the
Installation Options dialog box appears. select the Visual Basic for Applications
option under Shared Features.

Microsoft Excel, which is part of the Microsoft Office Professional 2007 suite, must
be installed on all 800xA System nodes where engineering tools or Excel based
reports will be used. This can include the following:

*  Process Graphics (for Display Documentation Tool).

*  Engineering Studio (for Bulk Data Manager Functions).
*  DataDirect - Excel Data Access.

*  Information Management.

*  Asset Optimization Server.

*  Batch Management.

*  800xA for Harmony.

e 800xA for AC 870P/Melody.

This software is available from any Microsoft reseller. Follow the installation
procedure described in the documentation provided by Microsoft.
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Section 2 Prerequisites

®

Macro Security for Microsoft Excel. Perform the following procedure for every
Industrial IT User on every node, after installation of Microsoft Excel and before
continuing installing or working on the Engineering Platform:

1. Start Microsoft Excel.
2.  Microsoft Office 2007:
Click the Office button in the upper left corner.
Microsoft Office 2010 or 2013:
Click the File menu in the left corner.
Click Excel Options to open the Excel Options dialog box.
Select Trust Center in the left pane of the Excel Options dialog box.

Click Trust Center Settings to open the Trust Center.

S

Select Macro Settings in the left pane of the Trust Center.

The macro security setting must be set to Enable all Macros for every Industrial
IT User on every node in the 800xA System if any of the following are true:

e  800xA for Harmony or 800xA for AC 870P/Melody is installed on any node in
the 800xA System.

. Engineering templates will be used on any node in the 800xA System.

7. Select Disable all Macros Except Digitally Signed Macros in the right pane
of the Trust Center.

8. Click OK to close the Trust Center.
9. Click OK to close the Excel Options dialog box.

Crystal Reports

Install Crystal Reports on any node where the Application Scheduler will be
installed, if Crystal Reports will be used as the reporting package on that node.
Crystal Reports does not have to be installed on nodes where the Application
Scheduler is running where Crystal Reports will not be used as the reporting
package.

The system revision supports all three versions of Crystal Reports as mentioned in
both the scenarios. Crystal Reports software is installed when users update the
system revision in the following scenarios.
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If Crystal Reports is installed for the first time - Install Crystal Reports 2008
Service Pack 5 (SP5), which is a full build installation package.

Browse SAP Business Objects web site, navigate to Service Pack section of
SAP Business Objects - Crystal Reports Runtime Packages to find the
installation package.

If Crystal Reports was already installed on the following 800xA versions, then
no change.

800xA 5.1 Revision A and 64-bit

—  Crystal Reports 2008 SP3 Full Build +
—  Crystal Reports 2008 Fix Pack 3.3

800xA 5.1

—  Crystal Reports 2008 Base +
—  Crystal Reports 2008 SP1 +
—  Crystal Reports 2008 SP2 +
—  Fix Pack 2.7

Process Engineering Tool Integration Specific Requirements

The following are requirements that exist only for Process Engineering Tool
Integration. Before installing Process Engineering Tool Integration software, install
the following prerequisites, if required:

INtools/SPI: Must be installed on a non-800xA node. If installing the Web
Services component on this node, Microsoft IIS with FrontPage server
extensions must be installed.

For viewing external CAD drawings, one of the following software
components is required to be installed on the 800xA System node on which the
800xA Client component of Process Engineering Tool Integration is installed:

— Autodesk DWG TrueView 2: Recommended to be used for viewing of
AutoCAD files. Autodesk DWG TrueView 2
(SetupDWGTrueView?.exe) is available on 800xA System Installation
DVD 5 in the following directory:
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3rd Party SW\AutoDesk
The latest version of DWG TrueView 2 can be downloaded free of charge at:

http://www.autodesk.com
—  AutoCAD.

Information Management Specific Requirement

Oracle 11gR2 runs on 64- and 32-bit operating systems. Oracle 11gR2 server
software is required for the Information Management historical services. The
applications includes reporting, data access to the information such as event,
historical data and production data. Install the Oracle program files on the system
drive (recommended). If desired, designate different drives for storing Oracle data
files, and file-based numeric log data.

The Oracle components for Information Management can be installed using the
single Oracle Installer. The Oracle Installer handles the installation of Oracle server
and client software. Information Management servers require oracle server
software. Optionally, oracle client software may be installed on other nodes in the
system and desktop tool nodes. The Installer detects the host operating architecture
and installs the correct versions of oracle for that architecture.

The following are the valid installs of Oracle:
e Oracle for Information Management Server Operating System.
*  Oracle for Client Nodes Operating System
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Section 2 Prerequisites Information Management Specific Requirement

Oracle for Information Management Server Operating System

The wizard installs (Figure 11) the 64-bit version of oracle server and 32-bit version
of oracle client in 64-bit node.

& Dracle Installer =[] x]
Oracle Installer Wizard ADD T
Processor: 64 Bit "l'l'lndumal s

Oracle 11.2.0.2

¥ Install Oracle
Oracle Server Install Status : Oracle 11 Server notinstalled
Oracle Client Install Status : Oracle 11 Client not installed

Select Oracle Component
& Install Oracle Server and Client

" Install Oracle Client Onhy

Selectthe desired drive to install on: | C:y -

Oracle CPU

¥ Install CPU
ServerCPL Install Status : Server CPU notinstalled
Client CPU Install Status : Client CFU notinstalled
Oracle Database Status Mo Database Exists
—TNS List
¥ Start THS Listener
TS Listener Status : Oracle THS Listener Mot Running
Disable Senaces Pipe Timeout Install I Reset Exit

Ready,

Figure 11. Oracle Installer Wizard

Server installation is always followed by client installation on the Information
Management Server nodes.

*  Displays the Processor: 64 Bit

*  On the Select Oracle Component group box, two options are displayed:
—  Install Oracle Server and Client.
—  Install Oracle Client Only.

e  Selectthe Install Oracle Server and Client to install the Server and
Client. The following status is displayed for Oracle 11.2.0.2, and Oracle CPU:
—  Oracle Server Install Status.
—  Oracle Client Install Status.
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—  Server CPU Install Status.
—  Client CPU Install Status.

Refer to Procedure to Install the Oracle Software on page 97 to install the Oracle
components on the node.

Oracle for Client Nodes Operating System

ﬂ Client can also be installed independently without servers in the Information
Management Client nodes.

@ Oracle Installer i ] 5
Oracle Installer Wizard ADD T
Processor: 64 Bit RIpEp I“dus_il"lnal

~ Oracle 11.2.0.2
¥ Install Oracle

Oracle Server Install Status Oracle 11 Server not installed

Qracle Client Install Status Oracle 11 Client not installed
Select Oracle Component
" Install Oracle Server and Client

% Install Oracle Client Only

Selectthe desired drive to install on: Ic:\ vl

~ Oracle CPU
¥ Install CPU
Server CPU Install Status : Server CPU install not possible
Client CPU Install Status : Client CPU not installed
Oracle Database Status : MNo Database Exists

~ TNS Listener
I~ Start TNS Listener

TNS Listener Status : Cannot Start TNS Listener

Install I Reset Exit

Ready.

Figure 12. Oracle Installer Wizard Installing Oracle Client

*  Displays the Processor: 64 Bit

*  On the Select Oracle Component group box, two options are displayed:
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— Install Oracle Server and Client.
—  Install Oracle Client Only.

e Select Install Oracle Client Only to install the Oracle Client. The
following status is displayed for Oracle 11.2.0.2, and Oracle CPU:
—  Oracle Server Install Status.
—  Oracle Client Install Status.
—  Server CPU Install Status.
—  Client CPU Install Status.

Refer to Installing Oracle Client on page 99 to install the client components on the
64-bit node.

Procedure to Install the Oracle Software

The Oracle software is accessible from the DVD 5. To install Oracle Server
software:

1. Insert the DVD 5 into the DVD drive.

2. Use Windows Explorer to locate and run OracleInstaller.exe in the
following location:

\3rd Party SW\Oracle\OraclellR2

3. If a Windows Security Warning - Open File dialog box appears, click Run to
continue.

4. The Oracle Installer Wizard (Figure 11) containing the following components
appears:

—  Oracle (11.2.0.2).
—  Oracle CPU.
— TNS Listener.

The Oracle Server, CPU, and TNS Listener are enabled for installation, by default.
The status for the Oracle components is displayed as shown in Figure 11 for a fresh
installation.

5. Select the Oracle Component - Server/Client.
6. Select the path to install the Oracle Server.

7.  Click Install to install the oracle components.
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8. A dialog box appears with the following message:

Are you sure you would like to install the following
Components?

Oracle 11 Server
Oracle 11 Client
Server CPU

Client CPU

Oracle TNS Listener

Click Yes to continue.

9. An Information message dialog box (Figure 13) is displayed describing the
actions to be taken in the following steps. Click OK to continue.

Information léj

i 0 b Oracle 11 Server: When prompted, press "Enter” to complete Oracle 11
W' Serverinstallation.
Oracle11 Client: When prompted, press "Enter” to complete Oracle 11
Client installation.

Critical Patch Update : When prompted for the email address, enter a
blank address and a "y" te remain uninformed of security updates.

Figure 13. Oracle Information Dialog Box

10. A Console Window is displayed with the installation information, the log file
location, and the installation progress. When the Console Window indicates
that the Oracle installation is complete and displays the message Please
press Enter to exit, press Enter to exit.

11. The CPU installation starts in a Console Window and indicates for the
following inputs:

a. E-mail Address/User Name: Enter a Blank address and then Enter to
continue.
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b. Do you wish to remain uninformed of Security issues ( [Y] es, [N]o):
Press Y and then Enter to continue.

Perform the actions described in Figure 13.

12. The Console Window indicates Is local system ready for patching
Press y and then Enter to continue.

13. The Installer starts to configure the TNS Listener. Once the TNS Listener is
configured and running, the Oracle Home Name (Server Home and Client
Home) and Home path is displayed.

14. The status message is displayed as Ready, which indicates the Installation is
complete.

15. Click Finish to exit the Oracle Installer.

Installing Oracle Client
1. Perform Step 1 through Step 4 from the Server Installation.

2. On the Oracle Installer Wizard (Figure 12), Select Install Oracle Client Only
to install the client.

ﬂ The Oracle Client is installed on a separate machine.

3. Click Install to install the oracle components.

4. A dialog box is displayed with the following message:

Are you sure you would like to install the following
Components?

Oracle 11 Client
Critical Patch Update
Click Yes to continue.
ﬂ TNS Listener is not installed with Oracle Client.
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5. Perform the Step 7 through Step 10 from the Server Installation to install the
Oracle Client and CPU patch.

ﬂ Database password is not required for the CPU Installation.

6. The status message is displayed as Ready, which indicates the Installation is
complete.

7. Click Finish to exit the Oracle Installer.

Backup Software

It is recommended that a third party backup/restore and/or disk imaging utility be
used to save (and restore if necessary) server and workstation hard drives. A valid
backup insures that the system can be restored.

Internet Explorer

Microsoft has announced that from January 12 2016 they will only support one
Internet Explorer version per operating system.

It is mandatory for users to update to latest Internet Explorer versions as mentioned
in the Microsoft announcement to continue receiving Security Updates.

For System 800xA 5.1 Revision E this means that it will only support the following
versions of Internet Explorer:

e Internet Explorer 11 - On Windows 7 SP1 (32- and 64-bit), Windows Server
2008 R2 64-bit.

e Internet Explorer 9 - On Windows Server 2008 SP2 32-bit.

Users running 32-bit 800xA Systems can have two Internet Explorer versions in
the same system (IE 9 for Windows 2008 SP2 and IE 11 for Windows 7 SP1 32-
bit).

For more information, refer to System 800xA 5.1 - Ceased Internet Explorer Support
- Update Product Update (3BSE083144) in ABB Library.

To have a seamless update to Internet Explorer 11, perform the following steps:
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Section 2 Prerequisites Group Policy Management

1. Install Internet Explorer 11 mandatory pre-requisites (which include Updates,
hotfixes and Security Updates) as provided in the link:
http://support.microsoft.com/kb/2847882 and restart the node.

2. Download and install Internet Explorer 11 and restart the node.

3. Resume System Update Tool and proceed with 800xA Update.

Download and Update to Internet Explorer 9.0 for Windows 2008 SP2 before
updating to System 800xA 5.1 Revision E.

If Internet Explorer 9.0 or 11.0 is installed, all 800xA Systems with Revision A or
older versions/revisions must be upgraded to 800xA 5.1 Revision E to enable
Process Portal A workplace to function, as required.

Install the hotfix https://support.microsoft.com/en-us/kb/3074850 to reduce the
Memory usage in Internet Explorer 11 that is introduced with MS15-032.

© &

Install or re-install the ABB recommended security updates for the latest Internet
Explorer 9.0 or 11.0. For more information on security updates, refer to Security
Updates Validation Status for System 800xA (3BSE041902) document.

Group Policy Management

The following procedure must be performed on the Primary Domain Controller. It
must be performed after all 800xA System nodes are added to the domain so that the
new Group Policy replicates to all nodes in the selected domain through the active
directory. However, if the system is expanded at a later time, the Group Policy will
replicate to the nodes added during the expansion.

Group Policy Settings for Systems with Internet Explorer 11 Installed

Domain Environment
1. Select:
Start > Run
2. Enter gpme.msc in the Run dialog box and click OK.
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Group Policy Settings for Systems with Internet Explorer 11 Installed Section 2 Prerequisites

Right-click the domain name in the left pane of the Group Policy Management
Console, and select Create a GPO in this domain, and Link it here... from
the context menu to open the New GPO dialog box.

Type in a name for the new Group Policy Object in the New GPO dialog box;
for example, IntranetName and click OK to return to the Group Policy
Management Console.

Right-click on the new Group Policy Object in the left pane of the Group
Policy Management Console, and select Edit from the context menu to open
the Group Policy Object Editor.

Navigate to the following in the left pane of the Group Policy Object Editor:

User Configuration > Policies > Administrative Templates > Windows
Components > Internet Explorer > Internet Control Panel >Advanced
Page

Double-click on Turn on Enhanced Protected Mode and change the setting
from Not Configured to Disabled.

Click OK.
Navigate to the following in the left pane of the Group Policy Object Editor:

User Configuration > Policies > Administrative Templates > Windows
Components > Internet Explorer > Internet Control Panel > Security
Page (see Figure 14)
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Group Policy Settings for Systems with Internet Explorer 11 Installed

B Group Policy Management Editor

Fle Acton View Help

e |HE= [ T

= G1 Group Policy Object [W2KBRU2SP 1-DC.HARN = |
I 4l Computer Configuration
| Polides
| Preferences
Bl 4 User Configuration
= [ Polides
| Software Settings
| Windows Settings
Bl [ Administrative Templates: Policy defi
*| Control Panel
| Desktop
I Network
| Shared Folders
| Start Menu and Taskbar
| System
| Windows Components
“| Application Compatibility

B

m

“| Attachment Manager
“| AutoPlay Policies
| Backup
“| Desktop Gadgets
~| Desktop Window Manager
| Digital Locker
| Instant Search
Bl 7 Internet Explorer
| Accelerators
| Administrator Approved
| Application Compatibility
| Browser menus
“ Compatibility View
| Delete Browsing History
| Internet Control Panel
“| Advanced Page
“| ContentPage
General Page

=]

B Security Page

Select an item to view its description.

Extended

Setting

State

| Internet Zone

"I Intranet Zone

| Local Machine Zone

“| Locked-Down Internet Zone

| Locked-Down Intranet Zone

“| Locked-Down Local Machine Zone
_| Locked-Down Restricted Sites Zone
| Locked-Down Trusted Sites Zone
“| Restricted Sites Zone

| Trusted Sites Zone

tranet Sites: Indude all local (intranet) sites notlisted in other z...  Not configured
cked-Down Internet Zone Template Not configured
ternet Zone Template Not configured
cked-Down Intranet Zone Template Not configured
tranet Zone Template Not configured
cked-Down Local Machine Zone Template Not configured
cal Machine Zone Template Not configured
cked-Down Restricted Sites Zone Template Not configured
estricted Sites Zone Template Not configured
cked-Down Trusted Sites Zone Template Not configured
usted Sites Zone Template Not configured
Urn on certificate address mismatch warning Not configured
tranet Sites: Indude all sites that bypass the proxy server Not configured
tranet Sites: Include all network paths (UNCS) Not configured
te to Zone Assignment List Not configured
Urn on automatic detection of intranet Not configured
urn on Notification bar notification for intranet content Not configured
4 | |

Standard /

Figure 14. Path to Navigate in GPO Editor

10.

Double-click on Intranet sites: Include all local (intranet) sites not listed in

other zones and change the setting from Not Configured to Enabled.

11.
12.

Click OK.

and change the setting from Not Configured to Disabled.

13.
14.

Click OK.

change the setting from Not Configured to Disabled.

15. Click OK.

Double-click on Intranet sites: Include all sites that bypass the proxy server

Double-click on Intranet sites: Include all network paths (UNCs) and
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16. Double-click on Turn on automatic detection of intranet and change the
setting from Not Configured to Disabled.

17. Click OK. The Security Page appears with following settings (see Figure 15).

2] intranet Sites: Indude all local (intrane s not listed in other z... Enabled

|i=| Locked-Down Internet Zone Template Mot configured
|=| Internet Zone Template Mot configured
|i=| Locked-Down Intranet Zone Template Mot configured
|i=| Intranet Zone Template Mot configured
=] Locked-Down Local Machine Zone Template Mot configured
=] Local Machine Zone Template Mot configured
|i=| Locked-Down Restricted Sites Zone Template Mot configured
|i=| Restricted Sites Zone Template Mot configured
|i=| Locked-Down Trusted Sites Zone Template Mot configured
|i=] Trusted Sites Zone Template Mot configured
|=| Turn on certificate address mismatch warning Mot configured
|i=| Intranet Sites: Indude &l sites that bypass the proxy server Disabled

|i=| Intranet Sites: Indude all network paths (UNCs) Disabled

|i=] Site to Zone Assignment List Mot configured
|=| Turn on automatic detection of intranet Disabled

|=] Turn on Notification bar notification for intranet content Mot configured

Figure 15. Security Page with the Settings

18. Close the Group Policy Object Editor.
19. Reboot the node.

Windows Workgroup Environment

Perform the following procedure on 64-bit Windows Server 2008 RU2 SP1 with
Internet Explorer 11 in Windows Workgroups.

1. Select:
Start > Run

2. Enter gpedit.msc in the Run dialog box and click OK to launch the Local
Group Policy Editor.

3. Navigate to the following in the tree view:
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10.

11.
12.

13.
14.

15.
16.
17.

User Configuration > Policies > Administrative Templates > Windows
Components > Internet Explorer > Internet Control Panel >Advanced
Page

Double-click on Turn on Enhanced Protected Mode and change the setting
from Not Configured to Disabled.

Click OK.
Navigate to the following in the tree view:

User Configuration > Administrative Templates > Windows
Components > Internet Explorer > Internet Control Panel > Security
Page (see Figure 14)

Select the security object.

Double-click on Intranet sites: Include all local (intranet) sites not listed in
other zones and change the setting from Not Configured to Enabled.

Click OK.

Double-click on Intranet sites: Include all sites that bypass the proxy server
and change the setting from Not Configured to Disabled.

Click OK.

Double-click on Intranet sites: Include all network paths (UNCs) and
change the setting from Not Configured to Disabled.

Click OK.

Double-click on Turn on automatic detection of intranet and change the
setting from Not Configured to Disabled.

Click OK (see Figure 15).
Close the Group Policy Object Editor.
Reboot the node.

Group Policy Settings for Systems with Internet Explorer 9 Installed

The following procedure must be performed on the Primary Domain Controller in a
domain environment, and on every node in a Windows Workgroup environment.
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The procedures differ depending on the environment (domain or Windows
Workgroup).

Domain Environment

Perform this procedure before installing 800xA System and Functional Area
@ software.

Disabling Protected Mode. Perform the following procedure to disable the
Windows Protected Mode feature:

ﬂ This procedure only applies to the Server Operating System nodes in domain
environments. Refer to Windows Workgroup Environment on page 110 to disable
protected mode on every the Server Operating System node in Windows
Workgroups.

1. Select:
Start > Run
2. Enter gpme.msc in the Run dialog box and click OK.
3. Navigate to the following in the tree view:
Domains > Current Domain Name > GroupPolicy Objects

4. Right-click the Default Domain Policy object and select Edit from the
context menu to launch the Group Policy Management Editor.

5. Navigate to the following in the tree view:

User Configuration > Policies > Windows Settings > Internet Explorer
Maintenance > Security

6. Select the security object.
7. Double-click Security Zones and Content Ratings in the right pane.

8. Select Import the current security zones and privacy settings in the Security
Zones and Privacy section.

9. The Internet Explorer Enhanced Security Configuration dialog box appears.
Click Continue.
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10.
11.
12.
13.
14.

Click Modify Settings.

Open the Security tab.

Select Local Intranet Security.

Clear the Enable Protected Mode check box.

Close all dialog boxes, making sure to click OK and not CANCEL.

Group Policy. This procedure must be performed on the Primary Domain
Controller. It should be performed after all 800xA System nodes have been added to
the domain so that the new Group Policy will replicate out to all nodes in the
selected domain via the active directory. However, if the system is expanded at a
later time, the Group Policy will replicate to the nodes added during the expansion.

1.

2.

Select:
Start > Run

Enter gpme .msc in the Run dialog box and click OK to launch the Group
Policy Management Console.

new Group Policy Object.

@ Do not modify the default Group Policy Object itself. Create, link and modify a

Right-click the domain name in the left pane of the Group Policy Management
Console, and select Create a GPO in this domain, and Link it here... from
the context menu to open the New GPO dialog box.

Type in a name for the new Group Policy Object in the New GPO dialog box;
for example, IntranetName and click OK to return to the Group Policy
Management Console.

Right-click on the new Group Policy Object in the left pane of the Group
Policy Management Console, and select Edit from the context menu to open
the Group Policy Object Editor.

Navigate to the following in the left pane of the Group Policy Object Editor:

User Configuration > Windows Settings > Internet Explorer
Maintenance > Security

Double-click the following in the right pane of the Group Policy Object Editor:
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Security Zones and Content Ratings

to open the Security Zones and Content Ratings dialog box (Figure 16).

Security Zones and Content Ratings x|

Security and Privacy Settings I

Y'ou can customize the settings of each security zone as well as customizing the privacy settings. These settings
must be made through the Modify Settings button belov. For more detailed help, refer to the help documents.

— Security Zones and Privacy

i Do mot customize security 2ones and privacy

& |mport the cument securty zones and privacy settings Modify Saltingsl

Content ratings allovw you to prevent ugers from viewing sites with risky content. Ratings are set on a per-site basis
and are rated by the author for deagrees of risky language, nudity, and violence.

[~ Conten
&5

" Impart the current Content Ratings settings rodify Settings I

Ok I Cancel | Lpply | Help |

Figure 16. Security Zones and Content Ratings Dialog Box
8.  Select the Import the current security zones and privacy settings option in
the Security Zones and Privacy frame.

9. The Internet Explorer Enhanced Security Configuration dialog box appears.
Click Continue.

10. Click Modify Settings in the Security Zones and Content Ratings dialog box to
open the Internet Properties dialog box with the Security tab selected.

11. Select the Local Intranet icon.
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12. Click Sites to open the Local Intranet dialog box (Figure 17).

Local intranet x|

‘:' Use the settings below to define which websites are inchuded in
.} the local intranet zone.,

[ Aukomatically detect intranet nebwork:

¥ Include all lacal intranet) sites not listed in other zones
[ Include all sites that bypass the proxy server
[ Inchude all network paths (LMCS)

what are intranet settings?  Advanced | OK I Cancel

Figure 17. Local Intranet Dialog Box

13. Clear the Automatically detect intranet network check box.

14. Select the Include all local (intranet) sites not listed in other zones check
box.

15. Verify that all other check boxes are cleared.

16. Click OK three times to close all open dialog boxes.
17. Close the Group Policy Object Editor.

18. Reboot the node.

Adding Workstations to the Domain Policy. Perform the following in order to
prevent any user from being able to add workstations to the domain.

1. Select:
Start > Run

2. Enter gpmc.msc in the Run dialog box and click OK to launch the Group
Policy Management Console.

3. Navigate to the following:

Forest: Domain Name > Domains > Domain Name > Group Policy
Objects > Default Domain Controllers Policy
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4. Right-click Default Domain Controllers Policy and select Edit from
the context menu to launch the Group Policy Management Editor.

5. Navigate to the following:

Default Domain Controllers Policy > Computer Configuration
Policies > Windows Settings > Security Settings > Local Policies >
User Rights Assignment

6. Intheright pane, double-click Add workstations to domain tolaunch the
Add workstations to domain Properties dialog box.

7. Select Authenticated Users and click Remove.
8. Click Add User or Group to launch the Add User or Group dialog box.
9. Click Browse to launch the Select Users, Computers, or Groups dialog box.

10. Select the users and/or groups that are to have the authority to add workstations
to the domain and click OK twice to return to the Add workstations to domain
Properties dialog box.

Click Find Now in the Select Users, Computers, or Groups dialog box to display
@ the available users and groups.

11. Click Apply and then OK to close the dialog box.
12. Close the Group Policy Management Editor.

Windows Workgroup Environment

Perform this procedure before installing 800xA System and Functional Area
@ software.

Disabling Protected Mode. Perform the following procedure to disable the
Windows Protected Mode feature:

ﬂ This procedure only applies to the Server Operating System nodes in Workgroup
environments.

1. Select:
Start > Run
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8.
9.

10.
11.
12.

Enter gpedit.msc in the Run dialog box and click OK to launch the Local
Group Policy Editor.

Navigate to the following in the tree view:

User Configuration > Windows Settings > Internet Explorer
Maintenance > Security

Select the security object.
Double-click Security Zones and Content Ratings in the right pane.

Select the Import the current security zones and privacy settings option in
the Security Zones and Privacy section.

The Internet Explorer Enhanced Security Configuration dialog box appears.
Click Continue.

Click Modify Settings.

Open the Security tab.

Select Local Intranet.

Clear the Enable Protected Mode check box.

Close all dialog boxes, making sure to click OK and not CANCEL.

Group Policy. This procedure must be performed on every node in the Windows
Workgroup. If the system is expanded at a later time, this procedure must be
performed on each node added during the expansion.

1.

From the Windows Taskbar, select:
Start > Run

Enter gpedit.msc in the Run dialog box and click OK to open the Local
Group Policy Editor.

Navigate to the following in the left pane of the Group Policy Object Editor:

User Configuration > Windows Settings > Internet Explorer
Maintenance > Security

Double-click the following in the right pane of the Group Policy Object Editor:

Security Zones and Content Ratings
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10.

11.
12.
13.
14.

to open the Security Zones and Content Ratings dialog box (Figure 16).

Select the Import the current security zones and privacy settings option in
the Security Zones and Privacy frame.

Click Modify Settings in the Security Zones and Content Ratings dialog box to
open the Internet Properties dialog box with the Security tab selected.

Select the Local Intranet icon.
Click Sites to open the Local Intranet dialog box (Figure 17).
Clear the Automatically detect intranet network check box.

Select the Include all local (intranet) sites not listed in other zones check
box.

Verify that all other check boxes are cleared.

Click OK three times to close all open dialog boxes.
Close the Local Group Policy Editor.

Reboot the node.

Adding Privileges to the 800xA Service User

This procedure only applies to the following node types. If these node types are not
present in the system this procedure can be skipped.

800xA for Harmony Configuration Server nodes.

800xA for Harmony Connectivity Server nodes.

800xA for Harmony Configuration Server with Connectivity Server nodes.
800xA for AC 870P/Melody Configuration Server nodes.

800xA for AC 870P/Melody Connectivity Server nodes.

There are some services that run under the 800xA Service User account for the
listed node types. Perform the following procedure to add the proper privileges to
the 800xA Service User account.

1.
2.
3.

Log off the 800xA Installing User account.
Log on the 800xA Service User account.

Log off the 800xA Service User account.
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4. Log on the 800xA Installing User account.

Windows Updates and Hot Fixes

Refer to Third Party Software System 800xA (3BUA000500%*) to install the listed
operating system updates and hot fixes. This document is accessible from ABB
SolutionsBank.
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Section 2 Prerequisites
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ﬂ The Central Licensing System (CLS) also has a Central Licensing System
extension that will add the License Usage aspect to the 800xA System. This can
be used to view the currently allocated licenses. Refer to Central Licensing
System Extension on page 122.

Set up a License Server by installing the CLS Server on the Primary Aspect Server
node. Install the CLS Client on all other 800xA System nodes, except Domain
Server nodes.

Certain 800xA System functions must be licensed before use. These functions will
not operate until their licenses are installed. The software is licensed by relating a
software key for each feature with a unique machine identifier. Software keys are
obtained from the ABB Software License Administration System (SOFA). This
section describes how to install the licensing software and use the License Entry
program to apply for software keys. The software keys must be installed on the node
where the Central Licensing Server software is installed when they are received
from ABB. Section 30, Licensing 800xA System Software explains how to install
and manage the software keys.

Licensing Overview

The 800xA System uses a licensing mechanism called the Central Licensing System
(CLS). One designated node, typically the Primary Aspect Server node, should
contain the License Server (CLS Server), thus becoming the License Server node.
This server dynamically distributes the available licenses as they are needed to all
other nodes within the system. As an alternative, licenses may also be reserved for
use by a particular node.

Software keys are generated by ABB, and are uniquely associated with the machine
identifier (ID) of the License Server node. The machine ID may be an Ethernet
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address or a hardware dongle ID. For the software to run, the machine ID used to
generate the software key must be present on the License Server node. The License
Server software periodically checks that the machine ID is still present. A single
machine ID supports multiple software keys for different features and for different
applications.

The machine ID is sent to ABB when a license key request is made. After receiving
the software keys, they can be entered in the License Entry program for proper
software operation.

License Server Setup

ﬂ Unless otherwise specified, log on as the Installing User from this point through
the completion of the installation and post installation process.

Set up a License Server by installing the CLS Server component on the Primary
Aspect Server node.

To install the required licensing components on the designated License Server:

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Base Functionalities > Licensing > Central
Licensing

2. Follow the Installation Wizard to complete the installation. Perform the
following when the indicated dialog boxes appear:

a. Select Components dialog box: Select the Server option. All required
client components are also installed as part of the server installation.

b. Username and Password dialog box: Enter the username and password
for the 800xA Service User (refer to Users and Groups on page 76). Use
the domain\user syntax to specify a domain account.

c. InstallShield Wizard Complete dialog box: Select the Start LCC
Service check box.

3. Continue with Obtaining the Machine ID.

Obtaining the Machine ID

There are two types of machine IDs that the ABB licensing program supports: a
removable hardware key, called a dongle, or the fixed Ethernet address of a network
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adapter. Each of the machine ID types has advantages and disadvantages. Using the
Ethernet address as a machine ID is generally more convenient. However, if the
network adapter is ever replaced or permanently removed from the node, a new set
of software keys will be required.

The Rainbow SentinelSuperPro hardware key, or dongle, is a copy protection device
that comes in two formats - the parallel port version attaches to the 25-pin parallel
port of the node, and the USB version attaches to a USB port of the node. Some
advantages of a dongle are:

*  The dongle can be moved to another node without needing to get new software
keys. However, dongles can only be attached to a single node at any given time.

e Other machine IDs may need to be replaced to upgrade the software. New
software keys must then be requested. However, there is no need to replace the
dongle with another one.

e The parallel port version of the Rainbow SentinelSuperPro dongle allows
sharing of the parallel port with most other parallel port devices.

To use a dongle as the machine ID, order it from ABB. When received, record the
dongle number on the ABB licensing registration form and install the dongle.

In most cases, ABB software licensing functions support multiple dongles that are
daisy chained together. The dongle for the 800xA System can be anywhere in the
daisy chain. USB dongles can not be daisy chained, but they can be plugged into
multiple USB ports.

If the licensing software is installed on the License Server, use the License Entry
program to obtain the machine ID.

To obtain the machine ID without installing the License Server (software not

@ available), use the method described in Obtaining the Ethernet Address on page
118 (applicable if using the Ethernet address) or Reading the Machine ID from a
Dongle on page 119 (applicable if using a dongle).

To use the License Entry program to obtain the machine ID:
1. To launch the License Entry program, select:

Start > All Programs > ABB Industrial IT 800xA > System >
Licensing > License Entry

2. Select:
Machine IDs > Available IDs...
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from the menu to display the Installed Machine IDs dialog box.
3. Record the machine ID displayed in the Machine IDs dialog box.
4. Proceed to Requesting Software Keys on page 119.

Obtaining the Ethernet Address

If the Ethernet address will be used as the machine ID and the License Server has
not been installed, use this procedure.

ﬂ This method is only applicable if using the Ethernet address as the machine ID.

1. Launch a Windows Command Prompt window.
2. Enter: ipconfig/all.

3. Read the line for Physical Address under the information for the network
adapter. If the node has two network adapters, two addresses will be shown.

the network adapters will be removed or replaced. The permanent license is tied
to the submitted machine ID. If the network adapter is removed or replaced, the
license will be invalidated.

@ Do not use the Ethernet address as the machine ID if there is a chance that one of

4. Record the machine ID (without the hyphens) on the Software Key Request
Form.

5. Proceed to Requesting Software Keys on page 119.
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Reading the Machine ID from a Dongle
ﬂ This method is only applicable if using a dongle as the machine ID.

Each parallel port or USB dongle is labeled with its unique machine ID. The label
looks like Figure 18, where the machine ID is as indicated.

'PART NUMBER BASED ON USB
ABB INDUSTRIALIT \ _— OR PARALLEL PORT DONGLE
<ABB PART NUMBER>"
12345 —
~————MACHINE ID

Figure 18. Dongle Machine ID

6. Proceed to Requesting Software Keys.

Requesting Software Keys
To request software keys (unless told otherwise by an ABB representative):

1. Obtain the machine ID of the License Server node (refer to Obtaining the
Machine ID on page 116).

2. Locate and have available the registration license numbers found on the license
certificate form shipped with the software.

3. Complete the Software Key Request Form shipped with the software. Follow
the instructions found on this form.

ﬂ Be sure to enter a valid e-mail address on the Software Key Request Form.

4. Fill in the Software Key Request Form as necessary.

5. Send the Software Key Request Form to the ABB Software License
Administration System using one of the methods on the registration form.

6. Wait for the software keys to be returned. The method by which the software
keys will be returned is selected on the Software Key Request Form:

—  Internet mail.
—  Postal mail.
—  Fax.
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Internet mail is recommended so the software keys will be returned as an
attached license (.sla) file. This is the format required by the License Entry
program. Detach the file from the Internet mail and save it to a location on the
License Server node where it may be accessed by the License Entry program.

License Client

Perform this procedure on every 800xA System node that will be a client to the
License Server. It must not be installed on the node where the CLS Server is
installed or on Domain Controllers, unless the Domain Controller is running other
800xA System software.

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Base Functionalities > Licensing > Central
Licensing

2. Follow the Installation Wizard to complete the installation. Perform the
following when the indicated dialog boxes appear:

a. Select Components dialog box: Select the Client option.

b. Select CLS Server Location dialog box: Enter the name of the License
Server node.
-or-
Click Browse... to browse for the node.

c. Username and Password dialog box: Enter the username and password
for the 800xA Service User (refer to Users and Groups on page 76). Use

the domain\user syntax (for Windows Workgroups use computer\user
syntax).

d. InstallShield Wizard Complete dialog box: Disable the Start LCC
Service check box.

3. Proceed to Central Licensing System Extension.
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CLS Standalone Option

ﬂ If the CLS Standalone option is used the server name can not be changed through
the License Status Viewer.

The CLS Standalone option is an addition to the existing Server and Client options
(Figure 19). This option appears when the License Client software installation is
initiated. The objective of this feature is to enable installation of Client Licensing
software on a standalone workstation without being dependent on Internet
Information Services (IIS). This makes it possible to install and use the Client
Licensing software without enabling IIS.

ABB Central Licensing System Setup ﬂ
Setup Type ‘ y
Select the setup bype that best suits your needs, |\ o

Click the type of setup yvou prefer,

Clisnt rDescription—————————
Server Installs Central Licensing System
server and client files without 115

configuration,

IrnztallShield

< Back | Mext = I Cancel

Figure 19. CLS Standalone Option

The CLS Standalone option installs all License Client and Server components
except the IIS configuration and the ASP.NET files. All communications through
IIS are bypassed. This option is useful for installations on any single node
workstation, laptop, etc.

The CLS Standalone option does not provide the License Assignment Editor,
therefore the total in use count for each feature can be seen through the License
Usage Aspect and the SFA Tester.
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Figure 20 shows the Modify option of the maintenance mode, where the existing
installation type can be modified.

ABB Central Licensing System Setup ﬂ
Select Features ‘ ]
Select the features setup will install, | h

Select the Features you want to install, and deselect the features you do not want to install,

b i~ Descripkion

LS Server
----- LS Standalone

Installs License Client
Component {LCC) Files,

0,00 MEB of space required on the C drive
1378.11 MB of space available on the C drive
IrnztallShield

< Back | Mext = I Cancel

Figure 20. CLS Modify Option

The limitations of the Modify option are:

*  The CLS Standalone option can not be selected in combination with CLS
Client and CLS Server.

. The CLS Server should be selected in combination with the CLS Client.

Central Licensing System Extension

ﬂ Ensure to install Process Portal A before installing Central Licensing System
Extension.

ﬂ Ensure to install and load CLS System Extension before loading the AC 800M
Connect system extension.

The Central Licensing system extension must be installed before it can be loaded
into the 800xA System.

Install the Central Licensing System Extension on all 800xA System nodes:

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:
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Manual Installation > Base Functionalities > Licensing > Licensing
System Extension

2. Follow the Installation Wizard to complete the installation.
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Section 4 800xA Base System

This section describes how to install the 800xA Base System. This installation
includes Redundant Network Routing Protocol (RNRP). This software is provided
on 800xA System Installation DVD 1 and must be installed on all 800xA System
nodes.

This section also describes how to install the following other Base System
functions:

¢ Excel Data Access (DataDirect).
e  Application Scheduler.

e Calculations.

e SoftPoint Server.

These components are provided on 800xA System Installation DVD 1 and may be
installed when this functionality is required.

Before installing the 800xA System software, the applicable Windows Operating
System and other software prerequisites must already be installed according to
Section 2, Prerequisites.

Verify the domain is functioning properly before installing any 800xA System
@ software.

Do NOT change IP addresses or node names on Domain Controllers or any
@ 800xA Server node after it has been added to the system.

Base System

This procedure installs Process Portal, RNRP, and other Base System functionality,
including the trend function, Graphics Builder, Instrumentation ActiveX Library,
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and Symbol Factory. This installation is required by all 800xA System nodes, except
separate Domain Server nodes.

To install this software:

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Base Functionalities > Base System

2. Follow the Installation Wizard to complete the installation. Perform the
following when the indicated dialog boxes appear:

a. Welcome dialog box: Verify that the 800xA Base 5.1 check box is
enabled in the Welcome dialog box.

b. Installation Selection dialog box: Select the components to install. All
components are selected by default. This is the recommended
configuration.

126

3BSE034678-511 G



Section 4 800xA Base System Base System

c. System Software User Settings dialog box (Figure 21): Specify groups
and users. Refer to Table 7 for guidelines.

x
System software User Settings 4
Define the Windows Users and Groups used by the System software. ‘
Domain: User Group:
System Admin, group name: I adcll I IndustriallTAdmin
System User, group name: I adcll I IndustriallTUser

Service Account: I crdc11\800xAService

Password: I LT YT YT Y

v Autostart System on v Apply these settings to
Windows startup. Application logging, too.

Information
- The Service Account should have a password that never expires.

-Fill in the appropriate domain name for the user groups, otherwise local groups will be
used. If the local groups do not exist, they will be created.

- Application logging is a service that enables fault tracing without the use of debuggers.

View Log ... | <Back Next > Cancel

TC08203A

Figure 21. System Software User Settings Dialog Box
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Table 7. System Software User Settings

Setting Description

System Admin and System User | Retain the default User Group names for these parameters
group names (IndustrialITAdmin and IndustrialITUser).

For multiple node configurations, the domain name must be
entered (use the NetBIOS name of the domain; for example,
PTTDOMAIN and not the fully qualified domain name
pttdomain.abb.com). Leave these fields blank for single
node configurations, for example when setting up an
Information Management Consolidation node.

For Windows Workgroups, use the local machine name as
the domain name.

Service Account Enter the 800xA Service user name as configured in Users
and Groups on page 76. The syntax is
domainName\username (local node name\username for

Windows Workgroups).
Password Enter the password for the Service Account. This ensures
that the services are running on a secured account.
Autostart System on Windows Enabling this option causes the 800xA Base System to start
startup up when Windows is started. This is recommended.

Apply these settings to Application | Enabling this option causes the AppLog function to be
logging, too configured at the same time as the system software user
settings, with the same settings.

The configuration of AppLog can be done manually in the
Configuration Wizard after system creation if necessary.

3. If any of the Base System Functions are to be installed, continue with Base
System Functions; otherwise, continue installing 800xA Base System and
Functional Area software in the order presented in this instruction manual on a
node-by-node basis.

SoftPoint Server

Install the SoftPoint Server on all nodes in the 800xA System, except separate
Domain Controller nodes.
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Section 4 800xA Base System Base System Functions

To install the SoftPoint Server:

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Base Functionalities > SoftPoint Server

2. Follow the Installation Wizard to complete the installation. Perform the
following when the indicated dialog boxes appear:

a. Setup Type dialog box: Select Complete.

Base System Functions
The following Base System functions are provided on 800xA System Installation
DVD 1 and may be installed when this functionality is required:

ﬂ Only components for which licenses have been purchased and installed can be
used.

*  Calculations. Refer to Redundant Calculation Servers on page 130 for
information on using the redundant Calculation Server option.

e Excel Data Access (DataDirect).
e Application Scheduler.

*  SoftPoint Server (refer to SoftPoint Server on page 128).

Management Server node, it is acceptable to defer installing these basic system
functions, except for the SoftPoint Server, and install them with the Information
Management Server software. All of these components, except SoftPoint Server,
are also installed with the Information Management Server software.

@ When installing the 800xA Base System software for an Information

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Base Functionalities > Calculations

for Calculations (refer to Redundant Calculation Servers on page 130 if
redundant Calculation Servers will be set up),

Information Management > DataDirect

for DataDirect.
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Base Functionalities > Scheduler
for Application Scheduler.

2. Follow the wizard to complete the installation of the selected application.

Redundant Calculation Servers

The redundant Calculation Server option allows for a primary Calculation Server
running in Service mode and a redundant Calculation Server running in Standby
mode during normal operation. When the primary is down, the standby will become
the primary and begin scheduling/executing the Calculations assigned to its Service
Group. Calculations can only be assigned to Service Groups, not Service Providers.

There are three valid configurations:

e  Two Information Management nodes.
e  Two nodes where one is an Information Management node.
e Two non-Information Management nodes.

After installing the software in the desired configuration, refer to System 800xA Post
Installation (3BUA000156%) to perform the required post installation procedures.
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Section 5 RNRP

This section describes how to install Redundant Network Routing Protocol (RNRP)
on separate Domain Controllers. RNRP is included in the Base System. It is not
required to install it on any node that has the Base System installed.

ﬂ The only additional 800xA System software that should run on separate Domain
Controller nodes is the Diagnostics Collection Tool (DCT) and the 800xA
Common Third Party Install Tool. If it is desired to gather diagnostics data from
the Domain Controller node, refer to Section 8, Diagnostics Collection Tool.

Installation

To install this software:

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Base Functionalities > RNRP

2. Follow the Installation Wizard to complete the installation. Perform the
following when the indicated dialog boxes appear:

a. Welcome dialog box: Enable the RNRP check box.

ﬂ Since RNRP service is mandatory in System 800xA installation, ensure to enable
the RNRP check box.

Verification

To verify that RNRP is installed:
1. Reboot the node.
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Verification

Section 5 RNRP

2.

Check that there is an RNRP icon in the system tray (Figure 22). Click it and
verify that the RNRP monitor is started.

B @Yy 5:53PM

TCO08364A

Figure 22. RNRP Icon

3,
4.

Right-click the RNRP icon to verify that the RNRP Wizard is started.

When RNRP has been installed and configured on all servers and clients and
they have been connected to the network, use the RNRP monitor to verify the
node names and IP addresses.

RNRP software on the Domain Server (or any other node that requires RNRP
independent of the 800xA Base System software) may need to be configured after
completing all procedures in this instruction manual. Refer to System 800xA
Network Configuration (3BSE034463%).
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Section 6 Structured Data Logger (SDL)

This section contains installation instructions for the Structured Data Logger (SDL)
software.

The SDL software contains:

*  SDL database functionality.
o The SDL service software.
¢ The Client software.

A typical SDL installation includes one SQL Server installation with one SDL.
database. The data flow into the database is provided by the SDL service. This is an
800xA service running in 800xA Service Provider nodes. The data can be viewed by
the client software that needs to be installed in every 800xA System node.

Select the complete installation on precisely one Application Server node
(nonredundant) that will run the SDL service. Do not activate the SDL Service on
any 800xA for Harmony or 800xA for AC 870P/Melody Connectivity Server or
Configuration Server nodes.

Select the typical installation for all other 800xA System nodes, except separate
Domain Server nodes.

Installation

Software for the SDL system extension must be installed on all nodes where
SDL will be used, including client nodes. Different parts of the software must
be installed depending on the node type and desired functionality according to
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Table 8.

Table 8. SDL Software to Install Depending on Node Type

Node Type Structured 1Data Database
Logger Components
800xA Server w/SDL X
800xA Client w/SDL X
800xA Application Server w/SDL X X

NOTE:
1. Includes afw service with SDL Collector. Run only on nonredundant nodes.
To install this software:

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Information Management > Structured Data
Logger

2. Follow the Installation Wizard to complete the installation. Perform the
following when the indicated dialog boxes appear:

Welcome dialog box: Enable the Structured Data Logger check box.

b. Setup Type dialog box: Select the components to install according to
Table 8 and the following:

—  SDL Server: Selecting this setup type will install SQL Server 2008 on the
node.

—  SDL Client: Selecting this setup type will install SQL Server 2008 Native
Client on the node.
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Section 6 Structured Data Logger (SDL) Installation

c. Message box: The message box differs depending on what was selected in
the Setup Type dialog box in Step b. Figure 23 shows the message box for
the SDL Server installation type and Figure 24 shows the message box for
the SDL Client installation type. Click Yes to continue with the
installation. Proceed to Step d for SDL Server installations and proceed to
Step m for SDL Client installations.

SQLServerInstallation 23

A SDL Server requires a SDL_INSTANCE of SQL Server 2008 SP1.
¥ Would you like to install the required SDL_INSTANCE now

Figure 23. Message Box for SDL Server Installation Type

SQLServerInstallation 22

] I
\ SDL Client requires a Microsoft SQL Server 2008 Mative Client.
Would you like to install it now ?

Figure 24. Message Box for SDL Client Installation Type
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d. Browse for Service Account dialog box (Figure 25): Use this dialog box
to enter the Service Account information for the SDL_INSTANCE.

ﬂ It is recommended to use the 800xA Service User account and password,
although it is permissible to use a customer-specific Service Account.

ABB Structured Data Logger 51.0/0 @

Browse for Service Account

Select the service account for SDL_INSTAMCE of SQL Server

User name:

Browse

Password:

< Badk | Cancel

Figure 25. Browse for Service Account Dialog Box

e. Itis possible to either:

—  Enter the Service Account user name and password in the Browse for
Service Account dialog box (Figure 25), click Next, and skip to Step m.

_Or_
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Section 6 Structured Data Logger (SDL) Installation

f.  Click Browse to launch the Browse for a User Account dialog box shown
in Figure 26.

Browse for a User Account @

Use the browse buttons to select Domain/Server and User name

Domain or Server:

| Browse

User name:

Ll

| Browse

Cancel |

Figure 26. Browse for a User Account Dialog Box

g.  Click Browse for the Domain or Server.

h. A Select a Domain or Server dialog box similar to the one shown in
Figure 27 appears. There will be one or more possible selections. Select
the correct Domain or Server and click OK to return to the Browse for a
User Account dialog box.

Select a Domain or Server @I

Domain or Server:

ABB-FC

Cancel |

Figure 27. Select a Domain or Server Dialog Box
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i.  Click Browse for the User Name.

j- A Select a User Name dialog box similar to the one shown in Figure 28
appears. Select the Service User.

Select a User name @

User name:

abb
Administrator
Guest

K | Cancel |

Figure 28. Select a User Name Dialog Box
k. Click OK to return to the Browse for Service Account dialog box
(Figure 25).
1. Enter the password and click Next.

m. A Browse for Folder dialog box similar to the one shown in Figure 29
appears. Browse to the following folder on 800xA System Installation
DVD I:

\3rd Party SW\Microsoft SQL Server
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Section 6 Structured Data Logger (SDL) Installation

Click OK and the installation will complete.

Browse For Folder |
Please browse for the folder Microsoft_SQL_Server' in DVD
1\3rd_Party_SW

B Desktop -
* L Libraries
| B abb
1B Computer
- €l Metwork
-8 Control Panel
E] Recycle Bin
\. Engineering Templates
\. DTTLeg
L. GDI

Lirames Gilar far 51

[ MskeNewroider | [k ][ concel |

Figure 29. Browse for Folder Dialog Box
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Section 7 800xA Instructions

The 800xA System and Functional Area instructions and Release Notes are
included on the System Version 5.1 Released Documents CD for access before
installing the 800xA System software.

Installation

To install 800xA System and Functional Area instructions:

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > 800xA Documentation

2. Follow the Installation Wizard to complete the installation. Perform the
following when the indicated dialog boxes appear:

Welcome dialog box: Enable the 800xA Instructions check box.
b. Installation Type dialog box:

—  Select Complete and click Next if installing the documentation on the
Primary Aspect Server node or any Engineering Workplace nodes. This
will install all 800xA user and reference instructions.

—  Select Typical and click Next if installing the documentation on any other
800xA System node. This will install only the 800xA user instructions.
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Section 8 Diagnostics Collection Tool

This section contains installation procedures for the Diagnostics Collection Tool
software. Install this software on every node in the 800xA System, including the
Domain Controller node (only if it is desired to gather diagnostics data from the
Domain Controller node).

Installation

To use one node to remotely retrieve diagnostics from other nodes:

*  The 800xA Base System must be installed on the Diagnostics Collection Tool
Client in order to retrieve Process Portal diagnostics data from a remote node.

To install the software:

ﬂ Specify an Administrative user name and password for the DCT Service account
during installation of the Diagnostics Collection Tool on a Domain Controller
node. Use domain\user name syntax to specify the domain account.

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Base Functionalities > Diagnostic Collection
Tool

2. Follow the Installation Wizard to complete the installation.
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Section 9 SFC Viewer

This section describes how to install the SFC Viewer software.

Installation

Feature Pack Functionality

ﬂ The features of SFC Viewer in 800xA 5.1 Feature Pack depends on the 800xA 5.1
latest revision installation of Engineering Studio and Control Builder.

To install the software:

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Base Functionalities > SFC Viewer

2. Follow the Installation Wizard to complete the installation.
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Section 10 SMS and e-mail Messaging

This section describes how to install SMS and e-mail Messaging. Install this
software on all nodes in the 800xA System.

Installation

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Base Functionalities > SMS and e-mail
Messaging

2. Follow the Installation Wizard to complete the installation.
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Section 11 800xA for AC 800M

This section describes how to install 800xA for AC 800M software. It covers:
e AC 800M Connect: Required on all nodes in a system using AC 800M
controllers. Refer to AC 800M Connect on page 149.
AC 800M Connect must be installed on the Engineering Workplace in order to
install Control Builder M.

e Control Builder M: Installed on all nodes requiring engineering functionality.
Refer to Control Builder M on page 151.

*  OPC server for AC 800M: Required on 800xA for AC 800M Connectivity
Servers. Refer to OPC Server for AC 800M on page 151.

e SoftController: Enables simulating an application without a real controller.
SoftController can also be used as a controller, though SoftController does not
allow I/O connections. Refer to Base Software for Soft Control on page 153.

e HI Controller: Installs the AC 800M HI extension. Refer to AC 800M High
Integrity on page 153.

AC 800M Connect

Ensure to install and load CLS System Extension before loading the AC 800M
Connect system extension.

AC 800M Connect provides the connection/integration between 800xA for

AC 800M and the 800xA System workplaces. Install AC 800M Connect on all
800xA System nodes, except separate Domain Server nodes. The installation of AC
800M Connect will also install the MMS Server for AC 800M, needed for data
exchange with controllers. To install AC 800M Connect:
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AC 800M Connect Section 11 800xA for AC 800M

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Connectivities > 800xA for AC S00M >
800xA for AC 800M Connect

2. Follow the Installation Wizard to complete the installation. Perform the
following when the indicated dialog boxes appear:

Read the text in each dialog box for important information concerning steps to be
@ taken during installation. For normal use, the default settings are recommended.

a. Installation Type dialog box:

—  Select Typical and click Next to install the AC 800M Time Adaptor. Do
not install the AC 800M Time Adaptor on 800xA for Advant Master
Connectivity Server nodes (including PU410 or PU515).

—  Select Compact to automatically disable the AC 800M Time Adaptor or
choose Custom to manually disable the AC 800M Time Adaptor.

—  If performing this procedure as part of an upgrade, and older versions of
libraries are needed, then select the relevant features according to the
following options:

—Select Custom and enable AC 800M Classic Libraries to install prior
library versions other than SB 2.1/2 libraries.

ﬂ If the AC 800M Time Adaptor is installed by mistake, and it needs to be removed:

1. Select: Start > Control Panel.

2. Select Programs and Features.

3. Select: AC 800M Connect > Change.

4. Select Modify and disable Time Adaptor.

ﬂ When Modify is selected, the check boxes indicate the selected features and not
the installed features. Example: if the Time Adaptor has been uninstalled, the
next time Modify is selected, the check box for the Time Adaptor will be enabled
even if it is not installed. The default features that are enabled when selecting
Modify are the same as when selecting Typical for a new installation.

3. To install Control Builder M, continue to Control Builder M. To install OPC
Server for AC 800M, proceed to OPC Server for AC 800M on page 151. If
SoftController is desired, proceed to Base Software for Soft Control on page
153.

150 3BSE034678-511 G



Section 11 800xA for AC 800M Control Builder M

Control Builder M

Control Builder M is the tool for configuring AC 800M controllers and I/O, and
control applications for the controllers. Install this software on all nodes requiring
this functionality. The installation of Control Builder M will also install the MMS
Server for AC 800M, needed for data exchange with controllers.

To install the Control Builder M software:

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Engineering & Development >
Control Builder M

2. Follow the Installation Wizard to complete the installation.

Read the text in each dialog box for important information concerning steps to be
@ taken during installation. For normal use, the default settings are recommended.

3. If OPC Server for AC 800M is required, proceed to OPC Server for AC 800M.
If SoftController is desired, proceed to Base Software for Soft Control on page
153.

OPC Server for AC 800M

OPC Server for AC 800M enables access to data and events in the controllers.
Install this software on all AC 800M Connectivity Servers. The Connectivity Server
may be single or in parallel operation, and the OPC Server for AC 800M will then
also be single or parallel. The installation of OPC Server for AC 800M will also
install the MMS Server for AC 800M, needed for data exchange with controllers.

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Connectivities > 800xA for AC S00M >
OPC Server for AC 800M
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2. Follow the Installation Wizard to complete the installation.

Read the text in each dialog box for important information concerning steps to be
@ taken during installation. For normal use, the default settings are recommended.

Perform the following when the indicated dialog box appears:

a. Setup Wizard: The Setup Wizard is automatically started with the
Service Account options preselected. Use the dialog box shown in
Figure 30 to specify that the OPC server use the Domain\800xA Service
User account (as specified in System software user settings dialog box
when the 800xA Base System was installed). Click Apply and then Close
when finished.

,ri Setup Wizard for OPC Server for AC BOOM il

Select a topic:

— Semvice - Account

Product
- File Locations " Local System Account {* This Account IDDMNN\SBMC&&CCUU

b Gepyvice Account
Password: I xxxxxxxxxx
Confirm Pagsword: I xxxxxxxxxx

The OPC Server for 4C 200M should be
added bo the B00m4 Service User account to
function in an integrated environment.

Bestart | Apply |

Help Show Settings

Figure 30. Service Account Setup

3. If SoftController is desired, proceed to Base Software for Soft Control.
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Base Software for Soft Control

SoftController enables simulating an application without a real controller.
SoftController can also be used as a controller, though SoftController does not allow
1/O connections. The installation of Base Software for SoftControl will also install
the MMS Server for AC 800M, required for data exchange with controllers.

To install the Base Software for SoftControl:
ﬂ SoftController requires a separate software license.

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Engineering & Development > Soft Controller

2. Follow the Installation Wizard to complete the installation.

Read the text in each dialog box for important information concerning steps to be
@ taken during installation. For normal use, the default settings are recommended.

AC 800M High Integrity

To install the AC 800M High Integrity extension:

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Connectivities > 800xA for AC S00M >
800xA for AC 800M High Integrity

2. Follow the Installation Wizard to complete the installation.
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Section 12 AC 800M Status Monitoring

Feature Pack Functionality

AC 800M Status Monitoring provides easy way to troubleshoot control system
hardware, it provides details of error(s)/warning(s) at each hardware unit. For
Input/Output (I/0) modules, it provides additional information of numbers of
Channels, Channel Status and Value. I/O Module to its associated Tag Navigation is
also possible.

ﬂ Install the software on every node in the 800xA System that has a AC 800M
Connect installed, exclude the Domain Controller Nodes.
To install the AC 800M Status Monitoring extension:

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Connectivities > 800xA for AC S00M >
800xA for AC 800M Status Monitoring

2. Follow the Installation Wizard to complete the installation.

3. Refer to System 800xA Post Installation (3BUA000156%*) to load the system
extension from the aspect server.

Upload using Configuration Uploader

Create Configuration Uploader aspect in Control Project or Control Network
depending on the projects to be uploaded. Perform the Upload by selecting the
required hardware units from project. Uploaded data is updated in Hardware Status
and Tag Navigation aspect with the Hardware status details and tag object for
navigation.
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Hardware Status details like errors and warnings, channel information and
controller hardware hierarchy are displayed that helps in troubleshooting hardware
10 module errors.
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Section 13 800xA for Advant Master and
800xA for Safeguard

This section describes how to install 800xA for Advant Master and 800xA for
Safeguard. Install these system extensions on all nodes in the 800xA System except
separate Domain Controller nodes.

System Configuration

800xA for Advant Master uses a Real Time Accelerator (RTA) board with the
Connectivity Server, either an external PU410 RTA Unit or a PU5S15A PCI-type
board. The application specific software on the RTA board is automatically loaded
when the 800xA for Advant Master software is started in the Connectivity Server.

If PU515A is used, it must be installed before installing the 800xA for Advant
Master software. For more information about PU410 and PU515A (how to
configure the Network Interface required for PU410), refer to 800xA for Advant
Master Configuration (3BSE030340%).

The RTA configuration, dialogs, and status indications do not differ depending on
the type of hardware used once the installation is complete. The term RTA Board in
800xA for Advant Master represents either a PU5S15A RTA Board or a PU410 RTA
Unit.

ﬂ PUS15A RTA Board is only supported in 32-bit versions of the Workstation
Operating System and the Server Operating System.
PU410 RTA Unit is supported in both 32-bit and 64-bit versions of the
Workstation Operating System and the Server Operating System.

When replacing a PU515A RTA Board with a PU410 RTA Unit, the PUS15A
@ must be removed before using Change program features.
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Figure 31 shows an example of a control system with MB 300 Control

Network.
CLIENT CLIENT CLIENT
= == [e——]
e [— | [— |
L] L [
TCP/IP N
CLIENT, ASPECT, AND ASPECT AND CONNECTIVITY
CONNECTIVITY SERVER | == &=| SERVER
= =
L ] [ ]
RTA [RTA]
MB300
SAFEGUARD
400 AC450
SAFEGUARD

400

Figure 31. Control System with MB 300 Control Network Example
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800xA for Advant Master Software Installation

To install the software:

1.

This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Connectivities > 800xA for Advant Master

Follow the Installation Wizard to complete the installation. Perform the
following when the indicated dialog boxes appear:

a. Welcome dialog box: Enable the 800xA for Advant Master check box.

b. Installation Already Running dialog box (Figure 32): Click OK to
continue.

Installation Already Running

Another installakion is in progress,
Yaou must complete that installation before continuing this one,

Figure 32. Installation Already Running Dialog Box (Click OK)
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c. Select Components dialog box: Select which features to install
(Figure 33). Use this dialog box to select the RTA Board Support.

This feature will be installzd on the local hard
=3~ Core Fles (117,75 b r| | e
¥ ~| RTA Unit PU410 Suppor

% | RTA Board PUS1S Suppr AEE 800xA for Advant Master 5.1

< >
Inskall ko: | Browse
Disk Usage | Reset | « Back | et = | Cancel |

Figure 33. Select Components Dialog Box for 800xA for Advant Master

If the node will be used as a Connectivity Server or a combined Aspect
Server and Connectivity Server, select either RTA Unit PU410
Support or RTA Board PU515 Support, and click Next.

If the node will be used as a Client or Aspect Server only, click Next.
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d. RTA Driver Install dialog box: If the RTA Board PU515 Support is to be
installed, the message shown in Figure 34 will appear.

RT& Driver Install

. Instaling R T4 Board Device Driver...

TCO05732A

Figure 34. RTA Driver Install Message
e. Windows Security dialog box: The Windows Security dialog box shown

in Figure 35 may appear once if PU515 was selected and twice if PU410
was selected. Click Install this driver software anyway to continue.

|

Would you like to install this device software?

MName: ABE AB ABEB Rta Slave
é— Publisher: AEE AB

[T Always trust software from "ABE AB™. Install | Don't Install I

@ You should only install driver software from publishers you trust. How can I
dedde which device software iz safe to install?

Figure 35. Windows Security Dialog Box

ﬂ The driver installation will take a few minutes and create 40 driver instances and
40 WudfHost processes that will be visible in the Windows Task Manager if
PU410 was selected.
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f. Installation Successful dialog box: Click Finish to proceed. When a
dialog box appears after the Installation Successful dialog box, asking to
restart the computer now, click No.

If 800xA for Advant Master is uninstalled and not reinstalled, an error message
@ appears each time the VBPG Graphics Builder is opened.

3. Proceed to 800xA for Safeguard Software Installation if Safeguard controllers
are included in the system.

800xA for Safeguard Software Installation

To install the software:

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Connectivities > 800xA for SafeGuard

2. Follow the Installation Wizard to complete the installation.
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Section 14 800xA for Harmony

This section describes how to install the 800xA for Harmony, Harmony Batch, and
Advanced Harmony Control System Monitoring software.

Install the client component on all 800xA System nodes, except separate Domain
Server nodes as a minimum for all 800xA for Harmony installations. All setup types
include the client components.

If, during an update/upgrade, or if the Harmony Connectivity Server software has
to be uninstalled for any reason, a reboot must be performed before reinstalling
the software.

SQL Server

Perform the following on Harmony Connectivity Server and Harmony
Configuration Server nodes for a Manual Installation:

1. Login to the 800xA Installation Account (800xAlnstaller if System Installer is
used).

2. Open the command prompt. Set the current directory to the folder that contains
the 800xA for Harmony installation on DVD 1.

For example: d:\dvd1\800xA Connectivities\800xA for Harmony).

3. Execute the following command:

ﬂ Do not include the [or] enclosing the arguments from the given example.

[Domain\InstallAccount] must be replaced with the current account name
including the Domain or node name. [Domain\ServiceAccount] must be replaced
with the name of the account running 800xA services including the Domain or
node name. [Password] must be replaced with the password for the account being
used to run 800xA services.
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- InstallSQL2008Full [Domain\InstallAccount]
[Domain\ServiceAccount] [Password]

800xA for Harmony

ﬂ Close all open applications before installing any 800xA for Harmony software.

To install the 800xA for Harmony software:

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Connectivities > 800xA for Harmony >
Harmony Connect

2. Follow the Installation Wizard until reaching the Setup Type Selection dialog
box (Figure 36). Select the setup type based on the node type where the
software is currently being installed.

(Configuration Server)or setup type 2 (Configuration Server w/

@ Setup type 3 (Connectivity Servers) can not be installed until setup type 1
Connectivity Server) is installed.

ABB 800xA for Harmony Setup
Setup Type Selection

Please selact & setup type.

1. Configuration Server Description
2. Corfiguration Server w/ Connactivity Server Setup vl install Harmony System
3. Connectivity Servers E xtension, Configuration Server,

4. Clignt

InstallShield

< Back Mext > Cancel

TCO04441C

Figure 36. Setup Type Selection
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3. Click Next and proceed to the heading of the selected setup type:

Configuration Server on page 165.

Configuration Server with Connectivity Server on page 165.
Connectivity Server on page 166.

Client on page 167.

Configuration Server
Perform the following steps to install the Configuration Server software:
1. When the Security Setup dialog box appears:

a. If this is a domain installation, enter the 800xA Service User name and
password and click Next.

b.  If this is a Windows Workgroup installation, enter machine
name\800xA Service User for the name.

2. Read the Important Installation Information dialog box when it appears. Click
Yes to continue the installation or No to abort.

Click Finish in the InstallShield Wizard Complete dialog box.

4. If needed, install Harmony Batch on page 167 and/or Advanced Harmony
Control System Monitoring on page 168.

Configuration Server with Connectivity Server

Perform the following steps to install the Configuration Server with Connectivity
Server software:

1.  When the Security Setup dialog box appears:

a. If this is a domain installation, enter the 800xA Service User name and
password and click Next.

b.  If this is a Windows Workgroup installation, enter machine
name\800xA Service User for the name.

2. Read the Important Installation Information dialog box when it appears. Click
Yes to continue the installation or No to abort.
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3. If needed, install Harmony Batch on page 167 and/or Advanced Harmony
Control System Monitoring on page 168.

ﬂ The PC, Network and Software Monitoring Server and Client installation type
must be installed on all Harmony Configuration Server with Connectivity Server
nodes (refer to Section 20, PC, Network and Software Monitoring).

Connectivity Server

Perform the following steps to install the Connectivity Server software:

1. The Select the Harmony Server Role dialog box will appear (Figure 37).

ABB 800xA for Harmony Setup E x|

Select the Harmony Connectivity Server Role

Select the redundancy role of the Harmony Connactivity server being installed. This
includes selecting the Hamony Group rumber for a primary and the host name of the.
primary for a backup.

[ Primary Conneciraty Server

[” Backup Connectivity Server

Select or entes the host name of the Primary
vty Server.

| |

< Back Hext > Cancel

TC08118A

Figure 37. Connectivity Server Role
a. Select Primary Connectivity Server or Backup Connectivity Server
depending on the role of the current node.

b. If Backup Connectivity Server is selected, select the host name of the
Primary Connectivity Server from the drop-down list box and click Next.

2. When the Security Setup dialog box appears:

a. If this is a domain installation, enter the 800xA Service User name and
password and click Next.
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b.  If this is a Windows Workgroup installation, enter machine
name\800xA Service User for the name.

3. Select the name of the Configuration Server in the drop-down list box and click
Next.

4. If needed, install Harmony Batch on page 167 and/or Advanced Harmony
Control System Monitoring on page 168.

ﬂ The PC, Network and Software Monitoring Server and Client installation type
must be installed on all Harmony Connectivity Server nodes (refer to Section 20,
PC, Network and Software Monitoring).

Client
Perform the following steps to install the client software:
1. Follow the Installation Wizard to complete the installation.

2. If needed, install Harmony Batch on page 167 and/or Advanced Harmony
Control System Monitoring on page 168.

Harmony Batch
Install Harmony Batch software on all nodes in the 800xA System, except separate
Domain Server nodes.

Batch Management software must be installed on all nodes in the 800xA System,
except separate Domain Server nodes in order to use Harmony Batch software.
Refer to Section 27, Batch Management for more information.

To install the Harmony Batch software:

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Connectivities > 800xA for Harmony >
Harmony Batch

2. Follow the Installation Wizard to complete the installation.
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Advanced Harmony Control System Monitoring

Install Advanced Harmony Control System Monitoring software on nodes in the
800xA System that require this functionality.

System Monitoring software in order to use Advanced Harmony Control System
Monitoring software. Refer to Section 19, Asset Optimization for more
information.

@ Asset Optimization software must be installed as Advance Harmony Control

To install the Advanced Harmony Control System Monitoring software:

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Connectivities > 800xA for Harmony >
Harmony CNAM

2. Follow the Installation Wizard to complete the installation.
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This section describes how to install 800xA for AC 870P/Melody software (this
product was referred to as 800xA for Melody prior to 800xA 5.1).

Install 800xA for AC 870P/Melody on all 800xA System nodes, except separate
Domain Server nodes when using Melody controllers.

Install the Configuration Server component on the Configuration Server, the
Connectivity Servers component on Connectivity Servers, and the client component
on all other 800xA System nodes. Installation type selection is covered later in the
installation procedure.

Feature Pack Functionality

Refer to 800xA for AC 870P/Melody Asset Management for HART Devices
Installation (2VAA000940%) to install the 800xA HART Asset Management that is
integrated with the Melody System.

If, during an update/upgrade, or if the Melody Connectivity Server software has
to be uninstalled for any reason, a reboot must be performed before reinstalling
the software.
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800xA for AC 870P/Melody Installation

ﬂ Close all open applications before installing 800xA for AC 870P/Melody
software.

Refer to Figure 38 for an overview of the necessary installation sequence of the
server and operator workstations.

INSTALL CONFIG
SERVER

e

INSTALL ASPECT
SERVER

INSTALL OPERATOR
WORKSTATION

INSTALL OPERATOR
WORKSTATION

INSTALL CONNECTIVITY
SERVER

INSTALL CONNECTIVITY
SERVER

nnnnnnn

Figure 38. Installation Overview Flowchart

To begin the 800xA for AC 870P/Melody software installation:

1. This software is accessible from the Installation AUTORUN screen by
selecting:

Manual Installation > Connectivities > 800xA for AC 870P/Melody

2. Follow the Installation Wizard until reaching the Setup Type Selection dialog
box.
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3. Use the Setup Type Selection dialog box, Figure 39, to select the correct setup
type based on the node type where the 800xA for AC 870P/Melody software is
currently being installed. Refer to Table 9 for guidelines.

Table 9. Setup Type Selections

Setup Type Software Description

Configuration Server | For the Configuration Server. Refer to Configuration Server on page 171.

Client For Aspect Servers, and other system nodes that are not a Melody
Connectivity or Configuration Server. Refer to Client on page 172.

Connectivity Servers | For Melody Connectivity Servers. Refer to Connectivity Servers on page

ABB B00xA for AC 870P | Melody 5.1 x|
Setup Type Selection ‘ i
|'&" 2
Fleaze select a setup type.
1. Configuration Server [ Description
2. Connectivity Servers Setup will inztall Melody System

Extension.
4. Configuration Server w/ Connectivity Server

IrnztallShield

< Back | Mest » I Cancel

Figure 39. Setup Type Selection Dialog Box

Configuration Server
This installs the Melody Configuration Server (Table 9):

1. Select the Configuration Server setup type and click Next.
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2. When the Security Setup dialog box appears, enter the 800xA Service User
name and password and click Next.

ﬂ In a Windows Workgroup, enter (computer name\800xA Service User) for the
name.

3. Select the SQL Database Disk Partition.
4. Read the Important Information dialog box when it appears. Click Yes to
continue the installation or No to abort.

5. Click Finish when prompted that the 800xA for AC 870P/Melody software
installation is complete.

6. Continue with Configure Access Rights on page 173.

ﬂ Refer to 800xA for AC 870P/Melody Configuration (3BDDO011741%*) and finalize
the configuration of the Melody ConfigServer before the installing the Melody
Connectivity Server.

Client
This installs the Melody system extensions:
1. Select the Client setup type and click Next.

2. Click Finish when prompted that the 800xA for AC 870P/Melody software
installation is complete.

Connectivity Servers
To install the Melody Connectivity Server:
1. Select Connectivity Servers in the Setup Type dialog box and click Next.

2. When the Security Setup dialog box appears, enter the 800xA Service User
name and password and click Next.

ﬂ In a Windows Workgroup, enter (computer name\800xA Service User) for the
name.
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3. Choose the ConfigServer location as shown in Figure 40, and click Next.

ABB B00xA for AC 870P | Melody 5.1 x|

Choose ConfigServer Location

Select network location of SOL Server.

Select running SOL Server ar enter hast name
of Configuration Server.

IrstallShield

< Back | Mext > | Cancel |

Figure 40. Selecting Configuration Server as SQL Server Location

4. Click Finish when the 800xA for AC 870P/Melody installation is complete.

ﬂ The PC, Network and Software Monitoring Server and Client installation type
must be installed on all Melody Connectivity Server nodes (refer to Section 19,
Asset Optimization).

Configure Access Rights

All Industrial IT users require read access to the Configuration server and SQL
Server databases for 800xA for AC 870P/Melody. To configure access rights for
read access, perform the following steps on the 800xA for AC 870P/Melody
Configuration Server. These steps can be repeated on each 800xA for

AC 870P/Melody Connectivity Server after it receives a copy of the Configuration
Server database (after the Melody Executive Service Provider is configured and
started). Refer to System 800xA Post Installation (3BUA000156%*) for more
information.

The Melody Tag Importer requires write access to the Configuration Server
database on the 800xA for AC 870P/Melody Configuration Server node. The
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following steps can be used in a similar way to configure an Industrial IT
administrator as db_datawriter for the Configuration Server database. Refer to
800xA for AC 870P/Melody Configuration (3BDD011741%*) for more information.

1. Select:

Start > (All) Programs > Microsoft SQL Server 2008 > SQL Server
Management Studio

2. Connect to current node\MELODY _INSTANCE.
3. Expand the listing to view the Security\Logins in the Microsoft SQL
Server Management Studio dialog box (Figure 41).

l- Microsoft SQL Server Management Studio

File Edit Wew Tools Window Community Help

Quenoey | 0B B HIGISHS | 8,
Object Explorer

Connect~ | @3 &0 m F [2] ;
S| Lﬂ PTTCFG\MELODY _INSTANCE (SQL Server 10.0,2531 - MELCON\800xainstall)
1 Databases
= 3 Security
Ca
3@ Server Roles
3 Credentials
3 Cryptographic Providers
A Audits
@ Server audit Specifications
3@ Server Objects
3 Replication
[l Management
|_% SQL Server Agent

Ready i

Figure 41. Microsoft SQL Server Management Studio Dialog Box

4. Select Logins and right-click to select New Login from the context menu.

5. Add the Industrial IT user group as the login name in the General page.
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Configure Access Rights

6. On the User Mapping page, select the db_datareader check box for the
ConfigServer and model databases (Figure 42).

(B ogin-mew =10j X}
| Selectapage 5 seipt ~ [ Help
2 General
&R Sarver Roles T
A User Mapping Users mapped to this login:
4 Secursbles Map | Diatabase | Vzer | Default Schema
1 Status v CorfigServer MELCON Industrial| TUser
— distribution
I mastar
{ model MELCON"Industriall TUsger
- msdb
— tempdb
| o
I= | Guest account enabled for: mods]
Database role membership for: model
[ db_accessadmin
Server: [[1 db_backupoperator
PTTCFS\MELODY_INSTANCE | | ReReEEachcy
[ db_datawriter
Connection: [ db_ddladmin
MELCON"800cainstall [ db_denydatareadsr
3 View connection properties [ db_denydatawriter
[ db_owner
[ db_securityadmin
@ it
Ready

[ o 1]

Cancel |

Figure 42. Selecting db_datareader for the ConfigServer and Model Databases

7. Click OK.
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Section 16 800xA for MOD 300

This section describes how to install the 800xA for MOD 300 software on an 800xA
System. 800xA for MOD 300 provides integration of the 800xA System and the
Advant OCS/MOD 300 control network (DCN or eDCN).

After completing all procedures in this instruction manual, and if the system will

ﬂ contain 800xA for MOD 300 functionality, MOD 300 Connectivity Servers,
Clients, and the associated Domain Controller all need to be set up to handle
getting time from the MOD 300 system through the Real-Time Accelerator
(RTA) on the Connectivity Servers. Refer to the System Level Tasks and 800xA
for MOD 300 sections in System 800xA Post Installation (3BUA000156%*).

Prerequisites and Requirements

The following prerequisites and requirements are necessary to support the 800xA
for MOD 300 software.

MOD 300 System Requirements

The Advant OCS System must be at Version 14.6/x for proper connectivity and
operation with 800xA for MOD 300.

One node with AdvaBuild 3.3/2 P2 or later for Windows is required by the MOD
Importer application to populate the Aspect Server with MOD 300 tag data.

Software Requirements

MOD 300 Client software can be loaded on top of application software packages
such as Information Management.
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Section 16 800xA for MOD 300

Table 10 summarizes the required software and the nodes to install the software

on.

Table 10. Software Requirements by Node Type

Software Client | Connectivity Server | Aspect Server
800xA - 800xA Base System 5.1 X X X
ABB PAS System Services X
800xA for MOD 300 X X X

ﬂ 800xA for MOD 300 can coexist in a system with 800xA for AC 800M; however,
the 800xA for MOD 300 Connectivity Servers and 800xA for AC 800M
Connectivity Servers can not be combined in the same node.

ﬂ 800xA for MOD 300 can coexist in a system with 800xA for Harmony; however,
the 800xA for MOD 300 Connectivity Servers and 800xA for Harmony
Connectivity Servers can not be combined in the same node.

RTA Requirements

The Real-Time Accelerator (RTA) is required to connect the MOD 300 Connectivity
Server to the Advant OCS Control Network (MOD 300 DCN/eDCN). Install the
internal RTA board or external RTA unit before installing the ABB PAS System
Services software. Refer to Real-Time Accelerator Board Installation on page 179
or Real-Time Accelerator Unit Installation on page 181.

Internal RTA boards are not supported in the 64-bit operating systems, it supports
only the RTA units. So, 800xA for MOD 300 running on 64-bit operating system
supports only the external RTA Unit PU41x driver.

More detailed information about the Real-Time Accelerator Unit installation can
be found in Industrial IT, System 800xA for MOD 300 - RTA Unit PU410 and
PU412 User’s Guide, Technical Data and Installation Information
(3BUAO01442%*).

178

3BSE034678-511 G



Section 16 800xA for MOD 300 Installation Procedure

Installation Procedure
The following installations are supported by the 800xA for MOD 300 installation

wizard.
*  800xA for MOD 300 Connectivity Server with 800xA for MOD 300
Client/Server.

*  Any other 800xA System node type with the 800xA for MOD 300 Client.
Follow this general procedure to load the 800xA for MOD 300 software.

1. Install the RTA board on the 800xA for MOD 300 Connectivity Server or
connect the RTA unit to access the Advant OCS Control Network (MOD 300
DCN). The RTA can provide time from the MOD 300 system. Setting up time
synchronization is a post installation activity. Refer to System 800xA Post
Installation (3BUA000156%).

If the RTA Board is the method of communication hardware used, refer to
Real-Time Accelerator Board Installation on page 179. If the RTA unit is the
method of communication hardware used, refer to Real-Time Accelerator Unit
Installation on page 181.

2. Insert the installation media and install the 800xA for MOD 300 software using
the installation wizard. Refer to 800xA for MOD 300 Installation Wizard on
page 182.

ABB PAS System Services is installed on the 800xA for MOD 300
Connectivity Server with 800xA for MOD 300 Client/Server node. Refer to
ABB PAS System Services on page 182.

3. Complete the post installation activities. Refer to System 800xA Post
Installation (3BUA000I56%).

Real-Time Accelerator Board Installation

ﬂ Internal RTA boards are not supported in the 64-bit operating systems, it supports
only the RTA units.

This topic is only required if installing an internal PCI RTA board on an 800xA for
MOD 300 Connectivity Server with 800xA for MOD 300 Client/Server node. Refer
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Real-Time Accelerator Board Installation Section 16 800xA for MOD 300

to the applicable computer documentation to determine the physical, electrical, and
environmental requirements for the computer.

A\

The PU514 or PU515 PCI RTA boards require a 5V PCI slot. Do not put the
PUS514 or PU515 RTA board in a PCI slot that uses the PCI-X133 standard. Also,
do not use the USB capable PU518 or PU519.

The latest PUS14A or PUS15A PCI RTA boards use a PCI-X133 slot and are
backward compatible to earlier PCI slot specifications. These cards can not be
used in PCI-X266 or higher, or in PCI Express slots. PU514A and PU5S15A RTA
boards replace PU514 and PU515 RTA boards respectively.

To install the PCI RTA board:

1.

A\

®

Disconnect the computer power cord from the power line.

Remove the computer power cord from the power line before removing the cover.
There are unisolated and potentially fatal power line voltages present under the
cover.

Remove the computer cover. Refer to the computer hardware manual for
details.

Wear a properly grounded antistatic wrist strap and handle the PCI RTA board
with care. Static discharges may damage the PCI RTA board when it is removed
from the antistatic bag. Do not touch connectors with bare hands.

Unpack the PCI RTA board.
Detach the plastic handle from the PCI RTA board, if required.

Remove the cover plate of any PCI slot and mount the PCI RTA board in the
slot.

Install the computer cover. Refer to the computer hardware manual for details.
Connect the computer power cord into the power line.

Turn on the computer.

Windows will detect the PCI RTA board as new hardware will attempt to
configure it. Cancel any attempts by Windows to configure the PCI RTA board.
The ABB PAS System Services software install will configure the PCI RTA
board (refer to ABB PAS System Services on page 182).
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Real-Time Accelerator Unit Installation

v

V

This topic is only required if installing an external RTA unit to be connected to an
800xA for MOD 300 Connectivity Server with 800xA for MOD 300 Client/Server
node. If upgrading a node that previously had an RTA board, it is required that the
RTA board be removed prior to the installation of the PAS System Services
software.

It is required to remove the existing PCI RTA board prior to installing the PAS
System Services (refer to ABB PAS System Services on page 182). If a PCI RTA
board exists, PAS will detect that board as the hardware interface and will install
the PUS511 drivers rather than the PU410 drivers needed for the RTA unit.

More detailed information about the Real-Time Accelerator Unit installation can
be found in Industrial IT, System 800xA for MOD 300 - RTA Unit PU410 and
PU412 User’s Guide, Technical Data and Installation Information
(3BUA001442R0001 ).

1. Unpack the RTA unit.

2. Install the RTA unit as a floor mount, desktop mount, or using the brackets for
rack mount.

Place the communication unit so that the connectors and the reset button are
within reach if using the brackets for rack mounting.

3. The RTA unit has two ports called PC 1 and PC 2 for connection to the
Connectivity Server. The default IP addresses of the RTA unit are as follows:

— PC 1 port =172.16.168.50
-  PC2port=172.17.168.50

4. The recommended IP addresses for the NIC cards in the Connectivity Server
are:

172.16.168.1 with subnet mask 255.255.252.0 and 172.17.168.1 with
subnet mask 255.255.252.0.

The default IP address of the RTA unit and identical IP address of the NIC can
be used in multiple Connectivity Servers as:

172.16.168.x and 172.17.168.x which are local IP addresses.

The status of the redundant connection can be viewed in the RNRP network event
monitor.
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Section 16 800xA for MOD 300

5.

The RTA unit communicates at 100 Mbit/sec on the PC 1 and PC 2 ports. It is
recommended to configure the network interface card in the 800xA for MOD
300 Connectivity Server to 100 Mbit/sec full duplex.

800xA for MOD 300 Installation Wizard

To install the software:

1.

This software is accessible from the Installation AUTORUN screen by
selecting:

Manual Installation > Connectivities > 800xA for MOD 300

Follow the Installation Wizard to complete the installation. Perform the
following when the indicated dialog boxes appear:

a. Welcome dialog box: Select the following as appropriate:

—  For MOD 300 Connectivity Servers with 800xA for MOD 300
Client/Server nodes select: ABB PAS - System Services and ABB
MOD300 Connect.

—  For all other nodes select: ABB MOD300 Connect.

Refer to ABB PAS System Services for MOD 300 Connectivity Server with
800xA for MOD 300 Client/Server installations.

Refer to 800xA for MOD 300 Software (MOD 300 Connect) for all
installations.

ABB PAS System Services

1.

The InstallShield Wizard for ABB PAS System Services dialog box appears, as
shown in Figure 43.

Select MOD 300 Connection as the installation type and then click Install
Now. This installs the MOD 300 Software and Drivers required for MOD 300.

The Installing ABB System Services dialog box appears. During the
installation, the RTA device driver is installed. Wait for the installation status
screen to complete.
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{i ABB PAS - System Services - InstallShield Wizard [ X}

System 800xA welcome to the InstallShield Wizard for ABB
PAS - System Services

The InstaliShield(R) Wizard will install ABB PAS - System
Services on your computer. To continue, click Next,

WARNING: This program is protected by copyright law and
international treaties.

Select the Installation Type

" IMBase
(¥ MOD300 Connection

(" MOD300 For AdvaBuild Custom... I

Back | fdext | Cancel |

Figure 43. Welcome Dialog Box for ABB PAS System Services
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a. Windows Security dialog box: The Windows Security dialog box shown
in Figure 44 will appear once if PU515 was selected and twice if PU410
was selected. Click Install to continue.

x

Would you like to install this device software?

Mame: ABB AB ABB Rta Slave
é— Publizher: ABE 4B

[T always trust software from "ABE AB" Install Don't Install

';if' You should anly install driver software from publishers you trust. How can I
decide which device software is safe to install?

Figure 44. Windows Security Dialog Box

ﬂ The driver installation will take a few minutes and create 40 driver instances and
40 WudfHost processes that will be visible in the Windows Task Manager if the
external PU410/PU412 is being used.

b. Select NO If the System Settings Change restart message appears.
This usually happens because of an uninstall/reinstall of ABB PAS System
Services. The reboot will be necessary later.

c. Select Continue Anyway if the Hardware Installation dialog with the
following message appears. This message may only appear if the
installation includes the PU515 (internal RTA board).

The software you are installing for this hardware: RTA
Board PU510/PU511 has not passed Windows Logo testing
to verify its compatibility with Windows 2008.
4. The InstallShield Wizard Complete dialog box appears. Click Finish to
complete the installation.
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This opens an information dialog box asking if you want to restart. Select No
(Do NOT restart at this time). A restart for configuration changes made by the
ABB PAS System Services software will be made later.

If you select Yes to restart, then you will have to run the MOD 300 Installation
Wizard again and install MOD 300.

The windows installer now prepares for the 800xA for MOD 300 install.

800xA for MOD 300 Software (MOD 300 Connect)

The 800xA for MOD 300 installation adds the support files required for importing
and using the MOD 300 interface. Some post installation activities are also required.

1. The ABB MOD300 Connect Setup dialog box appears. The installer
determines the correct installation type, as shown in Figure 45.

{i ABB 800xA for MDD 300 5.1.0,2 Setup

System 800xA Welcome to the ABE 50054 For MOD 300 5,1.0/2 Install wizard

The InstallShield® Setup wizard will install ABE S00:x4A For MOD
e Paees 500 5.1.02 on your computer,

Select "Mext" for custom installation

Select Installation Type and “Install Mow" to bypass custom
inskallation.

—Select the Installation Type
" Cliert
% Client/Connectivity Server

FRiPlEp

I AL 1D IR

Inistall Mo = Back I Mexk = Caneel

Figure 45. MOD 300 Setup Dialog Box

2. If the preselected installation type is correct (Client or Client/Connectivity
Server), select Install Now. Client is preselected for all node types except when
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ABB PAS System Services is present and then the MOD 300 Client/Server
install is used.

ﬂ Do not select the Client/Connectivity Server option if installing on a client node.
This will install server components that are not needed.

3. To change the default destination folder, perform the following steps.
Otherwise, skip to Step 4.

a. Alternately, select Next to continue past the welcome window (ABB
MOD 300 Setup).

b. Read the license agreement. Select I accept the terms in the license
agreement and select Next to continue. Selecting the I do not accept
option will not allow you to select Next.

c. Select Next to use the default destination folder or use the Change ...
button to use another folder location. The default file path is:
C:\Program Files\ABB Industrial IT

d. Select the type of node 800xA for MOD 300 is being installed on and then
select Next. The install process begins.

4.  The MOD 300 Server Security Setup dialog box appears. Enter the
domain\user name and password of the 800xA Service User when requested, as
shown in Figure 46 (password is case sensitive) and Select OK. Some
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registering occurs before the next step.

Ml MOD300 Server Security Setup E3

System 800XA Enter the Service account and password for MOD300 Servers

Account IHSIDomain\PPAService

Password I xxxxxxxxxxx >1

0K I Cancel

Figure 46. Security Login

5. Select Finish to close the Setup program.
6. Select: Start > Run to open the Run dialog box.

7. Enter pasPwdAdmin.exe inthe Run dialog box and click OK to open the Set
PAS Service Account dialog box.

8.  Enter the service account, password (and confirm the password) and click OK
to close the dialog box.

9. Select Yes to Restart Windows for Connectivity Servers. This is required so
that configuration changes take effect.
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Section 17 PLC Connect

This section describes how to install the PLC Connect software.

Installation

Install PLC Connect on all nodes in an 800xA System, except separate Domain
Server nodes.

1. Log on with Administrator privileges on a node with the 800xA System
installed.

2.  Exit all Windows programs.

3. This software is accessible from the Installation AUTORUN screen by
selecting:

Manual Installation > Connectivities > PLC Connect

4. Follow the Installation Wizard. Perform the following when the indicated
dialog boxes appear:

a. Setup Type dialog box: Select either:

—  Typical. Typical installation with no options installed. Follow the Wizard
to complete the installation.

—  Custom. Allows available options to be selected for installation. Continue
with Step b.
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b. Custom Setup dialog box: Specify which features to install. Make sure to
specify that the features are to be installed on the local hard drive.
Available features are:

—  PLC Connect Basics: Follow the Wizard to complete the installation.
— IEC60870: This requires a separate license. Continue with Step c.

—  Basic Process Objects: Obsolete Basic Process Objects - Not supported.
Do not select this feature.

Click Help for information on how to specify the features, Space for information
@ on current disk space, or Change to change the installation path.

c. IEC 60870 Licensing dialog box: Enter the License ID for the IEC driver
option, or the order number and then follow the Wizard to complete the
installation.
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Section 18 IEC 61850 Connect

This section describes how to install the IEC 61850 Connect software, which
consists of:

e IEC 61850 OPC Server: IEC 61850 OPC Data Access (DA) and Alarm and
Event (AE) Server, and the Communication Engineering Tool (CET) used to
configure the OPC Server.

* ABBIEC 61850 Connect: 800xA Object Types compliant to the IEC 61850
Standard, Alarm and Event Configuration, and the IEC 61850 Uploader aspect.

*  Substation Configuration Language (SCL) Components Setup: A set of
libraries used to parse the Substation Configuration Description (SCD) file.

Installation
To install IEC 61850 Connect:

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Connectivities > 800xA for IEC61850
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Section 18 IEC 61850 Connect

2. Follow the Installation Wizard to complete the installation. Perform the
following when the indicated dialog boxes appear:

a.

Welcome to the IEC 61850 Connect Installation Wizard dialog box:

IEC 61850 Connectivity Server nodes: Enable the SCL. Components
Setup, ABB IEC 61850 Connect, and IEC 61850 OPC Server check
boxes.

Every other node in the 800xA System (except separate Domain
Server nodes: Enable the SCL. Components Setup and ABB IEC 61850
Connect check boxes.

Confirm Selection dialog box: Verify that the desired components are
selected before clicking Next. One the selection is made, it is not possible
to go back and change the selections.

ﬂ For IEC 61850 Connect, ensure the Suppress Reboot checkbox is cleared
(Default Setting).

3. Depending on the selections made in Step 2, proceed to one of the following in
the order listed:

IEC 61850 OPC Server on page 192.
ABB IEC 61850 Connect on page 193.
SCL Components Setup on page 194.

IEC 61850 OPC Server
To install IEC 61850 OPC Server (if selected):

1. Follow the Installation Wizard to complete the installation. Perform the
following when the indicated dialog boxes appear:

a.

Select the Desired Installation Type dialog box: Typical is the default
and recommended selection.

This will automatically launch the SQL Server 2008 installation. Wait
until the installation completes.

Account Information dialog box: 800xAService appears by default in
the User Name text box. If the 800xA Service User name defined in
800xA Service User on page 84 is not 800xAService, type the 800xA

192
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Section 18 IEC 61850 Connect ABB IEC 61850 Connect

Service User name in manually.

To browse for the 800xA Service User, click Browse in the Account Information
@ dialog box and then use the Browse for User, Select Domain or Server, and Select
a User dialog boxes.

c. ABBIEC 61850 OPC Server has been successfully installed dialog
box: Click Finish to complete the OPC Server installation.
ﬂ If the ABB IEC 61850 OPC Server installation is manually aborted, make sure to
abort the installation of SQL Server 2008.

2.  Proceed to ABB IEC 61850 Connect.

ABB IEC 61850 Connect
There are two conditions for starting the ABB IEC 61850 Connect installation:

e If the IEC 61850 OPC Server installation was selected, the Welcome to ABB
IEC 61850 Connect dialog box appears automatically after completion of
IEC 61850 OPC Server installation and, if installed, the MSDE installation.

e Ifthe IEC 61850 OPC Server was not selected, the Welcome to ABB
IEC 61850 Connect dialog box appears after clicking Install in the Welcome to
the IEC 61850 Connect Installation Wizard dialog box (Step 2 under
Installation).

To install ABB IEC 61850 Connect:

1. Follow the Installation Wizard to complete the installation. Perform the
following when the indicated dialog boxes appear:

a. Select Features dialog box (Figure 47): Retain the default root feature
selection. Retain the default path in the Install to text box (recommended),
or click Browse and select the desired install folder.

2. Proceed to SCL Components Setup.
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i ABB IEC 61850 Connect PI5_7 - w751b2 Setup

Click on an kon in the kst below to change how this feature ks installed.

= 5_, ,l [EC 61850 Connect (10.23 Mb TM feature vill be instaled on the local hard
&2+ | IEC 61650 Cornect (10| 4™
Enter your description here
< >
Installbo: |C:\Program Files\ABB Industrial IT\Operate IT Browse |

DekUsage | Reset | cpsck [ mea> | cowe |

Figure 47. Select Features Dialog Box (Retain Default Root Features)

SCL Components Setup

The SCL Components Setup installation begins automatically after completion of
ABB IEC 61850 Connect installation.

Follow the Installation Wizard to complete the installation.
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Section 19 Asset Optimization

This section provides procedures for installing Asset Optimization software.

Asset Optimization Installation

This procedure describes installation of Asset Optimization software.

ﬂ The system extensions are loaded only one time on the Aspect Server node using
the Configuration Wizard. Refer to System 800xA Post Installation
(3BUAO00156%) to load the system extensions.

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Asset Optimization > Asset Optimization

2. Follow the Installation Wizard to complete the installation. Perform the
following when the indicated dialog boxes appear:

a. Setup Type dialog box: Make the selection based on the following:

—  Select Server to install AO Server components on all Asset Optimization
Server nodes.

—  Select Client to install Asset Optimization files on all nodes in the 800xA
System other than Asset Optimization Server nodes.

ﬂ VB Graphics Extension is used in the system, if required install Asset
Optimization VB Graphics Extension manually.

Defining the System Environment for CMMS Integration

Perform this procedure only if you are using CMMS (Maximo and SAP/PM)
Integration functionality.
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Network Topology
Record the following information for use during installation and/or configuration:
*  Gather Maximo or SAP Server information including:

—  Maximo or SAP Server node hostname/address.
—  Connection user name and password.

e Identify network security devices (For example: firewalls) that may isolate the
Maximo or SAP Server node or ECS node from the node that will serve as the
AoWebServerNode. If present, these devices need to support the network
protocol used by the Maximo or SAP Integration system extension.

System Security
Record the following information for use during installation and/or configuration:

*  Define a set of Windows users that are granted access to the Industrial IT
system product and its Maximo or SAP Integration system extension aspects.

*  Define a corresponding set of user accounts in the Maximo or SAP Server node
with the appropriate privileges: e.g. some users may only view active work
orders while others are authorized to submit new ones.

*  Define the Industrial I'T user to Maximo or SAP user mapping. This mapping is
implemented by adding one Maximo or SAP Credentials aspect in the
Industrial IT User object (refer to System 800xA Asset Optimization
Configuration (3BUA000I 18%*)).

Accessing Maximo Server Version 6.2 and SAP Server
Version 4.7

cpmPlus Enterprise Connectivity Version 4.0 (ECS 4.0) must be installed in order to
access Maximo Server Version 6.2 and SAP Server Version 4.7.

ﬂ ECS 4.0 is only required if using CMMS Integration.

ﬂ Install the Execution Service, Process Definition Tool, and Documentation
features. Do not install Clients and 800xA Connectivity features.
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ﬂ Enable IIS6 Metabase Compatibility in order to install ECS 4.0 - Web Service
Access

1. Verify that the procedure for IIS 6.0 Management Compatibility Components
was performed on the node that will serve as the AO Main Server node (refer to
Server Operating System on page 58 under Internet Information Services.

2.  Perform the following procedure to install ECS 4.0 on the node that will serve
as the AO Main Server node:

a. Double-click ABB cpmPlus Enterprise Connectivity (ECS)
4.0.exe. Refer to cpmPlus Enterprise Connectivity 40 Installation and
Maintenance (3BSE045766) for detailed information.

b. Install the ECS 4.0 - Web Service. ECS 4.0 Web Service is located in the
following directory:

ECS4.0\WebService

c. Double-click ABB cpmPlus Enterprise Connectivity (ECS)
4.0 - Web Service Access.exe.

ﬂ Verify that ABB cpmPlus Enterprise Connectivity (ECS) 4.0.exeis
installed before proceeding with the web service installation. Install the web
service on the same node where ECS version 4.0 is installed (the AO Main Server
node).

d. Follow the Installation Wizard to complete the installation. Accept all
defaults while installing the software.

ﬂ Ensure that the ABB cpmplus Enterprise Connectivity services is started after
restarting the node.

Accessing Maximo Server and SAP Server

Feature Pack Functionality

cpmPlus Enterprise Connectivity Version 4.2 (ECS 4.2) must be installed in order to
access Maximo Server and SAP Server. ECS can be installed on a separate network
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node designated as a ECS Server or can be combined with 800xA Asset
Optimization Server Node.

ﬂ The ABB cpmPlus Enterprise Connectivity Software is available in the DVD 5 in
the following location: <Drive>\3rd Party SW\ABB\ECS

Perform the following steps to install ECS 4.2:

1.  Double-click ABB cpmPlus Enterprise Connectivity (ECS) 4.02.0000.exe.
Refer to cpmPlus Enterprise Connectivity 4.2 Installation and Maintenance
(3BSE065556%*) for detailed information.

2. Select the following features from the Setup Settings dialog box in the
installation wizard:
—  Documentation.
—  ECS Core.
—  ECS Process Definition Tool.
—  External System Integration.
—  ECS Client.

ﬂ Do not install 800xA Connectivity, and Operations Management Functionality
features.

3. Follow the Installation Wizard to complete the installation. Accept all defaults
while installing the software.
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Section 20 PC, Network and Software
Monitoring

This section provides procedures for installing PC, Network and Software
Monitoring, which includes Basic Computer Monitoring. It also includes
installation procedures for the Network Monitor.

ﬂ SNMP Services must be enabled on server nodes before installing the PC,
Network and Software Monitoring Server software. Refer to Enable SNMP
Service on page 61.

ﬂ Do not halt the installation process part way through a step; however, it is
possible to halt the installation process between steps.

ﬂ The PC, Network and Software Monitoring Server and Client installation type
must be installed on all Harmony and Melody Connectivity Server nodes, and
Harmony Configuration Server with Connectivity Server nodes.

PC, Network and Software Monitoring Software

There are two possible installation scenarios for PC, Network and Software
Monitoring (PNSM):

*  800xA Systems running only PNSM Basic Computer Monitoring: It is
recommended that the PNSM Server (the Server and Client selection during
installation) be installed on a Connectivity Server node. It does not have to be
on its own Connectivity Server node but it simplifies future upgrade procedures
if it is installed on a node other than the Aspect Server node. The footprint of
Basic Computer Monitoring is small and should not affect the other software
running on the Connectivity Server.
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*  800xA Systems with additional PNSM assets besides those used for Basic
Computer Monitoring: Always install PNSM on its own Connectivity Server
node per the PNSM installation recommendations.

The PC, Network and Software Monitoring software should be installed on each
800xA node in the system.

When PC, Network and Software Monitoring is installed, an additional component
is provided:
*  Network Monitoring.

This can also be installed independently of PC, Network and Software Monitoring
(refer to Network Monitor Installation on page 202).

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Asset Optimization > PC, Network and
Software Monitoring

2. Follow the Installation Wizard to complete the installation. Perform the
following when the indicated dialog boxes appear:

a. Welcome dialog box: Enable the PC, Network and Software
Monitoring check box.

3. Select an Installation Type dialog box: Refer to Table 11.

Table 11. PC, Network and Software Monitoring Setup Types

Setup Type Software Description

Server and |Installs PC, Network and Software Monitoring Server, aspects, system extension

Client components, and Network Monitor on PC, Network and Software Monitoring Server,
800xA for Harmony Connectivity Server/Configuration Server with Connectivity
Server, and/or single engineering nodes. The single engineering node type includes
the PC, Network and Software Monitoring Server and Client. Refer to Server and
Client Installation on page 201.

Client Client node - Install on all nodes except where a Server and Client installation has

been performed. Refer to Client Installation on page 201.
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Server and Client Installation

1. Select Server and Client in the Select an Installation Type dialog box.

ﬂ During installation, a dialog box may occasionally appear to blink as multiple
command windows are opened and closed. This is normal behavior. Do not
manually close any command windows or the installation could be interrupted.

a. Set OPC Server User Account dialog box: Enter the 800xA Service
User user name and password. Prefix the user name with the domain name
(domain\user) if specifying an account on a domain.

2. Restart the node.

3.  Proceed to the Client Installation to use the Client Installation on other node
types.

Client Installation
1. Select Client in the Select an Installation Type dialog box.
2. Follow the Wizard to complete the installation.
3. Restart the node.
4

Proceed to Network Monitor Installation on page 202 to install the Network
Monitor. The Network Monitor can be installed independently onto a node
other than one on which the PC, Network and Software Monitoring Server and
Client install was performed.

Upgrading a PNSM Client Installation to a PNSM Server Installation

It is possible to upgrade a PNSM Client installation to a PNSM Server installation
using Programs and Features.

ﬂ SNMP services must be enabled before installing the PNSM Server software on a
server node. Refer to Enable SNMP Service on page 61.

1. Open Programs and Features from Windows Control Panel.
Select ABB PC, Network and Software Monitoring.
Click Change.

> wn

Select the Change program features option and click Next.
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5. Select the Server option and the PNSM Server software will be installed on the
local hard drive.

6. Select the Dependencies option and Dependencies will be installed on the local
hard drive.

7. Click Next.
8. Click Update Now.

Network Monitor Installation

The Network Monitor can be installed independently onto a node other than one on
which the PC, Network and Software Monitoring Server and Client install was
performed.

Refer to System 800xA Site Planning (3BUA000285%*) for planning and preparation
considerations to be taken into account before installing the network monitor. The
purpose of those considerations is to ensure that all network traffic to be monitored
goes past the nodes that are doing the monitoring.

ﬂ There are no new menu items created by this install. There is only a new process
running on the workstation or server.

1. Insert 800xA System Installation DVD 1 into the DVD drive.

2. Use Windows Explorer to locate Setup.exe in the following directory:

Asset Optimization\PC, Network and Software
Monitoring\Network Monitor

3. Double-click Setup.exe to begin the installation.

4. Follow the Wizard to complete the installation.
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Section 21 Device Library Wizard

For easy integration of fieldbus devices into the 800xA environment, ABB provides
a continuously increasing set of pre-integrated device types for FOUNDATION
Fieldbus, HART, and PROFIBUS protocol.

The Device Library Wizard is a tool that is used for adding these separately
delivered device types to the device libraries of an 800xA System.

The Device Library Wizard can be used only in connection with Device

ﬂ Management FOUNDATION Fieldbus (refer to Section 22, Device Management
FOUNDATION Fieldbus) and/or Device Management PROFIBUS & HART
(refer to Section 24, Device Management PROFIBUS & HART).

It contains the following components:

*  Device Library Wizard - Client: offers the graphical user interface to install,
extend, or restore device types in the 800xA System.

e Device Library Wizard - Server: implements a Windows service on the
Aspect Server node required by the Device Library Wizard - Client component.

Installation

The Device Library Wizard consists of a Server and a Client component available in
the Welcome dialog box. By default the Client component, which must be installed
on all 800xA System nodes, is selected. The Server component must be selected and
installed only on all Aspect Server nodes (including redundant Aspect Server
nodes).

Install the software on all Aspect Server nodes first and then on the other 800xA
System nodes. Close all programs before starting the installation.

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:
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Manual Installation > Device Management > Device Library Wizard

2. Follow the Installation Wizard to complete the installation. Perform the
following when the indicated dialog boxes appear:

a. Inthe Welcome dialog box, the ABB Device Library Wizard Client
check box is enabled by default.

—  Leave the Install Device Library Wizard - Client check box enabled on
all 800xA System nodes.

—  Enable the Install Device Library Wizard - Server check box on all
Aspect Server nodes (including redundant Aspect Server nodes).

ﬂ Read the text in each dialog box for important information concerning steps to be
taken during installation. For normal use, the suggested default settings are
recommended.

3. When the installation is finished, a green check mark for each component
appears in the Welcome dialog box. The check mark indicates that the
component has been processed.
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Section 22 Device Management FOUNDATION
Fieldbus

Use the Device Library Wizard to add separately delivered Device Types into the
@ 800xA System. Refer to System 800xA Device Management Device Library
Wizard (2PAA102573%*) for details.

Device Management FOUNDATION Fieldbus integrates the FOUNDATION
Fieldbus architecture into the 800xA System environment. It consists of these
components:

*  Fieldbus Builder FF: integrates the FOUNDATION Fieldbus configuring and
commissioning into the 800xA System environment.

. OPC Server FF: makes data from FOUNDATION Fieldbus devices available
to any desired OPC Client.

Installation
ﬂ Close all open applications before installing Device Management
FOUNDATION Fieldbus.

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Device Management > FOUNDATION
Fieldbus

2. Follow the Installation Wizard to complete the installation.

a. In the Welcome dialog box the check boxes for all components are
selected by default. Clear the check boxes for the components that are not
necessary.

Install Fieldbus Builder FF on all Aspect Server nodes, FF Connectivity
Server nodes, Workplace Client nodes, and Engineering Workplace nodes.
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Install OPC Server FF on all FF Connectivity Server nodes.

If the message:

One or more processes occupy ports which are used by
this application: Port nnnn is used for xxx by the
process with PID nnn. It is recommended to close them
before you continue this setup. Retry port check?

is displayed either select No to continue, or, if familiar with the Windows
Operating System, first stop the mentioned process and then click Yes to
continue.

If No is selected, an additional message:

You must restart your system ...

at the end of the installation procedure will prompt for the necessary reboot.

If Yes is selected, no reboot is necessary, but the stopped process must be
restarted after the installation has finished.

C.

During the installation the Configure dialog box for entering hardware and
software settings is displayed. In the left-hand side, select the components
to be configured and enter the settings in the fields on the right per the
remaining instructions.

These settings can also be made or altered after installation is finished by
selecting:

Start > All Programs > ABB Industrial IT 800xA > Device Mgmt >
FOUNDATION Fieldbus > Configure
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General Settings

When General Settings is selected, the dialog box shown in Figure 48 appears.
Refer to Table 12 for details.

@ Contact the network supervisor before entering or changing IP settings.

Etonﬁgure =
Ackion General Settings
P General Settings

[Flrage Layout Client/Server network interface
@ FF Standard Dictionary

Inzert the local IP address of the Client/S erver network interface:
) OPC Server FF

T FBE FF Connect IF address: [Tz 6. 4 22 .|
FF file distribution logging
& Subnet mask: [255.255 252 0 .|

QK I Cancel Lpply

Figure 48. Network Settings Dialog Box

Table 12. Network Address Settings

Dialog Box I
Element Description
Client/Server IP Address: Local IP address of this node in the Client/Server Network, i.e. the
Network Interface |IP address of the network adapter to which the Client/Server Network is

connected.

Subnet Mask: A node on a TCP/IP network is identified by its 32-bit IP
address. The IP address consists of NetID and HostID. The subnet mask
specifies the boundary between NetID and HostID.
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OPC Server FF Settings

When OPC Server FF is selected, the dialog box shown in Figure 49 appears.
Refer to Table 13 for details.

The settings under OPC Server FF are only required on those nodes that are

@ going to act as an FF Connectivity Server.

Etonﬁgure

Action

OPC Server FE

X General Settings

& Default Language
[,__!Page Layauk

E} FF Standard Dictionary
04 OPC Server FE
I'[ FEB FF Connect

@FF file distribution logging

~Resource (D

Existing local OPC Server FF resources:

IP address | Subnet [0

192.168.1.22 1

Mew HSE subnet 1D:

Lonfigure |
Eemove |

Mew IP address:

LI

| Add |

—MTP provider
[V Enable NTP server

[~ Enable NTP client

ok |

Cancel Lpply

Figure 49. OPC Server FF Configuration
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Table 13. OPC Server Resource IDs

Dialog Box

Element Description

Resource IDs A number of OPC Server FF instances can run simultaneously in one node.
Each component must be given a unique resource identification number so that it
can be uniquely addressed.

The same HSE subnet ID must be used on both Connectivity Server nodes to
create a redundant OPC Server FF.

The Subnet ID for the OPC Server FF can range from 1 to 20.
An OPC Server FF will only be available on this node if a Subnet ID is created.

Configure Used to configure the user account for the selected OPC Server FF. By default
the account information of the Service Account is used. It is not recommended to
change this. Click OK to close the dialog box. Clicking Cancel will not set the
account information.

Remove Used to delete the instance of the OPC Server FF and its corresponding Subnet
ID from the node.

Add Used to create OPC Server FF instances (OPC Server FF Subnet ID) on those
nodes that are going to act as a FF Connectivity Server.

Enable NTP Enable NTP (Network Time Protocol) Server is the default setting. This enables

Server this node to act as a timeserver for the linking devices on its HSE subnet. The
node itself is time synchronized by the selected Process Portal mechanisms.

Enable NTP Enable NTP Client to synchronize this node with an external time source if this

Client functionality is not provided by standard Process Portal mechanisms, e.g. for a

Single Node System. Additional Windows configuration might be necessary.

To manually configure the user account for the OPC Server FF:

1. Select the Subnet ID in the list and click Configure. The User Account OPC
Server FF dialog box is displayed.

2. Enter the 800xA Service User user name in the User: field.

3. Enter the 800xA Service User password in the Password: field and the Repeat
Password: field and click OK.
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FF File Distribution Logging

This dialog box is used to set paths and log file size for logging purposes. Refer to
Table 14 for details.

Table 14. FF File Distribution

Dialog Box Element Description

Server Log Type in or browse for a local path to store server log
files. For example:

C:\Program Files\ABB Industrial
IT\Engineer IT\Fieldbus Builder
FF\1log\FFDSD.log

Server Trace Type in or browse for a local path to store Server Trace
files. For example:

C:\Program Files\ABB Industrial
IT\Engineer IT\Fieldbus Builder
FF\log\Trace.log

Client Trace Type in or browse for a local path to store Client Trace
files. For example:

C:\Program Files\ABB Industrial
IT\Engineer IT\Fieldbus Builder
FF\log\TraceClt.log

Max Log Size Set the maximum log file size for logging purposes.
Recommendation: 2048 KB.
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Section 23 Engineering Studio

This section describes how to install Engineering Studio. Install this software on all
800xA System nodes, except separate Domain Server nodes.

If the Engineering Studio system extensions are loaded on the Aspect Server,

@ install the related Engineering Studio products on every other 800xA System
node (the license can be used from every client). Otherwise, there will be error
messages and some functions; for example, copying of objects with related
aspects, will not work. The Engineering Studio system extensions are listed in
System 800xA Post Installation (3BUAO00156%).

Dependencies

The following dependencies between the different components of Engineering
Studio exist:

*  Function Designer requires:

—  Document Manager: included in a typical installation of Engineering
Platform.

—  Control Builder M, AC 800M Connect, and Signal Extension for AC
800M Connect: used to configure AC 800M Controllers on Function
diagrams.

—  The following dependency is optional. It is only applicable for users of
Device Management PROFIBUS & HART.

Device Management PROFIBUS & HART with the Fieldbus Builder
PROFIBUS/HART and PROFIBUS/HART Device Integration
Library - Basics system extensions loaded on the Aspect Server: used
to configure PROFIBUS and HART devices on Function diagrams.

*  Topology Designer requires:

3BSE034678-511 G 211



Installation

Section 23 Engineering Studio

—  Document Manager: included in a typical installation of Engineering
Platform.

—  Control Builder M and AC 800M Connect: used to view AC 800M
control networks on Topology diagrams.

An Engineering Workplace is only available on a client when Engineering Studio
is installed on this client and the Engineering Base system extension is loaded on
the Aspect Server.

Installation

Use of Engineering Studio requires an Engineering Workplace license.
Additionally, the use of the Script Manager Professional Function requires a
Script Manager Professional license, and the use of Reuse Assistant requires a
Reuse Assistant license. The installation procedure for Script Manager and Script
Manager Professional is exactly the same.

The Engineering & Development\Engineering Studio folder on 800xA
System Installation DVD 1 contains the components of Engineering Studio.
Other Engineering components can be found in other Engineering &
Development folders.

The Engineering Studio installation installs both the server and client components.
To install the Engineering Studio software:

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Engineering & Development > Engineering
Studio

2. The Welcome dialog box appears with the ABB Engineering Studio 5.1.0/0
check box enabled by default. Leave it enabled for every node in the 800xA
System.

3. Click Install and follow the Installation Wizard until the Installation Type
dialog box appears. To install the Typical installation, proceed to Typical
Installation on page 213. To install a Custom installation, proceed to Custom
Installation on page 213. Return to this procedure when complete.
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Section 23 Engineering Studio Typical Installation

4. Follow the Installation Wizard to complete the installation. When the
installation is complete, if the system asks to reboot the node, click Yes to
reboot.

Typical Installation

The default selection is Typical. This installs all software components covered by
an Engineering Workplace license, except for the Reuse Assistant. If the Reuse
Assistant is desired, proceed to Custom Installation. If Typical is the desired
selection, click Next and follow the Wizard to complete the installation. When the
installation is complete:

—  If the current node is not an Aspect Server node, but will be used as a
workplace with Document Manager - AutoCad Integration, proceed to
Document Manager - AutoCAD Integration on page 216.

Custom Installation
To install Reuse Assistant, or to disable installation of certain components:

1. Select Custom and click Next. This opens the Change Feature dialog box
shown in Figure 50.

2. To specify the components to install, expand the subfeatures by clicking on the
plus sign (if available) on the left of the tree.

3. Select, by clicking on the down arrow (next to the hard drive symbol), either:
Will be installed on local hard drive
=0Or-

Entire feature will be installed on local hard drive
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i ABB Engineering Studio 5.1.0/0 Setup

Click on an icon in the list below to change how this feature is installed,

This Feature will be installed on the local hard
drive

Docurment and Paramet
AC300M Connect Signal
Scripk Manager (6,41 M|
Function Designer {94.£
Topology Desigrer (54!
Reuse Assiskant (9,24 b

< ?

Install bo: | Browse
Disk Lsage | Reset | < Back | Mext = | Cancel |

Figure 50. Engineering Studio Change Feature Dialog Box

Use the second alternative to install the feature and all subfeatures.

ﬂ The selections Run (all) from Network and Installed on First Use
are not applicable.

4. Table 15 lists and describes the features and subfeatures (if available) that can
be selected or deselected for installation. When the desired selections have

been made, click Next.
If it is necessary to change back to the default (Typical) installation, click Reset
@ before clicking Next.

Table 15. Engineering Studio Features

Feature Description

Contains the Excel add-in that supports list oriented bulk
data operations and integrates Excel spreadsheets into

Aspect Objects.

Bulk Data Manager
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Custom Installation

Table 15. Engineering Studio Features (Continued)

Feature

Description

Document and Parameter Manager

Document Manager provides functionality for comprehensive
document handling and insertion of references into
documents. Parameter Manager supports the handling of
engineering data. They provide interfaces both for bulk and
single data manipulation. The supplied system extension is
DM and PM Application.

AC 800M Connect Signal Extension

Contains signal objects for use by AC 800M Connect, I/0
Allocation, Bulk Data Manager, and Function Designer. It is
required for the Function Designer for AC 800M Connect
system extension.

Script Manager

Adds scripting capabilities to Aspect Objects using VBScript
language. The supplied system extension is Script
Manager.

Function Designer

Function Designer for AC 800M
Connect

Function Designer for
FieldbusBuilder P/H

Engineering portal for plant-oriented engineering across
Aspect Systems. The supplied system extension is Function
Designer. Optional system extensions that are available are
Function Designer for AC 800M Connect and Function
Designer for Fieldbus Builder PROFIBUS/HART.

Enhances libraries and object types of the AC800M
Connect system extension and signal objects of the Signal
Extension for AC800M Connect system extension for use
by Function Designer.

Enhances object types of the Fieldbus Builder
PROFIBUS/HART system extension and the
PROFIBUS/HART Device Integration Library - Basics
system extension for use by Function Designer.
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Table 15. Engineering Studio Features (Continued)

Feature Description

Topology Designer Graphical diagram based, configurable Status Viewer for the
Control Network. The supplied system extension is
Topology Designer. An optional system extension that is
available is Topology Designer for AC800M Connect.

Topology Designer for AC 800M | Enhances hardware unit Object Types of the Signal
Connect Extension for AC800M Connect system extension for use
by Topology Designer.

Reuse Assistant Provides functions to design Reuse Instructions and to
implement solutions based on defined Reuse Instructions.
The supplied system extension is Reuse Assistant.

Examples Provides three examples showing possible designs of Reuse
Instructions.

5. Follow the Wizard to complete the installation. When the installation is
complete:

—  If the current node will be used as a workplace with Document Manager -
AutoCad Integration, proceed to Document Manager - AutoCAD
Integration on page 216.

Document Manager - AutoCAD Integration

For AutoCAD Integration in Document Manager one of the following is required:

*  AutoCAD 2004, AutoCAD 2005, or AutoCAD 2006 (to be purchased
separately).

*  DWG TrueView 2.0 or later is recommended to be used for viewing of
AutoCAD dwg-files created from AutoCAD version 2002 and newer.
Autodesk DWG TrueView 2 (SetupDWGTrueView?2.exe) is available on
800xA System Installation DVD 5 in the following directory:

3rd Party SW\AutoDesk

ﬂ The latest version of DWG TrueView 2 can be downloaded free of charge at:
http://www.autodesk.com
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Section 24 Device Management PROFIBUS &

HART

This section describes how to install Device Management PROFIBUS & HART, a
set of software components for efficient planning, operation, and monitoring of
PROFIBUS and HART field devices within the 800xA System. It consists of the
following:

Fieldbus Builder PROFIBUS/HART with OPC Server: Aspect System
according to FDT 1.2 standard for engineering of PROFIBUS and HART
devices within the 800xA System. The OPC Server provides for easy data
exchange between smart field devices and Asset Optimization applications
without special adjustments.

Basic HART DTM: Generic Device Type Manager for configuration,
observation, diagnostic display, etc. of HART compatible field devices.

Basic PROFIBUS DTM: Device Type Manager for configuration,
commissioning, and diagnosis of generic PROFIBUS devices.

S800 I/O DTM: Device Type Manager for configuration, observation,
maintenance, etc. of S800 I/O modules and communication interfaces.

S900 I/0 DP DTM: Device Type Manager for configuration, observation,
maintenance, etc. of a S900 Station.

HART Device Integration Library: Library providing easy access to built-in
system extensions, such as Asset Management.

PROFIBUS Device Integration Library: Library providing easy access to
built-in system extensions such as Asset Management.

HART Multiplexer Connect: Support of HART Multiplexer for
configuration, calibration, diagnosis etc. of HART devices, connected to non-
800xA System DCS/PLCs.
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Section 24 Device Management PROFIBUS & HART

Install this software on all 800xA System nodes when PROFIBUS and HART field
devices are being used. For this software release, all components are installed on all
800xA System node types.

Installation

To install the Device Management PROFIBUS & HART software:

Install the Device Management PROFIBUS & HART software components from
@ the Meta setup window. Individual installation of each component is not allowed.

Use the Device Library Wizard for adding separately delivered Device Types into
@ the 800xA System. Refer to System 800xA Device Management Device Library
Wizard (2PAA102573%*) for details.

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Device Management > PROFIBUS & HART

2. Follow the Installation Wizard to complete the installation.

a.

In the Welcome dialog box the check boxes for all components except the
HART Multiplexer Connect component are enabled by default. Do not
disable any check boxes for any other components. The check box for the
HART Multiplexer Connect component must be enabled if the HART
Multiplexer Connect option is licensed and will be used in the 800xA
System.

Click Install to start the installation.

If the confirmation dialog box indicates that one or several components
have been installed already, ignore this warning and proceed with the
installation process. The installation process will resolve this situation,
described as follows:

Integrity and version checks are done during installation to assure that all
components can be installed. For each component, a progress bar is
displayed indicating the remaining time needed for installation.
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Section 24 Device Management PROFIBUS & HART Installation

—  If an equivalent version of the component is detected as already being
installed, the component will be installed again and the setup will
continue.

3. When the installation is finished, a green check mark for each component
appears in the Welcome dialog box. The check mark indicates that the
component has been processed.

AC800M Connect and AC800M High Integrity system extensions must be loaded
ﬂ before loading PROFIBUS Device Integration Library - Basic and HART Device
Integration Library - Basic system extension. Therefore, install AC800M Connect
and AC800M high Integrity also when installing Device Management
PROFIBUS and HART.
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Section 25 Process Engineering Tool
Integration

Process Engineering Tool Integration provides seamless data exchange between
INtools 6.0 or SmartPlant Instrumentation 7.0 (INtools/SPI) and 800xA System
databases.

Prerequisites

If not already installed and if required, refer to Process Engineering Tool Integration
Specific Requirements on page 93 for prerequisite installation information.

Installation

To install Process Engineering Tool Integration:

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Engineering & Development >
Process Engineering Tool Integration

2. Follow the Installation Wizard to complete the installation. Perform the
following when the indicated dialog box appears:
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Section 25 Process Engineering Tool Integration

a.

Select Features dialog box: Refer to Table 16 to choose the appropriate
installation feature.

Table 16. Process Engineering Tool Integration Installation Features

Installation Type

Description

800xA Client

Required for synchronizing data bidirectionally between the 800xA System
and INtools/SPI.
There are two installation options:
Regardless of which installation option is chosen, the 800xA
ﬂ Client selection must always be installed on the Primary
Aspect Server node in order to load the system extension.

1. Install and use Process Engineering Tool Integration on an Engineering
Workplace node with Control Builder M installed. This is the preferred
method in order to avoid loading the Primary Aspect Server node.

2. Install and use Process Engineering Tool Integration on the Primary
Aspect Server node (Control Builder M and Engineering Studio must also
be installed on the Primary Aspect Server node).

Web Services'?

Required for an online connection with the INtools/SPI database. Install
this component only on the INtools/SPI node.

INtools/SPI DB Import
Export Utility1 2

Required to import/export data from/to the INtools/SPI database via an
XML file (CAEX file). Install this component only on the INtools/SPI node.

1. Prior to installing these components, use Windows Explorer to locate intools.ini file on the INtools/SPI
node. Open the file in a text editor and make sure that Userld (created when the INtools/SPI database was
created) and Password fields are filled in with appropriate information. These fields are required.

2. The installation checks to see if INtools/SPI exists on the node on which these components are being installed.
The entry in the Select Features dialog box is hidden if INtools/SPI is not found on that node.
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Section 26 Information Management

This section describes how to install the Information Management (IM) software.
Information Management is a client/server application. Five configurations provide
five different levels of functionality:

IM Server: runs services for historical data collection, archive, and open data
access. Install this on the IM Server node. Refer to IM Server on page 224.

Information Management Consolidation node: allows for consolidation of
historical data from IM Servers in other systems on one node. Software
installation is the same as for the IM Server. Refer to IM Server on page 224.
The only difference is that the consolidation node is set up as a single-node
system which may or may not reside in a domain.

Information Management Client Toolkit: supports a user interface for
configuring and managing aspect objects related to Information Management
without having to install the full IM Server. Install the Client Toolkit on all
non-Information Management nodes in the system. Refer to Client Toolkit on
page 226.

Information Management Desktop Tools: provide access to process and
event data on the IM Server. For example, DataDirect is a tool for integrating
process and event information from the applications into an Excel spreadsheet.
Other tools that support data access are Desktop Trends and Display Services.
With the proper authority historical and real-time process data can be updated
via DataDirect and Display Services. The Desktop Tools are automatically
installed locally on the IM Server node. They may also be installed on remote
clients. The remote clients do not require 800xA System software to be
installed. Refer to Desktop Tools on page 228.

Information Management Profiles Client: Required for Profile Historian
applications. This client provides the user interface for using the profile
displays. The Profiles Client can be installed on any node in a system that

3BSE034678-511 G
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Prerequisites Section 26 Information Management

meets the requirements for Desktop tools. Refer to Information Management
Profiles Client on page 230.

Prerequisites

If not already installed, refer to Information Management Specific Requirement on
page 94 for Oracle installation information.

IM Server

This section describes how to install the IM Server software.

The installation wizard installs all Information Management software on the system
drive. Install the Oracle program files on the system drive as well (recommended). If
desired, designate different drives for storing Oracle data files, and file-based
numeric log data.

Default groups are created when Information Management and required third party
software are installed. To add, remove, or otherwise edit any groups after
installation, refer to System 800xA Information Management Configuration
(3BUF001092%).

Preparation

The following steps are required to ready the node for Information Management
software. Detailed instructions are provided in the following sections.

ﬂ Make sure to have the required hardware and enough free disk space.

Information Management Server Installation

Do not combine a Batch Server and an IM Server in the same node if Batch
@ redundancy is required. Refer to System 800xA System Guide Technical Data and
Configuration (3BSE04 1434 %) for more information.

ﬂ The SoftPoint Server must be installed before installing the Information
Management Server. Refer to SoftPoint Server on page 128.

The Information Management software is installed via the Information Management
Installation Wizard. To install the IM Server software:
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1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Information Management > Historian

2. The Information Management Installation Wizard appears. Click Information
Management.

3. The Information Management Prerequisites dialog box for IM Server
installations appears.

—  The Wizard scans the server to verify that all prerequisites are installed.
For installed prerequisites, the wizard indicates the version number. If the
version is not current enough to meet the requirements of this installation,
the version number is indicated in red; otherwise the version number is
indicated in black.

—  Prerequisites that are not installed are indicated as Not Found. These must
be installed. Prerequisites that are installed, but are out-of-date (indicated
in red), must have the proper version installed.

ﬂ If the Microsoft Office 2010 is installed as a prerequisite, the prerequisite page in
the Information Management Wizard displays the Office Version in red. Ignore
this and continue the installation.

— If all 800xA System installation instructions have been followed, all
prerequisites should already be installed. If not, use the links on the
Information Management Prerequisites dialog box to install them now.
When all prerequisites are installed, the Continue function on the
Information Management Prerequisites dialog box is enabled.

4. Click Continue to continue installing the Information Management software.
This displays the Information Management Install dialog box (Figure 51).

ﬂ Only components for which licenses have been purchased and installed can be
used. All options are selected by default. Deselect options for which licenses
have not been purchased.

5. Click INSTALL Information Management. This begins the Information
Management software installation that installs all Information Management
components, including the selected options from start to finish without any
further intervention. This process will take about 10 minutes. The time may
vary slightly depending on the performance of the server.
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ABB Industrial IT 800xA - Information Management

NT SP 2 IE: 8.0.6001.18882 Information Management
PAS - System Services Mot Found
Scheduler Mot Found
History Services Mot Found
Display Semices Mot Found
DataDirect Mot Found
INSTALL Desktop Trends Mot Found

#" Information Management

Select optional applications

IV_ Open Data Access ©DA Mot Found
IV_ Calculations CALC Mot Found

@ Version 5.1.0/0

Figure 51. Information Management Install Dialog Box for IM Server

—  The Wizard indicates the component that is currently being installed.

—  When the installation is finished, the installed software version is
indicated for each component.

a. A dialog box should appear requesting that the Service Account user name
and password be entered. Enter the required information.

6. Click Exit and a Restart Windows prompt appears. Click Restart Now to
restart the server and complete the installation.

Client Toolkit

The Information Management Client Toolkit supports a remote user interface for
configuring Information Management services and managing aspect objects from
the Plant Explorer Workplace, without having the full server functionality installed.
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Install the Client Toolkit on all non-Information Management nodes in the system.
This will allow for browsing and configuring Information Management objects and
aspects from these nodes.

The SoftPoint Server must be installed before installing the Client Toolkit. Refer
to SoftPoint Server on page 128.

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Information Management > Historian

2. The Information Management Installation Wizard appears. Click Client
Toolkit.

3. The Information Management Prerequisites dialog box for Client Toolkit
installations appears.

The Wizard scans the workstation or server to verify that all prerequisites
are installed. For installed prerequisites, the wizard indicates the version
number. If the version is not current enough to meet the requirements of
this installation, the version number is indicated in red; otherwise the
version number is indicated in black.

Prerequisites that are not installed are indicated as Not Found. These must
be installed. Prerequisites that are installed, but are out-of-date (indicated
in red), must have the proper version installed.

If all 800xA System installation instructions have been followed, all
prerequisites should already be installed. If not, use the links on the
Information Management Prerequisites dialog box to install them now.
When all prerequisites are installed, the Continue function on the
Information Management Prerequisites dialog box is enabled.

4. Click Continue to display the Client Toolkit install screen. This screen lists the
components of the Client Toolkit. These components will be installed in the
order in which they are listed.

Only components for which licenses have been purchased and installed can be
used. All options are selected by default. Deselect options for which licenses
have not been purchased.

5. Click INSTALL Client Toolkit. This begins the software installation and will
install all components from start to finish without any further intervention. This
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process will take about five minutes. The time may vary slightly depending on
the performance of the workstation or server.

—  The Wizard indicates the component that is currently being installed.

—  When the installation is finished, the installed software version is
indicated for each component.

6. Click Exit to complete the installation.

7. Proceed to Desktop Tools to install Desktop Tools, or to Information
Management Profiles Client on page 230 to install the Information
Management Profiles Client.

Desktop Tools

Desktop Tools support data access for viewing on remote desktops. These services
may be installed on all supported operating systems. These applications DO NOT

require the Information Management System Services, nor do they require 800xA

System software.

Desktop tools can also be installed on 32-bit (x86) versions of Windows XP SP3
and 32-bit (x86) versions of Windows Vista SP2 systems with Internet Explorer 8
and Excel 2007 or 2010 or 2013.

The 800xA Common Third Party Install Tool must be run before installing desktop
tools on the Workstation Operating System, Server Operating System, and Windows
Vista.

The 800xA Common Third Party Install Tool does not support Windows XP. Install
the following manually:

« NET3.5.
e Internet Explorer 8.
e Microsoft Excel 2007 or 2010 or 2013.

Desktop Tools Installation Guidelines
Read the following guidelines carefully before installing the software.

»  Upgrades: If upgrading the Desktop Tools from an earlier version, remove all
existing Desktop Tools software, including the Microsoft Runtime
Components. Use the Add/Remove Programs utility in the Windows Control
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A

Panel. Install the new software as described in this section. Upgrades only
apply to Windows XP nodes.

Launch Control Panel.

Select Network and Dialup Connections.

In the network and Dialup Connections list, select Local Area Connection.
In the Local Area Connection Status dialog box, click Properties.

In the LAN properties dialog box, select Internet Protocol (TCP/IP), then
click Properties.

In the TCP/IP properties dialog box, check the settings for:

— IP Address.
—  Subnet Mask.
—  Default Gateway.

Desktop Tools Installation

®
®

Make a backup of the system and applications before installing Information
Management software.

Perform all installation and related activities as the SAME user: either a domain
user with administrator privileges, or a locally-defined user with administrator
privileges, depending on whether or not the client resides in a domain.

To install Desktop Tools:

1.

Log in as a Windows user with administrator privileges. Use a domain user
with administrator privileges if installing the node on a domain; otherwise, use
a locally defined user with administrator privileges.

This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Information Management > Historian

The Information Management Installation Wizard appears. Click Desktop
Tools.

The Information Management Prerequisites dialog box for Desktop Tools
installations appears.
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—  The Wizard scans the workstation to verify that all prerequisites are
installed. For installed prerequisites, the wizard indicates the version
number. If the version is not current enough to meet the requirements of
this installation, the version number is indicated in red; otherwise the
version number is indicated in black.

—  Prerequisites that are not installed are indicated as Not Found. These must
be installed. Prerequisites that are installed, but are out-of-date (indicated
in red), must have the proper version installed.

— If all 800xA System installation instructions have been followed, all
prerequisites should already be installed.

5. Click Continue to display the Desktop Tools install screen. This screen lists
the components of Desktop Tools. These components will be installed in the
order in which they are listed.

6. Click INSTALL Desktop Tools. This begins the software installation and will
install all components from start to finish without any further intervention. This
process will take about five minutes. The time may vary slightly depending on
the performance of the workstation.

—  The Wizard indicates the component that is currently being installed.

—  When the installation is finished, the installed software version is
indicated for each component.

7. Click Exit to complete the installation.

Information Management Profiles Client

This application does not require the Information Management System Services or
800xA System software.

The Profiles Client can be installed on any node in a system that meets the
requirements for Desktop tools.

The Profiles Client may be installed as an option to the Information Management
Server, or Desktop Tools. If installing the Profiles Client independent of any
Information Management software, enable the Advanced View option on the
Information Management Installation Wizard. Figure 52 shows the Installation
Wizard with the Advanced option enabled. This lets you install the Information
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Management Profiles Client without having to install prerequisites that are not
necessary for this client (i.e. Oracle or Microsoft Excel).

The Profiles Client software is installed via the Information Management
Installation Wizard. To install the Profiles Client software:

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Information Management > Historian
2. The Information Management Installation Wizard appears.
3. Select the Advanced View option (just below Exit).
4. Click Install PROFILES Client.

ABB Industrial IT Information Manager A\ 1D D
M 5.1.0/0 Ripmwp

Upgrade
Informatio

I
(B

2010.06.07

IE: 8.0.6001.18882

Figure 52. Profiles Client Installation

5. Click Install Now on the Profile Client Installation Wizard. During the
installation there is a five-second opportunity to manually set ACC; otherwise,
defaults are used.

6. Click Finish to complete the installation.
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This section describes how to install Batch Management functionality.

Batch Management Installation

Batch Management is a client/server application within the 800xA System. Install
the Batch Server on the Batch Management Application Server. If applicable, install
the Batch Management Secondary Server on another Batch Management
Application Server after the installation of the Batch Management Primary
Server.
Do not combine a Batch Server and an IM Server (or other server applications) in
the same node if Batch redundancy is required. Refer to System S800xA System
Guide Technical Data and Configuration (3BSE041434%*) for more information.

Install the Batch Client on all other nodes in the 800xA System, except separate
Domain Server nodes.

ﬂ A Batch Client is automatically installed on all Batch Servers.

ﬂ Install Batch Clients on all nodes in the 800xA System (except separate Domain
Server nodes) other than the Primary and Secondary Batch Server nodes.

ﬂ Batch Management is installed only on SQL Server 2008 (32-bit). It will not
support SQL Server 2008 (64-bit).

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Batch Management
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2. Follow the Installation Wizard to complete the installation. Perform the
following when the indicated dialog boxes appear:

a. Setup Type dialog box: Select the components to install according to
Table 17.

Table 17. Setup Type Options

Option Requirements
Batch Management Install on one node. This server manages the Secondary Server and
Primary Server all Batch Clients. This selection will also install the
BATCH_INSTANCE of SQL Server.
Batch Management Install on one node. This server will take over if the Primary Server
Secondary Server fails. This selection will also install the BATCH_INSTANCE of SQL
(optional) Server.

Batch Management Client |Install on all other nodes in the 800xA System (except separate
Domain Server nodes) including the 800xA Primary Aspect Server.
Selecting Client will also install SQL Server Native Client.

Install VB Graphics This option should only be selected when installing Batch
Extensions (check box) Management as part of an upgrade. This will install the Batch
Management VB Graphics extensions on the selected node type.

b. Batch Management Software Destination Selection dialog box: Click
Browse to select the installation location, or accept the default.

c. Batch Management Runtime Database Destination Selection dialog
box (Server installations only): Click Browse to select the database
installation location, or accept the default.
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d. Message box: The message box differs depending on what was selected in
the Setup Type dialog box in Step a. Figure 53 shows the message box for
the Batch Management Primary or Secondary Server installations and
Figure 54 shows the message box for the Batch Management Client
installations. Click Yes to continue with the installation. Proceed to Step e
for Batch Management Primary or Secondary Server installations. Wait
for the installation to complete for Batch Management Client
installations.

@™% Batch Server (Primary or Secondary) requires a BATCH_INSTANCE
' of 0L Server 2008 (version 10.2,4000).
= Would you like to install the required BATCH_INSTANCE now?

Figure 53. Message Box for Batch Management Primary or Secondary Server
Installations

Question

@™% Batch Client requires Microsoft SQL Server Mative Client 10,0
'-._ _.-' {Client Tools Connectivity Feature of SQL Server 2008 (version
= 10.2.4000),
Wwould vou like ko install the required SQL Client now?

Figure 54. Message Box for Batch Management Client Installations
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e. Browse for Service Account dialog box (Figure 55): Use this dialog box
to enter the Service Account information for the
BATCH_INSTANCE.

ﬂ It is recommended to use the 800xA Service User account and password,
although it is permissible to use a customer-specific Service Account.

ABE Structured Data Logger 51.0/0 =]

Browse for Service Account

Select the service account for SDL_INSTAMCE of SQL Server

User name:

Browse

Password:

< Badk | {Next > Cancel

Figure 55. Browse for Service Account Dialog Box

f.  Itis possible to either:

—  Enter the Service Account user name and password in the Browse for
Service Account dialog box (Figure 55), click Next, and wait for the
installation to complete.

- Or_
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g. Click Browse to launch the Browse for a User Account dialog box shown
in Figure 56.

Browse for a User Account @

Use the browse buttons to select Domain/Server and User name

Domain or Server:

| Browse

User name:

Ll

| Browse

Cancel |

Figure 56. Browse for a User Account Dialog Box

h. Click Browse for the Domain or Server.

i. A Select a Domain or Server dialog box similar to the one shown in
Figure 57 appears. There will be one or more possible selections. Select
the correct Domain or Server and click OK to return to the Browse for a
User Account dialog box.

Select a Domain or Server @I

Domain or Server:

ABB-FC

Cancel |

Figure 57. Select a Domain or Server Dialog Box
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j-  Click Browse for the User Name.

k. A Select a User Name dialog box similar to the one shown in Figure 58
appears. Select the Service User.

Select a User name @

User name:

abb
Administrator
Guest

K | Cancel |

Figure 58. Select a User Name Dialog Box

I.  Click OK to return to the Browse for Service Account dialog box
(Figure 55).
m. Enter the password, click next, and wait for the installation to complete.

ﬂ Restart the Batch Primary and Secondary Servers when installation is complete.
Restart the primary followed by the secondary.
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Section 28 Multisystem Integration

For some applications, it is neither possible nor desirable to have all objects
centralized into a single system. This may be due to geographical location, plant
size, decentralized maintenance, different phases in commissioning, or other
reasons. Multisystem Integration provides support for connecting multiple 800xA
systems together.

Some terminology associated with Multisystem Integration is:

¢ Provider System: The 800xA System running the Remote Access Server. This
is the supervised system.

*  Subscriber System: The 800xA system running the Remote Access Client.
This is the supervising system.

*  Remote Access Server: Runs in the Provider System.
*  Remote Access Client: Runs in the Subscriber System.

This section describes how to install the Multisystem Integration software.

Recommended Hardware Configurations

There are no special requirements on the hardware for Multisystem Integration,
except the requirements for the 800xA Base System software.

However, the requirement that the time difference between a Remote Access Client
and a Remote Access Server should normally be less than a minute. To achieve this
time synchronization additional external equipment may be needed.

The following describes two different configurations for the Remote Access Server,
used for a small and medium/large 800xA System.
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Small Configuration

For a small configuration with a few hundred I/O signals, the Remote Access Server
can run in the same node as the Connectivity and Aspect Servers. It is recommended
to not run a Workplace on the same node.

Medium/large Configuration

For a medium/large configuration, it is recommended to run the Remote Access
Server in the Connectivity Server node.

Combinations of these basic configurations can also be used. For example, if the
Provider System is small, but the Subscriber System is connected to a lot of
Provider Systems, the configuration for a small system may be used on the Provider
side, and a medium/large configuration may be used on the Subscriber side.

Installation

To install the software:

1. This software is accessible from the Installation AUTORUN screen (refer to
Installation AUTORUN on page 32) by selecting:

Manual Installation > Base Functionalities > Multisystem Integration

2. Follow the Installation Wizard to complete the installation.
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Section 29 Snapshot Reports

The Snapshot Reports is a search engine for the System 800xA. It allows the user to
configure the Snapshot Search templates in the Aspect Object database. The

Snapshot Report View aspect can be used to search reports as a single report or as a
combined report that includes several templates.

Installation

Refer to the System 800xA 5.1 Snapshot Reports User Guide (3BSE060242 %) to
install the Snapshot Reports.

3BSE034678-511 G 241



Installation Section 29 Snapshot Reports

242 3BSE034678-511 G
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Before installing the software keys, refer to Section 3, Central Licensing System
(CLS) and:

Install the Central Licensing System (CLS) software on the designated License
Server and all License Clients.

e Obtain the machine IDs.
*  Apply for and receive the software keys.

ﬂ All software keys for 800xA System software must be installed before using the
applications. Install the software keys before attempting any post installation
procedures, as some procedures may require the software keys to be in place.

Software Key Installation

To install the software keys, launch the License Entry program from the license

server.

1. Select:
Start > All Programs > ABB Industrial IT 800xA > System >
Licensing > License Entry

2. Select:

File > Load/Replace Licenses...
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in the License Entry program as shown in Figure 59.

? -
(B ABB License Entry. - o X
[File] View License MachineIDs Help

Load / Replace Licenses...
View and Load License File = [Vewion [ Expiation Date Tay [ Option Strry
Remove Licenses... CORE_SYSTEM 51 31-Dec2010 Unimted

CORE_CONF_DEP 51 31-Dec:2010 Unimted
o Eee CORE_LOAD_EV_GO 51 31-Dec-2010 Unimted
Remove Extension... S 51 31-Dec-2010 Unlimted
TAGS_RED 51 31-Dec:2010 Unimted
Force License Cycle 800_OPC_SRVR 51 31.Dec-2010 Unlimted
Print... OLE_DB_RT 5.1 31-Dec-2010 Unlimted
) AUDIT_TRALL 51 31-Dec2010 Unimted
Bt ACCESS CNTL 51 31.Dec:2010 Unimted
BRI YT T DIG_SIGN 5.1 31-Dec-2010 Unlimted
1 MSG_SRVR 5.1 31-Dec-2010 Unlimted
2 CALC_SRVR 51 31-Dec2010 Unimted
3 SPNT_SRVR 51 31-Dec2010 Unimted
14 CONN_SYSTEM 51 31-Dec-2010 Unlimited
15 CON_ACB00M 51 31-Dec:2010 Unimted
1 CON_AC400 51 31-Dec:2010 Unimted
17 CON_HARMONY 5.1 31-Dec-2010 Unlimited
18 CON_PLC 51 31:Dec:2010 Unimted
19 CON_MELODY 51 31-Dec2010 Unimted
2 CON_MOD 51 31-Dec2010 Unimted
21 CON_DCI 51 31-Dec-2010 Unlimted
2 CON_ACB00F 51 31:Dec:2010 Unimted
2 CON_SAFEGUARD 51 31.Dec2010 Unimted
24 CON_PLC_DIAL 51 31-Dec-2010 Unlimited
> CON_PLC_IEC 51 31-Dec2010 Unimted
% 800M_SOFT_CON 51 31-Dec2010 Unimted
27 SNAP_SH_REPORTS 51 31-Dec2010 Unimted
28 POINT_OF_CTRL 5.1 31-Dec-2010 Unlimited
R v i v

T — S —— - rm——— P
®® ProductV.. | AlPAccess | [B) | ] Untitled- ... || jJ Windows-... || (g ABB Licen... *{ Control B... ¥9 AwAppL... |[ A Optional... | ¢ I ROMD G %4aM

Figure 59. License Entry Program
3. The Open dialog box appears. Use it to find the license file (.sla), which
contains the software keys and click Open.

4. If a software key has already been opened, the Overwrite prompt shown in
Figure 60 appears. If necessary, click Yes to install the current software keys.

Crverwrite existing license data for 300x4

Yes Mo

TCO05710A

Figure 60. Overwrite Prompt
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5.  When finished, the installed software keys may be viewed via the License
Entry program on a License Group basis. For example, Figure 18 shows the
software keys installed for the 800xA basic system functions.

tix ABB License Entry

File Miew License Machine IDs Help
B S & &
# | Feature | “ersian | Expiration [ ate | [y | s
1 CORE_SYSTEM 40 NAUG2004 20
 E TAGS 40 N-4UG2004 1000
-5 800xA Dperatic 3 TAGS_RED 40 -4UG2004 2000
+- = 800w Batch M. SPNT SRR 40 NAUG2004 20
-5 8004 Informath 5 COMM_SYSTEM 40 NAUG2004 20
4 & B00xA Contral & B CON_ACE00M 40 NAUG2004 20
o 5 004 Engineer | CON_PLC 40 NAUG2004 20
g COM_PLC_DIAL 40 NAUG2004 20
o G004 Asset OF g COM_PLC_IEC 4.0 I-aUG-2004 20
-5 8004 Fieldbus 10 COM_AC400 40 NAUG2004 20
11 CON_HARMONY 40 N-AUGZ004 20
£ 5 BI0A Extensior ) CON_MELODY 40 NAUG-2004 20
13 CON_MOD 40 N-AUGZ004 20
14 COM_SAFEGUARD 40 NAUG2004 20
15 COM_DCI 40 N-AUGZ004 20
16 CON_ACE00F 40 NAUG2004 20
17 COM_ACI00 40 N-AUG2004 20
18 USER_MOTES 40 NAUG2004 20
19 800_OPC_SAYR 40 N-AUGZ004 20
N NFNRRT An Al R-2nd N b
< ¥ < >

Table 18. Browsing Licenses on a License Group Basis

6. Select:
File > Exit

to exit the License Entry program when finished.
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Troubleshooting

Software keys are kept in a license file stored in a cache on the hard disk. Basic
troubleshooting steps are to locate the license file and view its contents.

ﬂ The most common problem occurs during software key installation if the
software keys loaded properly, but are not valid. Refer to Software Key
Installation on page 243 to load the software keys.
Locating the License File
The license file contains the individual software keys. To locate the license file:
1. Launch the License Entry program.
2. Select:
View > File View
3. The expected license file name is displayed at the top level in the tree view.
4. License files are stored in:

Install Drive:\Program Files\ABB Industrial
IT\ABBLicense\Licenses\Cache

Use Windows Explorer to check if the specified directory and file exist.

Unavailable Machine IDs

This section describes what to do if an option is not listed as an available machine
ID.

Rainbow Dongles

If the desired Rainbow SentinelSuperPro (parallel port) or Sentinel USB (USB port)
dongle is not listed as a machine ID option, verify the following:

1. Verify that the dongle was supplied by ABB. ABB software can read only ABB
dongles.

2. Verify that the dongle is attached to the parallel port or USB port. In most
cases, ABB software licensing functions support multiple dongles that are
daisy chained together on a parallel port or are plugged into multiple USB
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ports. The dongle for the 800xA System can be anywhere in the daisy chain or
in any USB port.

3.  Select:
Machine Ids > Available IDs

in the License Entry program to scan for newly inserted IDs.

Ethernet Address
If the Ethernet address is not listed as a machine ID option:

*  Verify the TCP/IP protocol was properly configured during the installation of
the product being licensed.

e Verify the network adapter is functioning correctly.

Common Error Messages

Table 19 lists the common error messages.

Table 19. Common Error Messages

Error Code Error Message Description / Action
8004AB1C/4AB1C Error in registry entry for Requested group does not exits in the
license file (License Group available groups.
does not exist). Open the license assignment editor to

view the list of groups and features.

8004AB05/4AB05 No such feature exists. This error occurs when checking out a
feature that has been licensed.

Open the license assignment editor to
view the list of features.
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Section 30 Licensing 800xA System Software

Table 19. Common Error Messages

Error Code Error Message Description / Action
8004AB09/4AB09 Feature found but machine ID | A license for the feature was found, but
mismatch. not for the computer in use.
If the license is for a moveable Machine
ID (For example: Rainbow
SuperPro/Rocky dongle) move the
dongle to the computer in use. Or, get a
license for the computer in use.
Use the license entry program and on
IDs tab view the machine IDs.
8004ABOA/4ABOA Feature found but wrong License for the feature was found, but for
version. a different version. Get a license for the
latest version of the product.
8004AB0OC/4ABOC |Feature expired. The license validity for the feature was
expired. Obtain the current license.
Use the License Entry program and view
the expiry date of the feature.
8004AB81/4ABF1/4 |Insufficient license The program requires more license than
ABF2 quantity/Invalid License were available. This error indicates
Granted: Available license license for the desired feature are
quantity exceeded/Some available, but not in the quantity
licenses could not be granted | requested. Request fewer license or
due to insufficient quantity. obtain more license.
8004AB83 Insufficient floating license Click on the diagnostic button of license
quantity. assignment editor to view the total
requests for the desired feature.
8004AB89/4AB89 The Client is not in the same | Possible causes are either the use of
System as the active SFA. one CLS server for more than one
800xA system or nodes not added in the
system after recreation of system/client
node point to the CLS system that is not
part of corresponding 800xA system.
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Table 19. Common Error Messages

Error Code Error Message Description / Action

4ABCA A Hardware Key (Machine ID) |Possible causes are either the dongle
has failed. You have %d hours |removed from the node or it has stopped
remaining to correct the responding.
problem before licenses Use the license entry program, on the
become invalid. IDs tab view the machine IDs of the

8004AB8C A Hardware Key has stopped | COmputer.
responding. Replace hardware
key to correct.

NOTES:
%d indicates representation of an integer value corresponding to the total no of hours left over. By default it shows 48
hours and it decreases by one for every one hour.

A temporary licence error message appears in the following situations:
e The CLS Client is not able to reach the CLS Server.
e IS down in the CLS Server.

Assigning Licenses

The Central Licensing System dynamically distributes the available licenses as they
are needed to all the nodes in the 800xA System. However, the License Assignment
Editor allows licenses to be permanently assigned to a particular node. To assign a
license to a particular node:

1. From the License Server node, select:

Start > All Programs > ABB Industrial IT 800xA > System >
Licensing> License Assignment Editor

2. This launches the License Assignment Editor as shown in Figure 61. Enter the
name of the node in the Select a Node or Application field.

Click Add. The node name will appear in the Assigned Features field.
Select the node name in the Assigned Features field.

Select the type of license to be assigned in the Available Licenses field.

AL

Enter the number of licenses (of the type selected) that will be assigned to the
node in the Number field.
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7. Click Assign.

8. Click Save. This will cause the licenses to be allocated as specified.

ﬂ If necessary, licenses will be removed from existing nodes to meet the specified
license allocation.

9. Repeat this procedure as required.

- £ http://aoss-M/ABBLI entralLic jice/Li jitor/Li it <[] x |2 8ing Ok
g Favorites | i &) Suggested Sites v &) Web Slice Gallery v 2] Customize Links
J'. = 3 v B v ) @ v Pagev Safetyv Toosv @~

BOOXAASSET ~

Figure 61. License Assignment Editor

Backup/Restore
License assignments are stored in XML format in the following file:

Install Drive:\Program Files\ABB Industrial
IT\ABBLicense\Licenses\LicenseFeatureAssignment.xml
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This file can be copied for backup or replaced with a backed up copy after a re-
install of the CLS software. If this file is restored from a backup, reboot the License
Server node or restart IIS in order for the change to take effect.

ﬂ Uninstalling the CLS software does not remove LicenseFeature Assignment.xml
and reinstalling the CLS software will not overwrite it.

License Assignment Editor Diagnostics

1. To display a complete listing of all the currently assigned licenses and the
nodes they are assigned to:

a. From the License Server node, select:

Start > All Programs > ABB Industrial IT 800xA > System >
Licensing > License Assignment Editor

b.  This launches the License Assignment Editor as shown in Figure 61. Click
Diagnostics to view the listing.

License Status Viewer

There are two uses for the License Status Viewer:

* License Violations on page 252.
e Temporary Licenses on page 253.
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The License Status Viewer (Figure 62) is an application that can be used to diagnose
licensing problems. The License Status Viewer is installed with the License Client
and is therefore available on every node running the 800xA System software.

. ADD Licensing Disgnostics e . . ;lglﬂ

Licens= Gicup | Fesfure | MachineAopkestion | ‘Vialstion Court | Eeior Code 1 Ennce Dietarls
B0, Cine TAGS _n GOLDEN 1 OxasB0G Irwahd Licerse Granted: Mo such fesbuie axistz
B0k, Cante TaGS 2 GOLDEW 1 OxabB05 Irwzhd Licerse Granted: Mo such fesbuie austs
B0kt Cntie TaGS Y GOLDEN 1 OxatB05 Irmzhd Licerse Granled: Mo such feshuie ensts
|CLS Machine:  |GOLDEM | Cormection Stalus: | Mo Ener -

TCO05712A

Figure 62. License Status Viewer

To display the License Status Viewer, select:

Start > All Programs > ABB Industrial IT 800xA > System > Licensing >
License Status Viewer

License Violations

If license violation messages (Applications are running Without Valid
Licenses) appear, use the License Status Viewer to determine which licenses are
in violation.

To save this list to a text file:
1. Launch the License Status Viewer by selecting:

Start > All Programs > ABB Industrial IT 800xA > System >
Licensing > License Status Viewer

2. Select:
File > Save

3. Enter a file name and browse to the directory in which to save the file.
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4. Click Save to save the file.

Temporary Licenses

If temporary license messages appear, (Applications are running with
Temporary Licenses. This computer is unable to communicate
with the License Server.) use the License Status Viewer to determine the
connection status of the CLS server. The CLS connection status is listed at the
bottom of the License Status Viewer. A typical problem is that the License Client is
not pointing to the node running the License Server. If this occurs, refer to CLS
Relocation Tool on page 253.

CLS Relocation Tool

If the License Client is not pointing to the correct License Server node, or the
License Server has been relocated or renamed, change it by using the License Status
Viewer:

The default CLS machine name for a standalone installation is STANDALONE. Do
@ not change the CLS Machine name if the CLS Standalone option is installed.
1. Launch the License Status Viewer by selecting:

Start > All Programs > ABB Industrial IT 800xA > System >
Licensing > License Status Viewer

2. Select:
Tools > Change CLS Machine
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3. The Central License Server Machine Selection dialog box appears (Figure 63).
Enter or browse for the node running the License Server.

. Central License Server Machine Sele '_ -1O] x|

Current CLS b achine: |G0LDEH

New CLS Machine: Browse... |

Apply ]

TCO05713A

Figure 63. CLS Relocation Tool

4. Click Apply to save the change.
5. Click Exit to return to the License Status Viewer.

6. Shut down and restart the node to apply the change.
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Appendix A Installation Media

The 800xA System documentation and software is delivered on:

e System Version 5.1 Released Documents CD: Contains 800xA System and
Functional Area instructions and Release Notes in pdf format, and any required
updates that do not appear on the DVDs. Table 20 lists the directory structure.

*  800xA System Installation DVD 1: Contains 800xA System and Functional
Area software. Table 21 lists the directory structure.

¢ 800xA System Installation DVDs (DVD 2, DVD 3, and DVD 4) for Device
Libraries: Each DVD contains Device Libraries of a specific fieldbus protocol

for use in the 800xA System in connection with Device Management
PROFIBUS & HART and/or Device Management FOUNDATION Fieldbus.

¢ 800xA System Installation DVD 5: Contains Oracle 11 installation files and
800xA System and Functional Area VB Graphics Extensions. Table 22 lists the
directory structure.

*  800xA System Installation DVDs (DVD 6 and DVD 7): DVDs are used to
update 800xA 5.1 to 800xA 5.1 latest revision (32- and 64-bit).

Feature Pack Functionality

¢ 800xA System Installation DVDs (DVD 8 and DVD 9): DVDs are used to
update 800xA 5.1 to 800xA 5.1 latest Feature Pack release (32- and 64-bit).
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Table 20. System Version 5.1 Released Documents CD

Directory Contents
System Version 5.1 Released System Version 5.1 Released Documents
Documents
Release Notes
Table 21. 800xA System Installation DVD 1
Directory Software
3rd_Party_SW ABB
ABB 800xA Common 3rd Party Install
Microsoft
Hotfixes
Microsoft SQL Server

Office Patch
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Table 21. 800xA System Installation DVD 1 (Continued)

Directory

Software

800xA Connectivities

800xA for AC 800M
AC 800M Connect
AC 800M HI Extension
OPC Server for AC 800M

800xA for Advant Master

800xA for Harmony
Harmony Batch
Harmony CNAM
Harmony API (hAPI)

800xA for IEC 61850
IEC 61850 Connect
IEC 61850 OPC Server
IEC 61850 SCL Components

800xA for Melody

800xA for MOD

PAS - System Services

800xA for SafeGuard

PLC Connect
PLC Connect
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Table 21. 800xA System Installation DVD I (Continued)

Directory Software

800xA Core Functionalities Diagnostic Tools
Diagnostics Collection Tool

Licensing
CLS
CLS Extension

Multisystem Integration

Process Portal A

RNRP

SFC Viewer

SMS and e-mail Messaging

800xA Documentation Software for installing 800xA documentation
Asset Optimization Asset Optimization Server & Client

MatLab

PPB

PC, Network and Software Monitoring
Network Monitor

Device Management & Fieldbuses Device Library Wizard
ABB Device Library Wizard - Client
ABB Device Library Wizard - Server

FOUNDATION Fieldbus
Fieldbus Builder FF
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Table 21. 800xA System Installation DVD 1 (Continued)

Directory

Software

Device Management & Fieldbuses
(continued)

PROFIBUS & HART
FDT Base Container
FDT Shared Components
Fieldbus Builder PH
HART Device Integration Library
HART DTM Builder
HART Multiplexer Connect
PROFIBUS Device Integration Library
PROFIBUS DTM Builder
S800 10 DTM
S900 IO DTM
Version Verification

Engineering & Development

Accessories
Digital Signatures Upgrade Tools

SV3

Sv4

Aspect Express

Base Software for Soft Control

Control Builder M
FirmwareFiles
Tools

Engineering Studio
Engineering Studio
FD Import Delete
Tools

Legacy Graphics Library

Process Engineering Tool Integration
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Table 21. 800xA System Installation DVD I (Continued)

Directory

Software

Information Management

Autorun

Calculations

Data Direct

Historian
Tools

Scheduler

SoftPoint Server

Structured Data Logger
SDLSQLServerlnstallation

Structured Data Logger Data

Production Management

Batch Management

System Installer

Installation Tools
System Planner
Upgrade
Windows Config

System Installer
DotNetFramework
InstallShield
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Table 22. 800xA System Installation DVD 5

Directory Software
3rd_Party_SW ABB
ABB 800xA Common 3rd Party Install
ECS
AutoDesk
Oracle
Oracle11R2

800xA Connectivities

800xA for Advant Master VB Extension

800xA for DCI
DCI Batch Extension
DCI Extension
DCI VB Graphics Extension

800xA for Harmony VB Extension

800xA for IEC 61850 VB Graphics Extension

800xA for Melody

800xA for MOD 300 VB Graphics Extension

800xA for Safeguard VB Extension

AC 800M VB Graphics Extension

PLC Connect VB Graphics Extension

800xA for Safeguard VB Extension

Additional Products

S800 10 FW
Cl801
Cl840

Snapshot Reports for 800xA

TRIO
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Table 22. 800xA System Installation DVD 5 (Continued)

Directory Software

Asset Optimization Asset Optimization Server & Client
Asset Optimization VB Graphics Extension

PC, Network and Software Monitoring
ABB PC, Network and Software Monitoring VB
Graphics Extension
PNSM Device Library
Base
Others
Servers
Switches
UPS

Device Management & Fieldbuses FOUNDATION Fieldbus
FF VB Graphics Extension

Engineering & Development Aspect Studio
Aspect Studio
Process Portal A SDK Extension
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The Engineering Repository is a simple source control system for:

*  Storing engineering solutions.
*  Moving engineering solutions between Engineering and Production systems.
e Comparing engineering solutions.

Engineering Repository Web Service Configuration

The Web service can be installed stand-alone and is independent of 800xA Base
installation.

Server Operating System
1. Install IIS.
a. Open the Server Manager (Computer > Manage).
b. Select the Roles item and click on Add Roles.
c. Check Web Server (IIS).

If asked Add features required for Web Server (I1S)?, click Add
Required Features.

e. Click Next.
f. Select ASP.NET.

g. If asked Add role services and features required for ASP.NET?, click
Add Required Role Services.

i

h. Select Basic Authentication and Windows Authentication under
Security.
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Appendix B Engineering Repository

j-

k.

Select IIS Management Console, IIS Management Scripts and Tools
and Management Service.

Click Next.

Click Install (This may take some time).

WCF is installed as standard, HTTP activations aren’t by default. To activate
these, on your machine, open Control Panel / Programs and Features, Turn
Windows Features on or off / Install, Windows Communication Foundation
HTTP Activation.

d.

€.

Open the Server Manager (Computer ->Manager).
Select the Features item and click on Add Features.

Select WCF Activation (Both HTTP Activation and Non-HTTP
Activation) under .NET Framework 3.0 Features.

Click Next.
Click Install. (This may take some time)

Install the Engineering Repository Web service.

a.

Copy the directory “ERService” that is located in “C:\Program Files\ABB
Industrial IT\Operate IT\Process Portal A” on a computer where 800xA
Base is installed, to “C:\Inetpub\wwwroot\ERService” on the computer
where the service shall run (can be the same computer).

264
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b. In the Internet Information Services (IIS) Manager, create a new Virtual
Application by right-clicking on the Default Web Site and select Add
Application.
ﬂ Follow any of the below procedures to start Internet Information Services (1IS)
Manager:
e  To start IIS Manager from the Run dialog box, perform the following steps:
1. On the Start menu, click All Programs, click Accessories, and then click
Run.
2. In the Open box, type inetmgr and then click OK.

e To start IIS Manager from the Administrative Services console, perform for
the following steps:

1. On the Start menu, click All Programs, click Accessories, and then click
Run.

2. In the Run text box, type control panel, and then click OK.

3. In the Control Panel window, click Classic View, and then double-click
Administrative Tools.

4. In the Administrative Tools window, double-click Internet Information
Services.
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_"E Internet Information Services (IIS) Manager j

=10l x]

@@ [6’ WIN-GKTYVOZZNOQ * Sites » Default Web Site »

|&@ = 5 1@ -

File Vew Help
ST 0 Default Web Site Home
- % Start Page . =
=95 WIN-GKTYVOZZNOQ (WIN-GKTYvozz( | SR by: Area (55
I} Application Pools ASP.NET B
E)-[@] Sites )
P -
=@M eoore . @ [
®-]  EdtPermissions... NET MNET  NETProfie
5 =t .
12 add Application... % Py
% Add Virtual Directory... \/ 1B/ E!
T Roles NET Trust NET Users
Edit Bindings. ... .
Manage Web Site 3 =Im-
- "
@ Refresh = &"" ﬁ
7 licaton ~ Connection  Machine Key
XK Remove ttings Strings
Rename = (e,
5 B & L
2 Switch to Content View B .
es and i Session State
Controls
n -
=
SMTP E-mail
s
d 9 |o
Authentication Compression Default
Document ;|
J | o) o] e
Ready

Figure 64. Add Application

4 Explore
Edit Site
[ Basic settings...

View Virtual Directories

Manage Web Site (~

P Start

5
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Server Operating System

C.

In the Alias field enter “AfwDistEngWcfServices” and for the Physical
path browse to the ERService folder. Connect as Application User (pass-
through authentication).

Site name:  Default Web Site

Path: !

Alias: Application pool:
IAwaistEng'\"a’cfServices IDefauItAppPool Select... |

Example: sales
Physical path:
IC: linetpubwwwroot\ERService

L

Pass-through authentication

Test Settings. .. |

OK Cancel

Figure 65. Add Application Window

Click OK.

Select AfwDistEngWcfServices in the connection pane and click on Edit
Permission in the Actions pane.

In the ERService folder property dialog select the security tab. Click on
Edit to change permissions. For the user NETWORK SERVICE set Allow
permissions for Read & execute, List folder contents, Read and Write.

3BSE034678-511 G
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If NETWORK SERVICE does not exist in the Groups or user names

windows it must be added.

. Permissions for ERService

Security |

Object name:  C:hinetpubwwwroot \ER Service

Group or user names:

2 CREATOR OWNER
&2 SYSTEM

;{ Users (WIN-GKTYWOZZNOG \Users)

;{ Administrators (WIN-GKTYVDZZNOG Administrators)

d
Add. Bemove |
Pemissions for NETWORK
SERVICE Alow Deny
Modty 0 O 4
Read & execute O
List folder contents O
Read O
Write O
L = = (=
Leam about access control and pemissions
ok | cancel | s |

Figure 66. ERService Permissions
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g. In the Internet Information Services (IIS) Manager, select
AfwDistEngWcfServices and open the Authentication feature. Enable
Windows Authentication and disable all others.

“E Internet Information Services (IIS) Manager i =10] x|
@—@ [?»wmqmwzmuqrs&mradmm&s&m»nfwis&gwdsm» & @ -
File \View Help
- Authentication _
Q-2 |8 ? Disable
-5 StartPage
[~ . i - Advanced Settings...
583 WIN-GKTYVOZZNOQ (WIN-GkTYvozz| | | SouRBY: No Grouping
L2} Application Pools Name =~ [ status [R || @ Hep
=-al Sites Anonymous Authentication Disabled Oniline Help
=2 Defauit Web Site ASPNET Impersonation Disabled
(8] aspnet_dent Basic Authentication Disabled H
(-] ERService Forms Authentication Disabled H

(% AfwDistEngWeServices

Windows Authentication Enabled

4 | i
y 3| [reswrm ven ] et

fost.config , <location path="Default Web Site/AfwDistEngWcfServices™ ai:g

Figure 67. Enabling Windows Authentication
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h. Create a new application by right-clicking on the Default Web Site and
select Add Application.

i.  Enter a name (For example: DistributedEng). Click OK.

0’3! Application Pools

This page lets you view and manage the list of application pools on the server. Application pools are assodated with worker processes,
contain one or more applications, and provide isolation among different applications.

Filter: =|#f 6o ~ Fshow All | Group by: No Grouping -

Name_~ [ stetus [ NETFrame... [ Managed Pipei... | Identity | Appi
Qaatd'\\‘.ret:SEr\»cesnpoPool L L B e s R il BO0xAService 1
L} Classic NET AppPool Add Application Pool 2 X} picatonpociidentty 0
L2} DefauitAppPool — HetworkService 4
2 Distrbutedeng - etworkservi i
2 [pstributedeng =
.NET Framework version:
| .NET Framework v2.0.50727 =l
Managed pipeline mode:
Integrated ol I
¥ Start application pool immediately
OK I Cancel

Figure 68. Add Application Pool

j-  Inthe list of application pools, right-click on the newly created application
pool. Select Advanced Settings.

k. On the Advanced Settings window navigate to Process Model pane, click

Identity and select Browse icon. The Application Pool Identity window is
displayed.
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1. On the Application Pool Identity window change the Built-in account: to
NetworkService. Click OK.

2]

* Built-in account;

|Nc:'.n'ork5¢n;|ﬂt ;I

Figure 69. Changing the Application Pool Identity

m. Click OK on the Advanced Settings window to save the changes.

n.  On the Default Web Site, select the new virtual application
AfwDistEngWcfServices created.

0. On the Action Pane, select Advanced Settings.

p- On the Advanced Settings, select application pool and change to the newly
created application DistributedEng. Click OK.

select Application Pool ' i .4
Application pool:
| DistrbutedEng |
DefaultAppPool

Classic NET AppPo
BatchWebService

DistrbutedEng
TR T=R [ a[:

Figure 70. Select Application Pool

g. Click OK on the Advanced Settings window to save the changes.
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r.  Verify that the service is working by opening up Internet Explorer and
navigate to http://localhost/AfwDistEngWcfServices/DistEngService.svc.
If the service is working this page will be displayed.

/~ service - Windows Internet Explorer . o =] B

gWcfSer j W X Ibf’ R

Suggested Sites @ | Web Slice Gallery =

tip: /localhost/AfwC

fa - B - ) o= - page- Safety- Tooks- @

This is 2 Windews® Cemmunication Foundation service.

Metadata publishing for this service is currently disabled.

If you have access to the service, you can enable metadata publishing by completing the following steps to
modify your web or application configuration file:

1, Create the following service behavior configuration, or add the <serviceMetadatas element to an axisting
service behavior configuration:
<behaviors>
<serviceBeshaviors>
<behavior name="MyServiceIlypeSehaviors"™ >
<serviceMetadata httpGetEnabled="crue" />
</behavior>
</serviceBehaviors>
</behaviors>

2. Add the behavior configuration to the service:

<service name="MyNamespace.MyServiceType" behavicorConfiguration="MyServiceTyps

Note: the service name must match the configuration name for the service implementation.

3. Add the following endpoint to your service configuration:

»

4
Done [ [ [ [ I [ [ & tocalintranet | Protected Mode: OFf 7~ [®Rw0% -

<endpoint contract="IMetadataExchange™ binding="mexHttpBinding" address="mex"™ v|

Figure 71. Service Display

Workstation Operating System
1. Install IIS.

a. Open the Program and Features in the Control Panel.
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Workstation Operating System

Figure 72. Windows Features Dialog - Application Development Features

b.

C.

Click on Turn Windows features on or off.

Select .NET Extensibility, ASP.NET, ISAPI Extensions and ISAPI

Filter.

r 5
Windows Features . g Ol S Elﬂlﬂ_hj

Turn Windows features on or off (2]

To turn a feature on, select its check box. To turn a feature off, clear its
check box, A filled box means that only part of the feature is turned on.

|:| . FTP Server ~
[] |, Web Management Tools |

= @ | World Wide Web Services I
= , Application Development Features

l..m

| .NET Extensibility
El Asp
EE '
EJ cal 1
| ISAPI Extensions
| ISAPI Filters I
[[1 | Server-Side Includes i

=] Commen HTTP Features |

[ oK ] ’ Cancel l
A _—
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d. Select Basic Authentication, Request Filtering and Windows
Authentication.

F ™y
Bl Windows Features o]

Turn Windows features on or off (7]

To turn a feature on, select its check box. To turn a feature off, clear its
check box. A filled box means that only part of the feature is turned on.

. Health and Diagnostics N
. Performance Features

. Security

|, Basic Authentication

|, Client Certificate Mapping Authentication

.. Digest Authentication
|, D5 Client Certificate Mapping Authentication
1 IP Security

1. Request Filtering
1 J. URL Authorization
@)

il Windows Authentication

[T1 1 Internet Information Services Hostable Web Core
| 0K ] [ Cancel

L

i

m

IO000F

1=

—

Figure 73. Windows Features Dialog - Security
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Repository

€.

Figure 74. Windows Features Dialog - Web Management Tools

Select IIS Management Console, IIS Management Scripts and Tools

and IIS Management Service.

F ™
Windows Features) . : - C=HA=
Turn Windows features on or off @
To turn a feature on, select its check box. To turn a feature off, clear itz
check box. A filled box means that only part of the feature is turned on.
[} Games -
[] |} Indexing Service
. Internet Explorer 8 =
= . Internet Information Services
1.4 FTP Server
= , Web Management Tools
[T] }. IS 6 Management Compatibility
) II5 Management Console
, IS Management Scripts and Tools \
.
| World Wide Web Services
[T1 1! Internet Information Services Hostable Web Core i
[ OK ] ’ Cancel l
b — = —
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f.

Select Windows Communication Foundation HTTP Activation and

Windows Communication Non-HTTP Activation.

Windows Features =ARCEN X

Turn Windows features on or off

To turn a feature on, select its check box. To turn a feature off, clear itz
check box. A filled box means that only part of the feature is turned on.

|:| , IS 6 Management Compatibility
, IS Management Console
, IS Management Scripts and Tools
, IS Management Service
| World Wide Web Services
[T] | . Internet Information Services Hostable Web Core
. Media Features
= . Microsoft MET Framewaork 3.5.1
, Windows Communication Foundation HTTP Activation

w ] L. Microsoft Message Queue (MSMQ) Server
4| m 2

i Windows Communication Foundation Non-HTTP Activa

m

[ ok ][ cance |

Figure 75. Windows Features Dialog - Windows Communication

g.

Click OK (This may take some time).

2. Install the Engineering Repository Web service.

Copy the directory “ERService” that is located in “C:\Program Files\ABB
Industrial IT\Operate IT\Process Portal A” on a computer where 800xA
Base is installed, to “C:\Inetpub\wwwroot\ERService” on the computer
where the service shall run (can be the same computer).

a.

In the Internet Information Services (IIS) Manager, create a new Virtual
Application by right-clicking on the Default Web Site and select Add

Application.
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Follow any of the below procedures to start Internet Information Services (1IS)
Manager:

e  To open IIS Manager from the Start menu, perform the following steps:
1. Click Start, and then click Control Panel.
2. Click System and Security, and then click Administrative Tools.

3. In the Administrative Tools window, double-click Internet Information
Services (IIS) Manager.

e To open IIS Manager from the Search box, perform for the following steps:
1. Click Start.
2.In the Start Search box, type inetmgr and press Enter.
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-
@5 Internet Information Services (IIS) Manager —r ﬂ E@g
6@ [@ » WINTGOLD » Sites » Default WebSite » | < @~

i
File View Help
Connections i Actions
0 Default Web Site Home
# 4 Explore .
€3 WIN7GOLD (Win7Gold\Lecald = i
4 g - : _{Wln old\Local Filter: . EGGO B %Shnwﬂll Edit Permissions
4t Application Pools = Edit Site
4-[8] Sites ASP.NET 4 -
: — indings...
PYr- Ty — p
-] Explore \"\é .dD:' o D Basic Settings... I
I i o % > — e —_—
Edit Permissions... .NET .NET Error .NET View Applications |
[ Add Application \"d Sl S RicRzaton View Virtual Directories |
H ‘|_’.'. - (o
| 7] Add Virtual Directory... 2 9 3 Manage Web Site ~
Edit Bindings... pfile .NET Roles .NET Trust .NET Users @ Restart '
- Levels P Start i
Manage Web Site > I? — = B Stop i
E Refresh kal=b] i!E B Browse Web Site |
Remove ion Connection MachineKey Pagesand Browse ™80 (htt
X s Strings Controls 81 Browse thitp) |
Rename Advanced Settings... |
| =
iz Switch to Content View p k =1 Configure
Session State SMTP E-mail Limits...
0 Help l
s Online Help
n Ay
| B o & i
I Authentic... Default Handler HTTP
Document  Mappings Respon...
' [ T Y
" = G=
O &M ¥ &
I5APIFilters  Modules Qutput Request -
1 . » (. Content View
Ready 45

Figure 76. Add Application - Workstation Operating System
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c. Inthe Alias field enter “AfwDistEngWcfServices” and for the Physical
path browse to the ERService folder. Connect as Application User (pass-
through authentication).

Add Application P |
. P
Site name:  Default Web Site
Path: !
Alias: Application peol:

AfwDistEngWcfServices DefaultAppPocl

Example: sales

Physical path:
Chinetpubtwwwroot\ERService E]

Pass-through authentication

Connect as... ] l Test Settings...

| ok || conce |

Figure 77. Add Application Window - Workstation Operating System

d. Click OK.

e. Select AfwDistEngWcfServices in the connection pane and click on Edit
Permission in the Actions pane.

f.  In the ERService folder properties dialog select the security tab. Click on
Edit to change permissions. For the user NETWORK SERVICE set Allow
permissions for Read & execute, List folder contents, Read and Write.
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If NETWORK SERVICE does not exist in the Groups or user names
window it must be added.

-

Permissions for ERService

]

Security

Object name:

Group or user names:

C:hinetpub™wwwroot \ERService

52 CREATOR OWNER

A1 NETWORK SERVICE

52 SYSTEM

.EIJAdministmtors (Win7Gold \Administrators)
};TJ Users (Win7Gold"\Users)

4| n

Pemissions for NETWORK
SERVICE

=
=)
=

Todfy
Read & execute
List folder conterts
Read

Write

Snecial nemission

T

Leam about access control and permissions

[ ok

][ Cancel ][

doply |

Figure 78. ERService Permissions - Workstation Operating System
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g. In the Internet Information Services (IIS) Manager, select
AfwDistEngWcfServices and open the Authentication feature. Enable
Windows Authentication and disable all others.

[ fon Sen - — . B
L =
\Tj Internet Information Services (IIS) Manager ' "
% (@ » WINIGOLD » Sites » Default WebSite » AfwDistEngWcfServices » @~ ) @-
File View Help
» [2¥ Authentication @ telp
N?GO.LD Mln?GoId\LocalAdmlmstrai Group by: No Grouping . Online Help
Application Pools -
Sites Name Status Response
0 @ Default Web Site Anonymous Authentication Disabled i
b | aspnet_client ASP.NET Impersonation Disabled "
B~ ~| ERService Basic Authentication Disabled HTTP 401 l
[ AfwDistEngWcfServices Forms Authentication Disabled HTTP 302 !
\ { Windows Authentication Enabled HTTP 401 '
1
I < m G
p [T —— [=| Features View |2 Content View '

| Configuration: 'localhost’ applicationHost.config, <location path="Default Web Site/AfwDistEngWcfServices”> q_'ﬂ :5|l

Figure 79. Enabling Windows Authentication - Workstation Operating System
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h.  Verify that the service is working by opening up Internet Explorer and
navigate to http://localhost/AfwDistEngWcfServices/DistEngService.svc.

If the service is working this page will be displayed.

-
& Service - Windows Internet Explorer @M
; A faYictE WS s o — =
ey |Q http://localhost/ AfwDistEngWcfServices/Dist v| ka2 | $,| x | |b Bing j ol
3 Favorites | i [ Suggested Sites v @] Web Slice Gallery ~
& Service ’-}, * B v [ @ v Page~ Safety~ Tools~ in ”

Service

This is a Windows® Communication Foundation service.

Metadata publishing for this service is currently disabled.

If you have access to the service, you can enable metadata publishing by completing the following steps to
modify your web or application configuration file:

1. Create the following service behavior configuration, or add the <serviceMetadata> element to an existing
service behavior configuration:

<behaviors>
<serviceBehaviors>
<behavior name="MyServiceIypeBehaviors™ >
<serviceMetadata httpGetEnabled="true" />
</behavior>
</serviceBehaviors>
</behaviors>

2. Add the behavior configuration to the service:

4 m

Done 0 Internet | Protected Mode: Off 2 v H1W% ~

Figure 80. Service Display - Workstation Operating System

Common Problems

1. The user cannot connect the client to the server and you get a security message:
Make sure that the UTC-time between the client and the server does not differ

more that 5 minutes.

2. The user cannot connect the client to the server: Try using the IP-address
instead of the computer name when connecting.
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3. Login Dialog: If a user other than the current Windows user is used to log in to
the server, the password must be entered every time the Engineering
Repository Browser is started.

4. The user may experience the following error:
HTTP Error 404.3 - Not Found

Description: The page requested by the user cannot be served because of the
Multipurpose Internet Mail Extensions (MIME) map policy that is configured on
the Web server. The requested page has a file name extension that is not recognized,
and is not allowed.

To resolve this issue, you need to take the following steps:

a. Run a command prompt window as administrator. Start, cmd as normal
then press CTRL+SHIFT+ENTER.

b. Navigate to c:\windows\Microsoft.Net\Framework\v3.0\Windows
Communication Foundation\.

c. Run the command ‘ServiceModelReg -i’ - The user should receive the
results below.

d. Exit.

Configuration Verification

Verify that the Engineering Repository Web Service is correctly configured by
performing the following:

1. Start Internet Explorer.

2.  Enter the following address in the Address bar:

http://localhost/AfwDistEngServices/
DistributedEngineering.asmx

A web page should display which operations are provided by the Engineering
Repository Web Service.
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Client Configuration

When starting the Engineering Repository user interface for the first time, enter
@ the name of the server if it is located on a different workstation.

The Engineering Repository user interface can be started from the toolbar in the
Plant Explorer or from a context menu:

1. Start the Plant Explorer.

2. Navigate to an Entity (such as Control Project) and right-click on it to display
the context menu. The context menu has an item called Engineering
Repository.

Common Problems

Some common problems associated with the configuration of the Engineering
Repository are described in Table 23.

Table 23. Common Problems

Problem Solution

Cannot connect Make sure that the UTC time between the client and the server does not differ
the client to the more that 5 minutes. If the time difference is considered impossible to correct,

server and a it is possible to increase to maximum allowed time difference. To increase the
security message |time difference tolerance, modifications in the configuration file for both the
is displayed service and the clients must be performed. The configuration file for the

service is called Web.config and is located in the directory where the service
is installed. The configuration file for the client is called
AfwEngineeringRepository.exe.config and is located in the bin directory of
800xA. Similar modification shall be done in both files. The time difference
tolerance should be set as low as possible.

Cannot connect Use the IP address instead of the computer name when connecting or ensure
the client to the that Microsoft WSE 3.0 is installed on both the client and the server.
server

Login dialog If a user other than the current Windows user is used to log in to the server, the
password must be entered every time the Engineering Repository Browser is
started
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Common Problems

Table 23. Common Problems (Continued)

Problem Solution
Validation of Select Start > Run and enter aspnet_regiis.exe -iinthe command
Engineering window to register ASP.NET 3.0 with IIS.
Repository Web | agpnet_regiis.exe is placed in %Systemroot%\Microsoft. NET\Framework\2.0.x.

Service from
Internet Explorer
fails if ASPNET
2.0 is not
registered with IIS

Logon to
Engineering
Repository failed

Ensure ASP.NET 2.0 is an “Allowed” Engineering Repository Web Service
Extension. This only applies if the Web Service is running on the Server
Operating System.

To set this:

1. Right-click on the My Computer icon from the desktop.
2. Select Manage.

3. Select Web Service Extensions.

3. Click Allow.

3BSE034678-511 G

285



Common Problems Appendix B Engineering Repository

286 3BSE034678-511 G



Index

Numerics
800xA common third party install tool 24
800xA for AC 870P/Melody 169
800xA for Advant Master 157
800xA for Harmony 163
800xA for MOD 300 177
800xA for Safeguard 157
800xA for TRIO 26
800xA service user
Adding privileges 112

A
About this book 15
AC 800M 149
AC 800M Connect 149
Control Builder M 151
OPC Server for AC 800M 151
SoftControl 153
AC 800M Connect 149
Adding 800xA domain users 87
Adding nodes to domain 86
Adding privileges to 800xA service user 112
Application Scheduler 129
Asset Optimization 195, 199
Automatic updates 54
Autorun 32

B

Backup software 100
Basic system functions 125
Batch Management 233

C
Calculations 129
Client Toolkit 226
CLS installation 115

Index

Client 120

Server setup 115, 116

Standalone option 121

System extension 122
Control Builder M 151
Crystal Reports 92

D
DataDirect 129
Default user groups and users 80
Defragmenting disks 43
Device Library Wizard 203
Device Management FOUNDATION Fieldbus 205
Device Management PROFIBUS & HART 217
Device Library Wizard 203
HART Multiplexer Connect 218
Diagnostics Collection Tool 143
Disabling protected mode 106, 110
Disks and file system 42
Display and Client Services 228
DNS server 67
Document Manager
AutoCAD integration 216
Domain controller 67

E
Enable SNMP service 61
Energy saver 53
Engineering studio 211
Ethernet address 118
Excel 91

F
File system 42, 44
FOUNDATION Fieldbus 205

3BSE034678-511 G

287



Index

G
Graphic displays 85
Group policy management 105
Groups 76

H

HART 217, 218
HART Multiplexer Connect 218

|
IE enhanced security configuration 51
IEC 61850 connect 191
IIS 56
Information Management 223
Installation 129
800xA for AC 870P/Melody 169
800xA for Advant Master 157
800xA for Harmony 163
800xA for MOD 300 177
800xA for Safeguard 157
AC 800M 149, 151, 153
Asset Optimization 195, 199
Batch Management 233
CLS 115
CLS Server setup 115, 116
CLS standalone option 121
CLS system extension 122
Device Management FOUNDATION Fieldbus
205
Device Management PROFIBUS & HART
217
HART Multiplexer Connect 218
Diagnostics Collection Tool 143
Directory 42
Engineering studio 211
Document Manager
AutoCAD integration 216
Excel Data Access (DataDirect) 129
General 26
Installation media 255

IEC 61850 connect 191
SQL Server 192
Information Management 223
License client 120
Multisystem Integration 239
PC, Network and Software Monitoring 200
Network Monitor 202
PLC Connect 189
Prerequisites 39
Adding 800xA domain users 87
Adding nodes to domain 86
Adding privileges to 800xA service user
112
Backup software 100
Crystal Reports 92
Domain controller and DNS server 67
Enable SNMP service 61
Group policy management 105
IIS 56
Microsoft Excel 91
Microsoft Word 90
Miscellaneous Windows setup 46
Network adapters 64
Remote client 62
Terminal server 62
Users and groups 76
Windows 40
Windows installation guidelines 44
Windows service pack 113
Process engineering tool integration 221
Process Portal 125
RNRP 131
SFC Viewer 145
SMS and e-mail Messaging 147
User account privileges for graphic displays 85
installation
RTA board 179
Installation data 30
Installation media 255
Installation overview 21

288

3BSE034678-511 G



Installation planning
Planning and preparation 30
Installation data 30
Installation tools 23
800xA common third party install tool 24
System verifier tool 25
Windows configuration tool 24

L
Local security policy 55

M
Machine ID 116
Maximo integration 195
Medium/large configuration 240
Microsoft Excel 91
Microsoft Word 90
MOD 300 System 177
Multisystem Integration 239

N

Network adapters 64
New installations 22

(o)
OPC Server for AC 800M 151

P
PC client applications 228
PC, Network and Software Monitoring 200
Network Monitor 202
PCI-type Realtime Accelerator Board 179
Planning and preparation 30
Installation data 30
PLC Connect 189
Popup blocker 54
Process engineering tool integration 221
Process Portal 125
PROFIBUS 217, 218

Protected mode, disabling 106, 110

R
Remote client 62
RNRP 131
RTA board installation 179

S
SFC Viewer 145
Small configuration 240
SMS and e-mail Messaging 147
SoftControl 153
SoftPoint Server 129
Software keys 119
SQL Server 192
System configuration console 25
System installer 22
Installation tools 23
800xA common third party install tool 24
System verifier tool 25
Windows configuration tool 24
System verifier tool 25

T

Terminal server 62
Time synchronization 239

U
Upgrades 22
User account privileges for graphic displays 85
User groups and users

Default 80
Users 76
\"
Virtual memory 52
w

Windows configuration tool 24

3BSE034678-511 G

289



Index

Windows firewall 24, 53
Windows operating system 40
Installation guidelines 44
Miscellaneous setup 46
Windows service pack 113
Word 90

290

3BSE034678-511 G



Revision History

This section provides information on the revision history of this User Manual.

ﬂ The revision index of this User Manual is not related to the 800xA 5.1 System
Revision.

The following table lists the revision history of this User Manual.

Revision Description Date
Index
- First version published for 800xA 5.1 64-bit FP1 December 2011
A Updated for 800xA 5.1 Rev B release June 2012
B Updated for 800xA 5.1 Feature Pack 3 release August 2012
C Updated for 800xA 5.1 Rev C release November 2012
D Updated for 800xA 5.1 Feature Pack 4 release February 2013
E Updated for 800xA 5.1 Rev D and FP4 releases | December 2013
F Updated for 800xA 5.1 Rev E and FP4 Rev E July 2015
releases

G Updated for intermediate release September 2015
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Updates in Revision Index A
The following table shows the updates made in this User Manual for 800xA 5.1

Rev B.

Updated Section/Subsection

Description of Update

Front Cover

Renamed Line 3 as Manual Installation instead
Installation.

About this User Manual

Minor changes are updated in this section.

Updates done in the subsection Version Described in
this Document.

Section 1. Installation Overview

Revision B Flow chart is added in the Installation
Sequence subsection.

Installation AUTORUN subsection changes.

Section 2. Prerequisites

The following subsections are updated:

e Selecting the Windows Operating System

e Disable User Account Control (UAC)

*  Regional and Language Options

. Information Management Specific Requirement
*  Microsoft Office Professional

*  User Account Privileges for Building VB Graphic
Displays - This section is corrected as
suggested by Tomas Lindstrom and Kees van
Overveld.

Section 9. SFC Viewer

Minor changes are updated in this section.

Section 18. Asset Optimization

Minor changes are updated in this section.

Appendix A. Installation Media

Minor changes are updated in this section.

Section 12. 800xA for Advant Master and
800xA for Safeguard

Changes are updated in this section.

Section 29. Licensing 800xA System
Software

Changes updated in the Common Error Messages
subsection.

292

3BSE034678-511 G



Updates in Revision Index B
The following table shows the updates made in this User Manual for 800xA 5.1

Feature Pack 3 release.

Updated Section/Subsection

Description of Update

About this User Manual

Updates done in the Version Described in this
Document subsection.

Feature Packs subsection is also added.

Section 1. Installation Overview

Feature Pack Flow chart is added in the Installation
Sequence subsection.

Section 2. Prerequisites

Information icon for Engineering Studio prerequisite
is added.

Section 9. SFC Viewer

Minor changes are updated in this section.

Section 18. Asset Optimization

Minor changes are updated in this section.

Appendix A. Installation Media

Minor changes are updated in this section.

Section 14. 800xA for AC 870P/Melody

Updated Asset Management Installation manual
reference.

Updates in Revision Index C
The following table shows the updates made in this User Manual for 800xA 5.1

Rev C.

Updated Section/Subsection

Description of Update

Front Cover

Minor Changes are updated on the Front cover.

About this User Manual

Minor changes are updated in this section.

Updates done in the subsection Version Described in
this Document.

Section 1. Installation Overview

Revision C Flow chart is added in the Installation
Sequence subsection.
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Updated Section/Subsection Description of Update

Section 2. Prerequisites Minor Changes are updated in this section.
The following subsections are updated:
e  Microsoft Office Professional

Section 9. SFC Viewer Minor changes are updated in this section.

Section 14. 800xA for AC 870P/Melody Minor changes are updated in this section.

Section 18. Asset Optimization Minor changes are updated in this section.

Appendix A. Installation Media Minor changes are updated in this section.

Updates in Revision Index D

The following table shows the updates made in this User Manual for 800xA 5.1
Feature Pack 4 release.

Updated Section/Subsection Description of Update

About this User Manual Updates done in the Version Described in this
Document subsection.

Feature Packs subsection is also added.

Section 1. Installation Overview Feature Pack Flow chart is added in the Installation
Sequence subsection.

Section 2. Prerequisites Information icon for Engineering Studio prerequisite
is added.

Section 9. SFC Viewer Minor changes are updated in this section.

Section 18. Asset Optimization Minor changes are updated in this section.

Appendix A. Installation Media Minor changes are updated in this section.

Section 14. 800xA for AC 870P/Melody Updated Asset Management Installation manual
reference.

Section 12 AC 800M Status Monitoring Section is added newly for Feature Pack 4.
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Updated Section/Subsection

Description of Update

Section 3 Central Licensing System

Updated Central Licensing System Extension
subsection. (Page 116)

Section 11 800xA for AC 800M

Updated AC 800M Connect subsection. (Page 113)

Updates in Revision Index E

The following table shows the updates made in this User Manual for 800xA 5.1
Revision D and Feature Pack 4 release.

Updated Section/Subsection

Description of Update

About this User Manual

Formatted according to the new Template

Front Cover

System Version Changes.

Section 2 Prerequisites

Changes done in Selecting the Windows Operating
System subsection.

Changes done in Microsoft Office Professional
subsection.

Section 14 800xA for Harmony

Changes done in SQL Server subsection.

Updates in Revision Index F

The following table shows the updates made in this User Manual for 800xA 5.1
Revision E and Feature Pack 4 Revision E release.

Updated Section/Subsection

Description of Update

Section 2 Prerequisites

Changes for 800xA Harmony is updated in the
Internet Information Services subsection.

Section 9 Asset Optimization

Changes are done in the section.
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Updates in Revision Index G

The following table shows the updates made in this User Manual for intermediate

release.
Updated Section/Subsection Description of Update
Section 2 Prerequisites Changes for Microsoft Office is updated in the
Microsoft Office Professional subsection.
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